
Copyright (c) Starfish Software %date

Sidekick 98 Help



Sidekick 98 Help

2 / 200

Table of contents

Font Dialog Box
................................................................................................................................... 24
Search Setup Dialog Box
................................................................................................................................... 24
To Do/Goals Dialog Box
................................................................................................................................... 24
Sort To Do Items/Goals List Dialog Box
................................................................................................................................... 25
Delete Recurring Dialog Box
................................................................................................................................... 26
Personal List Setup Dialog Box
................................................................................................................................... 26
Define Cardfile Fields Dialog Box
................................................................................................................................... 27
Ignore All Command (Shortcut Menu)
................................................................................................................................... 27
Date Stamp Command (Shortcut Menu)
................................................................................................................................... 28
Time Stamp Command (Shortcut Menu)
................................................................................................................................... 28
Edit Command (Shortcut Menu, Calendar)
................................................................................................................................... 28
Font Command (Shortcut Menu, Contacts)
................................................................................................................................... 28
Font Command (Shortcut Menu, Memos)
................................................................................................................................... 28
Recurring Command (Shortcut Menu)
................................................................................................................................... 28
Send To Command (Shortcut Menu)
................................................................................................................................... 29
Send To Eudora Pro or Exchange Command (Contacts)
................................................................................................................................... 29
Send To Eudora Pro or Exchange command (Memos)
................................................................................................................................... 29
Send To Fax Command
................................................................................................................................... 29
Add Card Dialog Box
................................................................................................................................... 29
Find Condition Dialog Box
................................................................................................................................... 30
Extract Cards on Condition Dialog Box
................................................................................................................................... 30
Print Labels/Address Book/Envelopes Dialog Box
................................................................................................................................... 31
More (Print) Options Dialog Box
................................................................................................................................... 31
Template Setup Options Dialog Box
................................................................................................................................... 32



Sidekick 98 Help

3 / 200

Set Up Label/Address Book Template Dialog Box
................................................................................................................................... 32
Set Up Contents Dialog Box
................................................................................................................................... 33
Set Up (Envelope) Template Dialog Box
................................................................................................................................... 34
More Options (Envelopes) Dialog Box
................................................................................................................................... 35
Back Up And Restore Dialog Box
................................................................................................................................... 35
Back Up Dialog Box
................................................................................................................................... 35
Restore Dialog Box
................................................................................................................................... 36
Fill In Information Dialog Box
................................................................................................................................... 37
Change Directory Dialog Box
................................................................................................................................... 37
Match Cardfile Fields Dialog Box
................................................................................................................................... 38
Delete Match Fields Dialog Box
................................................................................................................................... 38
Remove Duplicate Cards Dialog Box
................................................................................................................................... 38
Change Display Font Dialog Box
................................................................................................................................... 39
Modify Cardfile Template Dialog Box
................................................................................................................................... 39
Paper Setup Dialog Box
................................................................................................................................... 39
Select Cardfile Template
................................................................................................................................... 40
Print Dialog Box
................................................................................................................................... 40
Print Activities Dialog Box
................................................................................................................................... 41
Sidekick Password Setup Dialog Box
................................................................................................................................... 41
Enter Password Dialog Box
................................................................................................................................... 42
Deskpad Color Setup Dialog Box
................................................................................................................................... 42
Extract Criteria Dialog Box
................................................................................................................................... 42
Toll Prefixes Dialog Box
................................................................................................................................... 42
Setup Wizard: General Information
................................................................................................................................... 43
Setup Wizard: Choose Location
................................................................................................................................... 43
Setup Wizard: E-mail Type



Sidekick 98 Help

4 / 200

................................................................................................................................... 43
Setup Wizard: Set Up Your Service
................................................................................................................................... 44
Setup Wizard: Which Service?
................................................................................................................................... 44
Setup Wizard: No Service Found
................................................................................................................................... 44
Setup Wizard: Choose Profile
................................................................................................................................... 44
Setup Wizard: Mail Server Information
................................................................................................................................... 45
Setup Wizard: POP3 Information
................................................................................................................................... 45
Setup Wizard: Name and Address
................................................................................................................................... 45
Setup Wizard: Flash Sessions
................................................................................................................................... 45
Setup Wizard: Registration Information
................................................................................................................................... 45
Setup Wizard: Registration Address
................................................................................................................................... 46
Setup Wizard: Registration Options
................................................................................................................................... 46
Setup Wizard: Mail Registration
................................................................................................................................... 46
Setup Wizard: Finish
................................................................................................................................... 46
Attach a Uniform Resource Locator
................................................................................................................................... 46
E-mail Setup Dialog Box
................................................................................................................................... 47
New Report Dialog Box
................................................................................................................................... 47
Select Cardfile To Save To Dialog Box
................................................................................................................................... 48
Starfish TrueSync
................................................................................................................................... 48
Introducing Starfish Sidekick 98
................................................................................................................................... 49
Overview: Learning about Sidekick 98
................................................................................................................................... 49
About the Calendar View
................................................................................................................................... 50
About Internet Group Scheduling and the Activities View
................................................................................................................................... 50
About the EarthTime View
................................................................................................................................... 51
About the Contacts View
................................................................................................................................... 51
About the Memos View
................................................................................................................................... 52



Sidekick 98 Help

5 / 200

About the Expenses View
................................................................................................................................... 52
About the Phone Dialer
................................................................................................................................... 53
About the Report View
................................................................................................................................... 53
About Internet Time Synchronizer
................................................................................................................................... 54
Using Sidekick 98 Help
................................................................................................................................... 54
Toolbar
................................................................................................................................... 55
Contacting Starfish Software
................................................................................................................................... 55
Sidekick Files
................................................................................................................................... 57
................................................................................................................................... 57
Glossary
................................................................................................................................... 59
................................................................................................................................... 60
................................................................................................................................... 60
................................................................................................................................... 60
................................................................................................................................... 60
................................................................................................................................... 60
................................................................................................................................... 60
................................................................................................................................... 60
................................................................................................................................... 60
................................................................................................................................... 60
................................................................................................................................... 61
................................................................................................................................... 61
................................................................................................................................... 61
................................................................................................................................... 61
................................................................................................................................... 61
................................................................................................................................... 61
................................................................................................................................... 61
................................................................................................................................... 61
................................................................................................................................... 61
................................................................................................................................... 62
................................................................................................................................... 62
................................................................................................................................... 62
................................................................................................................................... 62
................................................................................................................................... 62
................................................................................................................................... 62
................................................................................................................................... 62
................................................................................................................................... 62
................................................................................................................................... 62
................................................................................................................................... 62
................................................................................................................................... 63
................................................................................................................................... 63
................................................................................................................................... 63
................................................................................................................................... 63



Sidekick 98 Help

6 / 200

................................................................................................................................... 63

................................................................................................................................... 63

................................................................................................................................... 63

................................................................................................................................... 63

................................................................................................................................... 63

................................................................................................................................... 64

................................................................................................................................... 64

................................................................................................................................... 64
Shortcut Keys
................................................................................................................................... 64
Calendar Shortcut Keys
................................................................................................................................... 64
EarthTime Shortcut Keys
................................................................................................................................... 65
Contacts Shortcut Keys
................................................................................................................................... 66
Memos Shortcut Keys
................................................................................................................................... 67
Expense Shortcut Keys
................................................................................................................................... 69
Activities View Shortcut Keys
................................................................................................................................... 69
Report Shortcut Keys
................................................................................................................................... 70
Calculator Function Keys
................................................................................................................................... 71
Calendar Menu
................................................................................................................................... 71
Events Command
................................................................................................................................... 71
To Do Items Command
................................................................................................................................... 72
Calls Command
................................................................................................................................... 72
Sort Command
................................................................................................................................... 72
Recurring Events Command
................................................................................................................................... 72
Multi-Day Command
................................................................................................................................... 73
Group Command
................................................................................................................................... 74
Single Day Event Command
................................................................................................................................... 74
Event Page (Schedule an Event Dialog Box)
................................................................................................................................... 74
Notes Page (Schedule an Event Dialog Box)
................................................................................................................................... 75
Single Day To Do Items Command
................................................................................................................................... 75
Recurring To Do Items Command



Sidekick 98 Help

7 / 200

................................................................................................................................... 75
Single Day Calls Command
................................................................................................................................... 76
Recurring Calls Command
................................................................................................................................... 76
Goals Command
................................................................................................................................... 77
Special Day Command
................................................................................................................................... 77
Delete Command (Calendar)
................................................................................................................................... 78
Sort To Do Items Command
................................................................................................................................... 79
Sort Goals Command
................................................................................................................................... 79
Almanac Command
................................................................................................................................... 79
Personal List Setup Command
................................................................................................................................... 79
Daily Activity Command
................................................................................................................................... 79
Cards Menu
................................................................................................................................... 80
Add Card Command
................................................................................................................................... 80
Duplicate Card Command
................................................................................................................................... 80
Move Cards Command
................................................................................................................................... 80
Delete Cards Command
................................................................................................................................... 81
Mark/Unmark Current Card Command
................................................................................................................................... 81
Unmark All Command
................................................................................................................................... 81
Define Fields Command
................................................................................................................................... 82
Reorder Fields Command
................................................................................................................................... 82
Sort Cards Command
................................................................................................................................... 83
Reorder Tabs Command (Contacts View)
................................................................................................................................... 83
Edit Menu
................................................................................................................................... 84
Edit Menu (Contacts View)
................................................................................................................................... 84
Find Command (Contacts View)
................................................................................................................................... 84
Edit Menu (Calendar View)
................................................................................................................................... 84



Sidekick 98 Help

8 / 200

Edit Menu (Memos View)
................................................................................................................................... 84
Edit Menu (Expense View)
................................................................................................................................... 84
Edit Menu (Report View)
................................................................................................................................... 85
Edit Menu (EarthTime View)
................................................................................................................................... 85
Undo Command
................................................................................................................................... 85
Cut Command
................................................................................................................................... 85
Copy Command
................................................................................................................................... 86
Paste Command
................................................................................................................................... 86
Copy Special Command
................................................................................................................................... 86
Copy Special Setup Command
................................................................................................................................... 86
Go to Cardfile Command
................................................................................................................................... 87
Find Text Command
................................................................................................................................... 87
Find Condition Command
................................................................................................................................... 87
Find Next Command (Contacts View)
................................................................................................................................... 88
Find Previous Command (Contacts View)
................................................................................................................................... 88
Go To Command (Calendar View)
................................................................................................................................... 88
Go to Today Command
................................................................................................................................... 88
Go to Specific Date Command
................................................................................................................................... 88
Find Command (Calendar View)
................................................................................................................................... 89
Reschedule Command
................................................................................................................................... 89
Add Card Command
................................................................................................................................... 90
Select All Command
................................................................................................................................... 90
Go to Folder Command
................................................................................................................................... 90
Find Command (Memos View)
................................................................................................................................... 90
Replace Command (Memos View)
................................................................................................................................... 91
Found Text Command



Sidekick 98 Help

9 / 200

................................................................................................................................... 91
Find Next Command (Expense View)
................................................................................................................................... 92
Find Previous Command (Expense View)
................................................................................................................................... 92
Find Command (Expense View)
................................................................................................................................... 92
Delete Column/Row Command
................................................................................................................................... 92
Go To Command (Activities View)
................................................................................................................................... 93
Delete Command
................................................................................................................................... 93
File Menu
................................................................................................................................... 93
File Menu (Activities View)
................................................................................................................................... 93
File Menu (Contacts View)
................................................................................................................................... 93
Print Command (Contacts View)
................................................................................................................................... 94
File Menu (Calendar View)
................................................................................................................................... 94
File Menu (Memos View)
................................................................................................................................... 94
File Menu (Report View)
................................................................................................................................... 94
File Menu (Expenses View)
................................................................................................................................... 94
File Menu (EarthTime View)
................................................................................................................................... 94
New Cardfile Command
................................................................................................................................... 94
Open Cardfile Command
................................................................................................................................... 95
Close Cardfile Command
................................................................................................................................... 95
Close Cardfiles Command
................................................................................................................................... 95
Import Cardfile Command
................................................................................................................................... 95
Export Cardfile Command
................................................................................................................................... 96
Setup Cardfile Template Dialog Box
................................................................................................................................... 96
Save Cardfile Command
................................................................................................................................... 96
Save Cardfile As Command
................................................................................................................................... 96
Save All Command
................................................................................................................................... 97



Sidekick 98 Help

10 / 200

Back Up and Restore Command
................................................................................................................................... 97
Print Setup Command
................................................................................................................................... 97
Print Cards Command
................................................................................................................................... 97
Print Labels Command
................................................................................................................................... 98
Print Address Book Command
................................................................................................................................... 98
Print Envelopes Command
................................................................................................................................... 98
Exit Command
................................................................................................................................... 98
File 1,2,3,4 Commands
................................................................................................................................... 99
New Calendar Command
................................................................................................................................... 99
Open Calendar Command
................................................................................................................................... 99
Save Calendar Command
................................................................................................................................... 99
Save Calendar As Command
................................................................................................................................. 100
Import Calendar Command
................................................................................................................................. 100
Outlook 97 Command
................................................................................................................................. 100
Schedule+ 7.0 Command
................................................................................................................................. 100
Open Dialog Box (Schedule+ 7.0)
................................................................................................................................. 100
Lotus Organizer 97 Command
................................................................................................................................. 101
Open Dialog Box (Lotus Organizer 97)
................................................................................................................................. 101
Print Command (Calendar View)
................................................................................................................................. 101
Print Sidekick Format Dialog Box
................................................................................................................................. 102
Print At-A-Glance Daily Format Dialog Box
................................................................................................................................. 102
Print At-A-Glance Weekly Format Dialog Box
................................................................................................................................. 103
Print At-A-Glance Monthly Format Dialog Box
................................................................................................................................. 104
Print Day Runner Format Dialog Box
................................................................................................................................. 104
Print Day-Timer Format Dialog Box
................................................................................................................................. 105
Print Franklin Format Dialog Box



Sidekick 98 Help

11 / 200

................................................................................................................................. 105
Print Filofax Format Dialog Box
................................................................................................................................. 106
One-Month Sidekick Format Command
................................................................................................................................. 106
One-Week Sidekick Format Command
................................................................................................................................. 107
Two-Week Sidekick Format Command
................................................................................................................................. 107
Six-Week Sidekick Format Command
................................................................................................................................. 107
Sidekick Year Planner Command
................................................................................................................................. 107
Four Months by Three Rows Command
................................................................................................................................. 107
Two Months by Six Rows Command
................................................................................................................................. 108
New Memo File Command
................................................................................................................................. 108
Open Memo File Command
................................................................................................................................. 108
Save Memo File Command
................................................................................................................................. 108
Save Memo File As Command
................................................................................................................................. 109
Print Memos Dialog Box
................................................................................................................................. 109
Page Setup Dialog Box
................................................................................................................................. 109
New Report Command
................................................................................................................................. 110
Open Report Command
................................................................................................................................. 110
Save Report Command
................................................................................................................................. 110
Save Report As Command
................................................................................................................................. 111
Print Command (Report View)
................................................................................................................................. 111
Print Preview Command (Report View)
................................................................................................................................. 111
Print Preview Command (Memos View)
................................................................................................................................. 111
Print Preview Command (Expenses View)
................................................................................................................................. 111
New Expense File Dialog Box
................................................................................................................................. 112
Open Expense File Command
................................................................................................................................. 112
Save Expense File Command
................................................................................................................................. 113



Sidekick 98 Help

12 / 200

Save Expense File As Command
................................................................................................................................. 113
Print Receipt/Report Command
................................................................................................................................. 113
Print Command (Activities View)
................................................................................................................................. 113
File-Handling Options
................................................................................................................................. 114
File-Handling Options (Calendar View)
................................................................................................................................. 114
Help Menu
................................................................................................................................. 114
Memos Menu
................................................................................................................................. 115
Memo Command
................................................................................................................................. 115
Folder Command
................................................................................................................................. 115
Mail Merge Command
................................................................................................................................. 115
Add Memo Command
................................................................................................................................. 115
Delete Memo Command
................................................................................................................................. 116
Move Memo Command
................................................................................................................................. 116
Sort Memos Command
................................................................................................................................. 116
Mark/Unmark Current Memo Command
................................................................................................................................. 117
Unmark All Memos Command
................................................................................................................................. 117
Extract Memos Command
................................................................................................................................. 117
Import Memo Command
................................................................................................................................. 117
Export File Command
................................................................................................................................. 118
Export Memo Command
................................................................................................................................. 118
Add Folder Command (Memos View)
................................................................................................................................. 118
Modify Folder Command
................................................................................................................................. 119
Delete Folder Command
................................................................................................................................. 119
Combine Folders Command
................................................................................................................................. 119
Reorder Tabs Command (Memos View)
................................................................................................................................. 119
Export File Command



Sidekick 98 Help

13 / 200

................................................................................................................................. 120
Create Template Command
................................................................................................................................. 120
Mail Merge Cardfile Command
................................................................................................................................. 121
Phone Menu
................................................................................................................................. 121
Phone Dialer
................................................................................................................................. 121
Setup Default SpeedDial Field Dialog Box
................................................................................................................................. 122
Phone Dialer Setup Dialog Box
................................................................................................................................. 123
Call Note
................................................................................................................................. 123
Reports Menu
................................................................................................................................. 124
Layout Menu
................................................................................................................................. 124
Card Report Dialog Box
................................................................................................................................. 124
Calendar Report Dialog Box
................................................................................................................................. 124
Free Time Report Dialog Box
................................................................................................................................. 125
To Do Items Report Dialog Box
................................................................................................................................. 125
Contact Log Report Dialog Box
................................................................................................................................. 126
Open Report Command
................................................................................................................................. 126
Go to Current Report Command
................................................................................................................................. 127
Choose Report Style Command
................................................................................................................................. 127
Save Report Style Command
................................................................................................................................. 127
Update Report Command
................................................................................................................................. 127
Font Command (Report View)
................................................................................................................................. 127
Report Title Dialog Box
................................................................................................................................. 127
Change Column Width Command
................................................................................................................................. 128
Hide Row Title Command
................................................................................................................................. 128
Hide Column Title Command
................................................................................................................................. 128
Tools Menu
................................................................................................................................. 128



Sidekick 98 Help

14 / 200

Tools Menu (Contacts View)
................................................................................................................................. 129
Tools Menu (Calendar View)
................................................................................................................................. 129
Tools Menu (Memos View)
................................................................................................................................. 129
Tools Menu (Expense View)
................................................................................................................................. 129
Tools Menu (Activities View)
................................................................................................................................. 129
Tools Menu (Report View)
................................................................................................................................. 129
Extract Cards Command
................................................................................................................................. 130
Contact Manager Command
................................................................................................................................. 130
Quick Letter Command
................................................................................................................................. 130
Synchronize Command
................................................................................................................................. 131
Conversions Command
................................................................................................................................. 131
................................................................................................................................. 131
Calculator Command
................................................................................................................................. 132
Setup Command
................................................................................................................................. 132
Toolbar Command
................................................................................................................................. 132
Preferences Command
................................................................................................................................. 133
General Preferences Command
................................................................................................................................. 133
Calendar Preferences Command
................................................................................................................................. 134
Daily Page (Calendar Preferences)
................................................................................................................................. 134
Weekly Page (Calendar Preferences)
................................................................................................................................. 135
Monthly Page (Calendar Preferences)
................................................................................................................................. 135
Yearly Page (Calendar Preferences)
................................................................................................................................. 136
Memo Preferences Command
................................................................................................................................. 136
Expense Preferences Command
................................................................................................................................. 136
Defaults Page (Expense Preferences)
................................................................................................................................. 137
Currency Page (Expense Preferences)
................................................................................................................................. 137



Sidekick 98 Help

15 / 200

Expense Type Page (Expense Preferences)
................................................................................................................................. 138
Pick List Page (Expense Preferences)
................................................................................................................................. 138
Group Scheduling Preferences Command
................................................................................................................................. 139
Electronic Mail Page (Group Scheduling Preferences)
................................................................................................................................. 139
Signature Page (Group Scheduling Preferences)
................................................................................................................................. 140
Exchange Settings Dialog Box
................................................................................................................................. 140
Web Publisher Preferences Command
................................................................................................................................. 140
Merge Cardfile Command
................................................................................................................................. 140
Extract Cards on Text Command
................................................................................................................................. 141
Extract Cards on Index Range Command
................................................................................................................................. 141
Extract Cards on Condition Command
................................................................................................................................. 141
Spelling Command
................................................................................................................................. 141
Auto Spell Check Command
................................................................................................................................. 142
Word Count Command
................................................................................................................................. 142
View Menu
................................................................................................................................. 142
View Menu (Contacts View)
................................................................................................................................. 143
View Menu (Calendar View)
................................................................................................................................. 143
View Menu (Memos View)
................................................................................................................................. 143
View Menu (Expenses View)
................................................................................................................................. 143
View Menu (EarthTime View)
................................................................................................................................. 143
View Menu (Report View)
................................................................................................................................. 143
View Menu (Activities View)
................................................................................................................................. 144
Calendar Command
................................................................................................................................. 144
EarthTime Command
................................................................................................................................. 144
Contacts Command
................................................................................................................................. 144
Memos Command



Sidekick 98 Help

16 / 200

................................................................................................................................. 144
Expenses Command
................................................................................................................................. 145
Activities Command
................................................................................................................................. 145
Daily View Command
................................................................................................................................. 145
Weekly View Command
................................................................................................................................. 145
Monthly View Command
................................................................................................................................. 145
Yearly View Command
................................................................................................................................. 145
Toolbar Command
................................................................................................................................. 145
Status Bar Command
................................................................................................................................. 146
Index View Command
................................................................................................................................. 146
Card View Command
................................................................................................................................. 146
Memo View Command
................................................................................................................................. 146
Folder View Command
................................................................................................................................. 146
Ruler Command
................................................................................................................................. 147
Line Numbers Command
................................................................................................................................. 147
Receipt View Command
................................................................................................................................. 147
Report View Command
................................................................................................................................. 147
All Events Command
................................................................................................................................. 147
Appointments Command
................................................................................................................................. 148
To Do Items Command
................................................................................................................................. 148
Calls Command
................................................................................................................................. 148
Internet Events Command
................................................................................................................................. 148
Creating a Cardfile (Using cardfile templates)
................................................................................................................................. 148
Creating a Cardfile (Adding new contact cards)
................................................................................................................................. 148
Creating a Cardfile (Changing cardfile fields)
................................................................................................................................. 149
Creating a Cardfile (Sorting a cardfile)
................................................................................................................................. 149



Sidekick 98 Help

17 / 200

Adding Contact Cards
................................................................................................................................. 149
Selecting Contact Cards
................................................................................................................................. 150
Moving Contact Cards between Cardfiles
................................................................................................................................. 150
Adding a To Do
................................................................................................................................. 150
Adding an Appointment
................................................................................................................................. 150
Making a Recurring Appointment, To Do, or Call
................................................................................................................................. 151
Adding Multi-Day Events
................................................................................................................................. 151
Adding a Memo
................................................................................................................................. 151
Faxing a Memo
................................................................................................................................. 152
E-mailing a Memo
................................................................................................................................. 152
Backing Up Your Files
................................................................................................................................. 152
Restoring Your Files
................................................................................................................................. 152
Designing Printed Label Contents (Overview)
................................................................................................................................. 153
Designing Printed Label Contents (Creating and editing elements)
................................................................................................................................. 153
Designing Printed Label Contents (Creating Card Fields elements)
................................................................................................................................. 154
Designing Printed Label Contents (Creating Text and Stamp elements)
................................................................................................................................. 154
Designing Printed Label Contents (Creating Graphic elements)
................................................................................................................................. 154
Designing Printed Label Contents (Resizing elements)
................................................................................................................................. 154
Designing Printed Label Contents (More options)
................................................................................................................................. 155
Expense Menu
................................................................................................................................. 155
Folder Command
................................................................................................................................. 155
Add Folder Command (Expense View)
................................................................................................................................. 156
Delete Current Folder Command
................................................................................................................................. 156
Modify Folder Command
................................................................................................................................. 156
Receipt Command
................................................................................................................................. 157
New Receipt Command



Sidekick 98 Help

18 / 200

................................................................................................................................. 157
Delete Receipt Command
................................................................................................................................. 157
File Properties Command
................................................................................................................................. 157
Format Menu
................................................................................................................................. 158
Font Command
................................................................................................................................. 158
Paragraph Command
................................................................................................................................. 159
Tabs Command
................................................................................................................................. 159
Bullet Command
................................................................................................................................. 159
EarthTime Settings Dialog Box
................................................................................................................................. 160
Select a Different City Command
................................................................................................................................. 160
Facts about the City Dialog Box
................................................................................................................................. 161
Modify City Information Dialog Box
................................................................................................................................. 161
Make Cityname the Map Center Command
................................................................................................................................. 162
EarthTime Menu
................................................................................................................................. 162
Set as Local Time Command
................................................................................................................................. 162
Choose as Home Clock Command
................................................................................................................................. 162
Clock Setup Command
................................................................................................................................. 163
Time Difference Command
................................................................................................................................. 163
Rearranging Cities
................................................................................................................................. 164
Daylight Saving Time Change
................................................................................................................................. 164
Center Map Here Command
................................................................................................................................. 164
Internet Menu (Activities View)
................................................................................................................................. 164
Internet Menu (Contacts View)
................................................................................................................................. 165
Internet Menu (Calendar View)
................................................................................................................................. 165
Mailing List Command
................................................................................................................................. 165
Resources Command
................................................................................................................................. 166



Sidekick 98 Help

19 / 200

Publish to the Web Command (Calendar View)
................................................................................................................................. 166
Publishing Wizard Command (Calendar View)
................................................................................................................................. 166
Publish to the Web Command (Contacts View)
................................................................................................................................. 166
Publishing Wizard Command (Contacts View)
................................................................................................................................. 166
Netscape Mail Command
................................................................................................................................. 167
Eudora Pro Mail Command
................................................................................................................................. 167
Send/Receive Now Command
................................................................................................................................. 167
Schedule Group Event Dialog Box
................................................................................................................................. 167
Date and Time Page
................................................................................................................................. 168
Participants Page
................................................................................................................................. 168
Message Page
................................................................................................................................. 169
Resources Page
................................................................................................................................. 169
Options Page
................................................................................................................................. 169
Internet Scheduling Wizard Step 1
................................................................................................................................. 170
Internet Scheduling Wizard Step 2
................................................................................................................................. 170
Internet Scheduling Wizard Step 3
................................................................................................................................. 171
Internet Scheduling Wizard Step 4
................................................................................................................................. 172
Internet Scheduling Wizard Step 5
................................................................................................................................. 172
Internet Scheduling Wizard Step 6
................................................................................................................................. 172
Internet Scheduling Wizard Step 7
................................................................................................................................. 173
Set Up Preferred E-Mail Search Order Dialog Box
................................................................................................................................. 173
Edit Mailing List Command
................................................................................................................................. 173
Manage Mailing List Command
................................................................................................................................. 174
Compose the Minutes of the Meeting Dialog Box
................................................................................................................................. 174
Delegate To Dialog Box
................................................................................................................................. 175
Reschedule Request Dialog Box



Sidekick 98 Help

20 / 200

................................................................................................................................. 175
Accept Invitation Dialog Box
................................................................................................................................. 175
Decline Invitation Dialog Box
................................................................................................................................. 176
Cancel Event
................................................................................................................................. 176
Send Reminder
................................................................................................................................. 176
Reschedule
................................................................................................................................. 176
Reschedule Resource Reservation
................................................................................................................................. 176
Cancel Resource Reservation
................................................................................................................................. 177
Confirm Event
................................................................................................................................. 177
Delete Event
................................................................................................................................. 177
Event
................................................................................................................................. 177
Resource Reservation Wizard Step 1
................................................................................................................................. 177
Resource Reservation Wizard Step 2
................................................................................................................................. 178
Add Resources Command
................................................................................................................................. 178
Modify Resources Command
................................................................................................................................. 179
Remove Resources Command
................................................................................................................................. 180
Transfer Resources Command
................................................................................................................................. 180
Accept Resource Transfer
................................................................................................................................. 180
Decline Resource Transfer
................................................................................................................................. 181
Retransfer Resource
................................................................................................................................. 181
Undo Transfer
................................................................................................................................. 181
New Resource Manager Dialog Box
................................................................................................................................. 181
Distribute Resources Command
................................................................................................................................. 182
View Resources Command
................................................................................................................................. 182
Print Resources Command
................................................................................................................................. 182
Print Reservations Dialog Box
................................................................................................................................. 182



Sidekick 98 Help

21 / 200

Netscape Address Book Command
................................................................................................................................. 183
Eudora Pro Address Book Command
................................................................................................................................. 183
Exchange Address Book Command
................................................................................................................................. 183
Windows Address Book Command
................................................................................................................................. 184
Virtual Cardfiles
................................................................................................................................. 184
Launch URL Command
................................................................................................................................. 184
Shortcut Menu (Activities View)
................................................................................................................................. 185
Checking Your Schedule
................................................................................................................................. 185
Viewing Internet Group Scheduling Event Details
................................................................................................................................. 186
Creating a Group Event
................................................................................................................................. 186
Replying to an Event Invitation
................................................................................................................................. 186
Checking Event Replies
................................................................................................................................. 187
Entering Reply Status Manually
................................................................................................................................. 187
Rescheduling a Group Event
................................................................................................................................. 187
Canceling a Group Event
................................................................................................................................. 188
Adding More Participants to an Event
................................................................................................................................. 188
Adding a New Resource
................................................................................................................................. 188
Making a Resource Available to Others
................................................................................................................................. 188
Reserving a Resource for an Event
................................................................................................................................. 189
Transferring Management of a Resource
................................................................................................................................. 189
Changing a City Clock
................................................................................................................................. 189
Centering a City
................................................................................................................................. 190
Centering a Map Location
................................................................................................................................. 190
Comparing Time in Two Cities
................................................................................................................................. 190
Converting Measurements
................................................................................................................................. 190
Entering an Expense Receipt



Sidekick 98 Help

22 / 200

................................................................................................................................. 190
Creating an Expense Report
................................................................................................................................. 191
Changing Expense Report Options
................................................................................................................................. 191
Dialing a Voice Call Automatically
................................................................................................................................. 191
Entering a Call Note
................................................................................................................................. 192
Checking While-You-Were-Out Messages
................................................................................................................................. 192
Importing and Exporting
................................................................................................................................. 192
Importing and Exporting: Supported File Formats
................................................................................................................................. 193
Importing and Exporting: Maximum Values
................................................................................................................................. 193
Importing files in different formats
................................................................................................................................. 193
Exporting files
................................................................................................................................. 194
Import Wizard: Welcome
................................................................................................................................. 195
Import Wizard: Select File
................................................................................................................................. 195
Import Wizard: Target File
................................................................................................................................. 195
Import Wizard: Select Fields
................................................................................................................................. 195
Export Wizard: Welcome
................................................................................................................................. 195
Export Wizard: Select File
................................................................................................................................. 196
Export Wizard: Target File
................................................................................................................................. 196
Export Wizard: Select Fields
................................................................................................................................. 196
Customizing the Toolbar
................................................................................................................................. 196
Dragging Sidekick URLs into Your Web Browser
................................................................................................................................. 197
Introducing Starfish Web Publisher
................................................................................................................................. 197
Using Starfish Web Publisher
................................................................................................................................. 197
Introducing Starfish TrueSync
................................................................................................................................. 198
Using TrueSync for REX
................................................................................................................................. 198
Using TrueSync for PalmPilot
................................................................................................................................. 198



Sidekick 98 Help

23 / 200

Synchronizing Sidekick 98 and PalmPilot Data
................................................................................................................................. 199
About the REX card
................................................................................................................................. 199
Introducing vCard and vCalendar
................................................................................................................................. 200
Using vCard and vCalendar
................................................................................................................................. 200



Sidekick 98 Help

24 / 200

Font Dialog Box

Click the Font button in a calendar-printing dialog box to open the Font dialog box.

Dialog Box Options

Font
Sets the font typeface.

Font Style
Sets the font style: regular, italic, bold, or bold italic.

Size
Sets the point size for the font.

Select Font For
In Weekly, Monthly and Yearly view, sets the fonts to use for each part of the display of the selected view.
Click to select an item, then make all the font selections and click Apply.

Sample
Displays a sample of the selected font with the chosen attributes.

Script
In Daily view (some formats), sets the alphabet to use for text.

Apply button
In Weekly, Monthly and Yearly view, applies the specified font to the item selected in the Select Font For list.
Make sure to apply the changes you make to the fonts for each item in the Select Fonts For list before you
select another item or click OK. 

Created with the Personal Edition of HelpNDoc: Easily create EPub books

Search Setup Dialog Box

This dialog box opens when you click the Search Setup button in the Contact Manager dialog box.

Dialog Box Options

Search Within
Sets the activities and other text fields to include in the Contact Manager search. Check Appointments, Calls,
To Do, and/or Contact Log.

Created with the Personal Edition of HelpNDoc: Create cross-platform Qt Help files

To Do/Goals Dialog Box

In Calendar view, the Calendar | To Do Items | Single Day command opens the To Do dialog box, and the
Calendar | Goals command opens the Goals dialog box. The options are the same in both dialog boxes.

Dialog Box Options

Predefined Activities
Displays a list of predefined activities you can choose from. Predefined Activities are usually composed of
text and one or more field names, which are replaced with information from the current card. For example,
Call {Firstname} {Lastname} at {Phone}, when filled in with the current card information, might read Call
Michael Smith at 555-8943. If you choose an item from the Predefined Activities list, you can edit the text in
the Text field. If no Predefined Activities are listed, click the Setup button to open the Personal List Setup
dialog box.

https://www.helpndoc.com/feature-tour
https://www.helpndoc.com/feature-tour/create-help-files-for-the-qt-help-framework


Sidekick 98 Help

25 / 200

Subject
Sets the text (up to 500 characters) of the To Do or goal. Type text, or select an activity from the Predefined
Activities list.

Notes
Type a description or note about the activity. The Notes text can be up to 2000 characters. In Daily view, a
paperclip icon appears next to the To Dos or goals that have text in the Notes box.

Priority
Sets the priority for the To Do or goal to Low, Medium, High, or Advanced. If Advanced is chosen, you can
click the Advanced button to specify additional levels of priority. 

Advanced button specifies more detailed levels of priority than Low, Medium, or High. Advanced priorities
sort on two levels, first on A-B-C and then on 1-2-3-4-5-6. 

No Priority sets no priority for the To Do or goal.

Category
Specifies the category for the To Do or goal. In the To Do list and Goals list, you can sort To Dos and goals by
category. Select a category from the drop-down list. To create categories, click the Setup button. 

Assign
Specifies the person assigned to the To Do or goal (or the person who assigned it to you). Select a name
from the Assign drop-down list. To add names to the Assign list, click the Setup button.

Due Date
Sets the date by which the To Do or goal should be completed. The Due Date displays in the right-most
column of the To Do list or Goals list. You can sort items in the To Do list or Goals list by Due Date. Type the
due date, use the spin button to select a date, or click the down arrow and select a date from the mini
calendar.

No Due Date
When checked, specifies no completion date for the To Do or goal.

Completed

When checked, indicates that the To Do or goal is completed. A  appears next to completed tasks in the
Daily view, and the description line in the list is crossed out. The activity no longer forwards to the next day.

Timer
When checked, turns the timer on to record the elapsed time until the To Do or goal is completed. The timer
will run as long as Sidekick is running, up to 10,000 hours.

Default button
Saves the settings for Priority, Category, Assign, and Completed as default settings for new To Dos or goals.

Setup button
Opens the Personal List Setup dialog box, where you create or modify predefined activities, categories, and
assigns.

Recurring button
(To Do items only) Opens the Recurring To Do dialog box, where you can set the current To Do to recur. This
option is available only for To Dos.

Created with the Personal Edition of HelpNDoc: Easily create EBooks

Sort To Do Items/Goals List Dialog Box

Choosing Calendar | Sort | To Do Items opens the Sort To Do Items dialog box. Choosing Calendar | Sort |
Goals opens the Sort Goals List dialog box. The options are the same in both dialog boxes.

Dialog Box Options

Primary Index

https://www.helpndoc.com/feature-tour
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Sets the first attribute that the To Dos or goals will be sorted on.

Secondary Index
Sets the second attribute the To Dos and goals will be sorted on.

Order
Choose options that determine the order in which items are sorted:

Ascending sorts in ascending order according to the primary and secondary indexes.

Descending sorts in descending order according to the primary and secondary indexes.

Blank Indexes First moves To Dos or goals that have blanks for the index first.

Blank Indexes Last moves To Dos or goals that have blanks for the index last.

Sort Completed Items to Bottom automatically moves completed items to the bottom of the list when you
click another Calendar list.

Created with the Personal Edition of HelpNDoc: Free help authoring environment

Delete Recurring Dialog Box

To open this dialog box, click the Delete button in the Recurring To Do, Recurring Event, or Recurring Call
dialog box. 

Select the instances you want to delete:

· All Occurrences

· Future Occurrences

· Past Occurrences

Tip: Selecting Past Occurrences provides a good way to clean up old entries you no longer need.

Created with the Personal Edition of HelpNDoc: Single source CHM, PDF, DOC and HTML Help creation

Personal List Setup Dialog Box

To open this dialog box, click the Setup button in the To Do, Call, or Goals dialog box. Or choose Calendar |
Personal List Setup in the Daily Calendar view. 

Dialog Box Options

Setup Options
Selects the kind of option you want to change. Select Predefined Activities, Call Status, Category, or Assign.
Only options relevant to the activity in question are available. (For example, if you reached  this dialog box
from the To Do dialog box, Call Status is not an available option.) As the different options are selected, the
corresponding definitions for the options are displayed in the List box below. 

Field Names
Lists field names that you can add to the edit box when creating or modifying Predefined Activities. Double-
click a field name to add it at the cursor position in the Edit box. 

For example, if you have a field name called LastName, you can type "Meeting with" in the Edit box and then
double-click LastName in the Field Names list to create the following predefined activity: "Meeting with {-
LastName}".

Edit
Type or revise information here, and add field names by double-clicking them (for Predefined Activities).

List
Displays the items in the list for the item selected in Setup Options. You can add, delete, or change items in
the list.

Add button

https://www.helpndoc.com/help-authoring-tool
https://www.helpndoc.com/help-authoring-tool


Sidekick 98 Help

27 / 200

Adds the text in the Edit box to the List box.

Change button
Replaces the text in the List box with the text in the Edit box.

Delete button
Deletes the selected item in the List box.

Created with the Personal Edition of HelpNDoc: Full-featured EPub generator

Define Cardfile Fields Dialog Box

Use this dialog box to define fields for a cardfile. To open it, in Contacts view, choose Cards | Define Fields.

Dialog Box Options

Field Name
Type a new field name (up to 39 characters) or click on a field name you want to change.  Note: If the field is
to be used for Internet scheduling, the field name must include one of the following keywords indicating the e-
mail type: Exchange, Internet, CompuServe, AOL.

Add button
Inserts the new field name after the highlighted position in the field name list box. This button is dimmed if the
field name already exists.

Add Before button
Inserts a field name before the highlighted position in the field name list box. This button is dimmed if the field
name already exists.

Change button
Changes a field name. This button is dimmed if the field name already exists or a field name has not been
selected.

Delete button
Deletes a field name from the field name list. This button is dimmed if no field name is selected. 

Warning: By deleting a field name, you delete all the information in that field in the cardfile.

Sort By button
Opens the Sort Cardfile dialog box. Use this dialog box to change the index line, which determines the sorting
order of the cards in the cardfile.

OK button
Updates the active cardfile with the changes made to the field names defined. This button is dimmed if no
changes have been made to the field names and no changes have been made in the Sort By dialog box.

Created with the Personal Edition of HelpNDoc: Write eBooks for the Kindle

Ignore All Command (Shortcut Menu)

The Ignore All command appears on the shortcut menu when you right-click a word that has been marked by
AutoSpell as a possible misspelling. 

If you select Ignore All, the strikethrough is removed from the word at the current location and at all other
instances of that word in your memo. 

Created with the Personal Edition of HelpNDoc: Free EBook and documentation generator
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Date Stamp Command (Shortcut Menu)

To stamp todayʼs date at the insertion point in the Contact Log or current memo, right-click in the Contact Log
or memo to open the shortcut menu, and choose Date Stamp.

Shortcuts
Keyboard: Ctrl+D

Created with the Personal Edition of HelpNDoc: Easy CHM and documentation editor

Time Stamp Command (Shortcut Menu)

To stamp the current time at the insertion point in the Contact Log or current memo, right-click in the Contact
Log or memo to open the shortcut menu, and choose Time Stamp.

Shortcuts
Keyboard: Ctrl+T

Created with the Personal Edition of HelpNDoc: Create cross-platform Qt Help files

Edit Command (Shortcut Menu, Calendar)

The Edit command displays the appropriate daily entry dialog box for the selected activity: appointment, To
Do, call, or goal. Right-click the event and choose Edit from the shortcut menu.

Created with the Personal Edition of HelpNDoc: Full-featured EBook editor

Font Command (Shortcut Menu, Contacts)

The Font command in the shortcut menu displays the Change Display Font dialog box, where you choose the
display font for the cardfile.

Created with the Personal Edition of HelpNDoc: Easily create Qt Help files

Font Command (Shortcut Menu, Memos)

The Font command in the shortcut menu displays the Change Display Font dialog box, where you choose the
display font for the Memos view.

Created with the Personal Edition of HelpNDoc: Easily create CHM Help documents

Recurring Command (Shortcut Menu)

The Recurring command in the shortcut menu displays the appropriate dialog box: Recurring Event,
Recurring Call, or Recurring To Do.

Created with the Personal Edition of HelpNDoc: Write eBooks for the Kindle
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Send To Command (Shortcut Menu)

The Send To option in the shortcut menu lets you send information in a card or memo. Right-click in the
memo or card contents to use the Send To command. 

For more information, point to one of the Send To commands and press F1.

Created with the Personal Edition of HelpNDoc: Free PDF documentation generator

Send To Eudora Pro or Exchange Command (Contacts)

You can send the contents of a card to someone else via e-mail by using the Send To Eudora Pro or Send To
Exchange command in the shortcut menu.  These commands launch your Exchange or Eudora Pro (32-bit)
e-mail software and insert the card fields as text in an e-mail message. 

Created with the Personal Edition of HelpNDoc: Easy EBook and documentation generator

Send To Eudora Pro or Exchange command (Memos)

You can send the contents of a memo to someone else via e-mail by using the Send To Eudora Pro or Send
To Exchange commands in the shortcut menu.  These commands launch your Exchange or Eudora Pro (32-
bit) e-mail software and insert the text in an e-mail message.

Created with the Personal Edition of HelpNDoc: Produce electronic books easily

Send To Fax Command

You can fax a memo to someone using your fax modem. 

1. In Memos, use the Viewport to select one or more cards of people you want to fax the memo to. The cards
must include a field that contains the word “fax” in its name, and there must be a valid fax number in the
field. 

2. Right-click in the text area of the memo you want to fax, and choose Send To | Fax.

Created with the Personal Edition of HelpNDoc: Free Web Help generator

Add Card Dialog Box

The Add Card dialog box lets you add one or more cards to the current cardfile. To open this dialog box, in
Contacts view, choose Cards | Add. In Calendar or Memos view, choose Edit | Add Card.

Dialog Box Options

Card Contents
The fields of the current cardfile are displayed. Type the information you want to add for the new card.

Add button
Adds the current data to the cardfile. The dialog box is cleared and remains open so you can add another
card, if desired.

Close button
Closes the Add Card dialog box. If you have data in the dialog box, Sidekick asks if you want to add the
current data to the cardfile.

https://www.helpndoc.com
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Created with the Personal Edition of HelpNDoc: Free CHM Help documentation generator

Find Condition Dialog Box

In Contacts view, the Find Condition command (Edit | Find | Condition) opens the Find Condition dialog box.

Dialog Box Options

Condition 1 and Condition 2
Each condition consists of three parts:

Field Name (left):  Click the down arrow to select a field name to include in the condition. <Any Field> has
Sidekick search for the text in all fields; select <Any Field> only if the selected operator is Equal To or Not
Equal To.

Operator (center):  Click the down arrow to select an operator. Choose from the following operators:

Equal To

Not Equal To

Less Than

Less Than Or Equal To

Greater Than

Greater Than Or Equal To

Between (within the range). In the Value field (on the right), use a comma to separate the two values.

Outside (outside of the range). In the Value field (on the right), use a comma to separate the two values.

Value (right):  Type the text you want to search for.

If you want to add an OR condition, check the box in the Condition 1 area and fill in the condition.

If you want to add an AND condition, check the box below Condition 2 and fill in the condition.

Created with the Personal Edition of HelpNDoc: Create help files for the Qt Help Framework

Extract Cards on Condition Dialog Box

Use this dialog box to specify the conditions for extracting cards. To open it, in Contacts view, choose Tools |
Extract Cards | On Condition.

Dialog Box Options

Condition 1 and Condition 2
Each condition consists of three parts:

Field Name:  Click the down arrow to select a field name to include in the condition. <Any Field> has
Sidekick search for the text in all fields; select <Any Field> only if the selected operator is Equal To or Not
Equal To.

Operator:  Click the down arrow to select an operator. Choose from the following operators:

Equal To

Not Equal To

Less Than

Less Than Or Equal To

Greater Than

Greater Than Or Equal To

Between (within the range). Use a comma to separate the two values.

Outside (outside of the range). Use a comma to separate the two values.

Value:  Type the text you want to search for.

If you want to add an OR condition, check the box in the Condition 1 area and fill in the condition.

https://www.helpndoc.com
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If you want to add an AND condition, check the box below Condition 2 and fill in the condition.

Created with the Personal Edition of HelpNDoc: Free HTML Help documentation generator

Print Labels/Address Book/Envelopes Dialog Box

Use this dialog box to select the cards and lay out the format. To open it, in the Contacts, choose File | Print,
and then choose which of the three items you want to print.

Dialog Box Options

1 Select Cards to Print
Selects which cards to print as labels, address books, or envelopes:

Current Card prints a label, address book, or envelope using the current card of the active cardfile.

All Cards prints labels, address books, or envelopes using all cards in the active cardfile.

Index Range prints labels, address books, or envelopes from a range of cards in the active cardfile. Type
the index line information for the first and last cards of the range to print in the From and To boxes.

Selected Cards prints labels, address books, or envelopes using the selected cards in the active cardfile.

Marked Cards prints labels, address books, or envelopes using the marked cards in the active cardfile.

2 Choose Printing Style Template
Sets the size and position of labels or address book entries on a page. When printing envelopes, this sets the
overall design of the envelopes, excluding the addressee portion. 

A list of templates is provided to get you started. However, since all printers are different, you should make
sure the template you want to use prints correctly to your printer before printing many pages. You may have
to adjust the margins slightly.

Click the Set Up Template button to open the Set Up Template dialog box to edit template attributes, including
margins.

To delete a template, select it from the drop-down list and press the Delete key.

3 Choose Contents to Print
Sets the design of the label or address book entry. When printing envelopes, this sets the design of the
addressee portion of the envelope. Click the Set Up Contents button to open the Set Up Contents dialog box to
create or change a design. 

To delete a contents design, select it from the drop-down list and press the Delete key.

For detailed information on how to create the contents, see Designing Printing Label Contents.

4 Select Printing Options
Repeat Entire Set sets the number of copies of the entire label sheet, address book, or envelope set to
print.

Repeat Each Card sets the number of copies of each label, address book entry, or envelope to print
(before printing the next one in the set). Select this option to print multiple return address labels.

More Options lets you set additional printing options, such as the starting position for labels and index
tabs, page numbers, and a different print sort order than in the cardfile itself. See More (Printing) Options
Dialog Box for more information. For envelope printing, see More Options (Envelopes) Dialog Box.

Preview button
Lets you preview the labels, address books, or envelopes before printing.

Created with the Personal Edition of HelpNDoc: Produce electronic books easily

More (Print) Options Dialog Box

To open this dialog box, when printing labels or address books, click More Options in the Print dialog box.

Dialog Box Options
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Orientation
Sets the paper orientation: portrait or landscape. 

Other Options
Skip Blank Lines skips any blank lines or empty fields from the printed labels or address book entries.
Note that if the current label contents design contains a field name on the same line as other text, that other
text will always print, even if the information from that field is blank.

Skip Blank Cards skips cards in which all fields in the label format are empty.

Add Page Numbers prints page numbers at the bottom of address book pages.

Index Tabs prints alphabetical index tabs at the top of each address book page.

Separate Index Tabs prints each new index tab at the top of a new address book page.

Print Index Field
Sorts the printed address books or labels by the field you specify here. This is useful if you want to sort the
printed materials in a different way from the way they are sorted in the cardfile. For example, although your
cardfile may be sorted alphabetically by the Company field, you might want to print labels sorted by Zip Code.

Start Print Position
Sets the row and column position on a label sheet to begin printing. This is useful when printing to partially
used label sheets.

Created with the Personal Edition of HelpNDoc: Produce Kindle eBooks easily

Template Setup Options Dialog Box

To open this dialog box, when printing from Contacts view, click the Options button in the Set Up Template
dialog box.

Dialog Box Options

Reverse Side Printing Options 
When Print on Both Sides is checked in the Set Up Template dialog box, use these options for printing to
asymmetrical pages.

Left to Right Mirror Image switches the left and right settings for label and page margins when printing the
reverse side of address book pages.

Top to Bottom Mirror Image switches the top and bottom settings for label and page margins when
printing the reverse side of address book pages. This makes the printout horizontally symmetrical.

Reverse Order of Pages on Reverse Side prints the reverse side of the address book pages in reverse
order, starting with the last page of the address book. 

Binder Holes Position
Use these options when printing to paper with more than one address book page per sheet. Choose

Same Side when all binder holes on address book pages are on the same side of each sheet of paper.

Centered when all binder holes on address book pages are toward the center of the sheet of paper.

Mirrored when all binder holes on address book pages are toward the outside edges of the sheet of paper.

Created with the Personal Edition of HelpNDoc: Write EPub books for the iPad

Set Up Label/Address Book Template Dialog Box

In Contacts view in the Print Labels/Address Book/Envelopes dialog box, click the Set Up Template button to
open the Set Up Template dialog box, where you can set exact page margins and layout for your labels or
address book.

Dialog Box Options

Page Margins
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Sets the margins on the sheet of paper that is being printed to. 

For address book printing, the number of "pages" to one sheet of paper can vary from one to four. Therefore,
the Page Margins for the paper will adjust the distances from the top, bottom and sides of the paper to the
edge of the pages, as well as the horizontal and vertical distance between the pages that the paper is divided
into (set as horizontal and vertical page margins).

Label Margins
Sets the dimensions of the labels on the page, adjusting the distance from the top, bottom, and sides of the
paper to the edge of the labels, as well as the vertical and horizontal distance between the labels. In address
book printing, label margins adjust the distance from the top, bottom, and sides of the page, as well as the
vertical and horizontal distance between the labels on a page.

Page Layout
Sets the number of rows of labels to a page, the number of columns of labels to a page, and the number of
pages to a sheet of paper. The number of pages is used for address book and index card printing only.

Print on Both Sides
Use this option for printing address books to both sides of the paper. When this option is checked, Sidekick
prompts you to reinsert the paper after the first sides of the address book pages are printed. Choose OK from
Sidekick to begin printing the second sides of the address book pages. For more information, see Reverse
Side Printing Options in the Template Setup Options dialog box.

Opposite Corners
When one of the vertical page options is selected in Pages (2v or 3v), use this option to turn the page to print
opposite corners. 

Save As button
Saves the changes you have made to the template (or saves as a new template), and closes the dialog box.

Cancel button
Cancels the changes you have made to the template, and closes the dialog box.

Options button
Sets several reverse-side printing options and specifies the position of binder holes. 

Test Print button
Prints a sample sheet of labels that indicates the exact margins of the printed output. Match this test print
sheet to the actual sheet of labels.

Created with the Personal Edition of HelpNDoc: Full-featured EPub generator

Set Up Contents Dialog Box

Dialog Box Options

Save As button
Saves the changes you have made to the contents (or saves as new contents), and closes the dialog box.

Cancel button
Cancels the changes you have made to the contents, and closes the dialog box.

Hint button
Displays helpful hints for designing the contents. 

Click to Add
Card Fields button creates a text element that can include cardfile fields. After you click the Label button,
the Edit Label Text dialog box appears with a list of cardfile fields. Double-click a field to add it to the label
text. 

Text button creates a text element. Opens the Edit Text dialog box. Type the text you want in the Text
element, and click the OK button. 

Graphic button creates one of four graphic elements: Bitmap, Frame, Round Frame, or Line.

https://www.helpndoc.com/create-epub-ebooks
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Stamp button creates a stamp element from a number of ready-made phrases. Text can be rotated by
right-clicking.

Modify Selection button
Customizes the selected element. This command displays the shortcut menu for the selected element. The
shortcut menu lists editing options appropriate for the type of elements selected: Alignment for Text elements,
for example, or Thickness for lines. (You can also change the contents of Card Fields elements or Text
elements by double-clicking them.)

Zoom button
Magnifies or reduces the area shown onscreen.

Show Grid 
Shows the grid used in aligning elements. (See Snap to Grid, below.)

Snap to Grid
Causes elements to “snap” to a regular grid of points when you create or move them. This is useful for
aligning elements.

Created with the Personal Edition of HelpNDoc: Benefits of a Help Authoring Tool

Set Up (Envelope) Template Dialog Box

In Contacts view in the Print Envelopes dialog box, click the Set Up Template button to open the Set Up
Template dialog box.

Dialog Box Options

Save As button
Saves the changes you have made to the envelope template (or saves as a new template), and closes the
dialog box.

Cancel button
Cancels the changes you have made to the template, and closes the dialog box.

Hint button
Displays helpful hints for designing the envelope template. 

Click to Add
Card Fields button is not enabled in this dialog box, because you only need to add Card Field information
in the addressee portion of the envelope. To do so, use the Set Up Contents dialog box.

Text button creates a text element. Clicking Text opens the Edit Text dialog box. Type the text you want, and
click OK. 

Graphic button creates one of four graphic elements: Bitmap, Frame, Round Frame, or Line.

Stamp button creates a stamp element from a number of ready-made phrases. Text can be rotated by
right-clicking. 

Modify Selection button
Customizes the selected element. This command displays the shortcut menu for the selected element. The
shortcut menu lists editing options appropriate for the type of elements selected: Alignment for Text elements,
for example, or Thickness for lines. (You can also change the contents of Text elements by double-clicking
them.)

Zoom button
Magnifies or reduces the area shown onscreen.

Show Grid
Shows the grid used in aligning elements. (See Snap to Grid, below.).

Snap to Grid
Imposes a regular grid of points that elements will snap to. This is useful for aligning elements.

https://www.helpauthoringsoftware.com
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Created with the Personal Edition of HelpNDoc: Easily create CHM Help documents

More Options (Envelopes) Dialog Box

Dialog Box Options

Feed and Orientation 
Sets the envelope feed direction and orientation.

Options
Skip Blank Lines skips any blank lines or empty fields from the printed labels or address book entries.

Skip Blank Cards skips cards in which all fields in the label format are empty.

Manual Feed lets you manually feed envelopes to the printer, rather than having the printer print from a
stack.

Print Index Field
Sorts the printed address books or labels by the field you specify here. This is useful if you want to sort the
printed materials in a different way from the way they are sorted in the cardfile.

Margins
Sets the top and left margins of the envelope printing area.

Created with the Personal Edition of HelpNDoc: Write eBooks for the Kindle

Back Up And Restore Dialog Box

To open this dialog box, choose File | Back Up and Restore. Choose the action you want: Back Up or
Restore.

Dialog Box Options

Overwrite Confirmation 
Check to have Sidekick notify you when you are backing up or restoring files over any existing files with the
same names.

Next >>
Click to proceed. The Back Up dialog box or Restore dialog box appears.

Created with the Personal Edition of HelpNDoc: News and information about help authoring tools and software

Back Up Dialog Box

 Related topics

To open this dialog box, choose File | Back Up and Restore, click Back Up, and click Next. Choose the drive
and directory of the files you want to back up. You can copy multiple files across multiple disks, as long as no
single file is larger than the capacity of a disk.

Dialog Box Options

Source File Directory 
Click the Browse button if you need to change the directory from which files will be backed up. The Change
Source Directory dialog box opens, and you can specify the source directory. You can back up files from
different directories by changing directories and selecting files from them.

Source Files
Click each file you want to back up. Notice that all cardfiles in the directory are grouped under the heading
[Cardfile], all calendar files are under the [Calendar] heading, and so forth with other Sidekick files. Other
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(non-Sidekick) files are listed under the [Other] heading. 

Back Up Following Files
Displays the files you have selected to back up. 

Destination Directory 
Click the Browse button if you need to change the directory to which the files will be copied.  The Change
Destination Directory dialog box opens, and you change the destination directory. 

>
Adds the selected files in the Source Files list to the Back Up list.

>>
Adds all files listed in the Source Files list to the Back Up list.

< 
Removes the selected files from the Back Up list.

<<
Removes all files from the Back Up list.

Previous
Discards the settings youʼve specified and returns you to the opening Back Up and Restore dialog box.

Begin
Begins the backup process.

Created with the Personal Edition of HelpNDoc: Free EPub producer

Restore Dialog Box

 Related topics

To open this dialog box, choose File | Back Up and Restore, click Restore, and click Next.

Dialog Box Options

Source file directory 
Click the Browse button if you need to change the directory from which files will be restored. The Change
Source Directory dialog box opens, and you can change the source directory. 

Source Files 
Click each file you want to restore and click the > button to add it to the Restore list. Notice that all cardfiles in
the directory are grouped under the heading [Cardfile], all calendar files are under the [Calendar] heading,
and so forth with other Sidekick files. Other files are listed under the [Other] heading.

Restore File Names and Destinations 
Displays the file names you select to restore, and the directory to which the files will be restored.

Change Destination Directory for the Selected Files
Highlight files from the Restore File Names and Destinations list, and then click the Browse button if you need
to change the directory to which the files will be restored. The Change Destination Directory dialog box
opens, and you can change the destination directory. 

>
Adds the selected files in the Source Files list to the Restore list.

>>
Adds all files listed in the Source Files list to the Restore list.

< 
Removes selected files from the Restore list.

<<
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Removes all files from the Restore list.

Previous
Discards the settings you've specified and returns you to the opening Back Up and Restore dialog box.

Begin
Begins the restore process.

Created with the Personal Edition of HelpNDoc: Free help authoring environment

Fill In Information Dialog Box

This dialog box appears when your memo template contains field names (in brackets, as merge fields) that do
not exist in the cardfile you are merging with the memo.

Dialog Box Options

Find
By default, this field contains the field name that does not exist in the cardfile. You can change this text if you
want to search for something else.

Replace With
In this field, type the text you want to replace the Find text with. Each time you use different Replace With text,
it is added to the list below this field. You can click any text in the list to bring it into the Replace With field
again. 

Replace
Replaces the selected text in the memo with the text in the Replace With field, then selects the next
occurrence of the text from the Find field. 

Replace All
Replaces all occurrences of the Find text with the Replace With text.

Ignore
Ignores the selected text in the memo, and finds the next occurrence of the Find text.

Ignore All
Ignores all occurrences of the Find text.

Close
Closes the dialog box.

Created with the Personal Edition of HelpNDoc: Free help authoring tool

Change Directory Dialog Box

Dialog Box Options

Directories
Displays the directories available on the current drive. 

Drive
Displays the current drive. Click the down arrow to choose another drive. 

Network
Displays the Map Network Drive dialog box, which allows you to map drive letters to network drives.
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Created with the Personal Edition of HelpNDoc: Generate EPub eBooks with ease

Match Cardfile Fields Dialog Box

To open this dialog box, click OK in the Move Cards dialog box, or drag a cardʼs index line to another cardfile
tab. 

Select a field from each cardfile and click the Match button.

Dialog Box Options

Source Cardfile List
Lists the fields in the source cardfile.

Destination Cardfile List
Lists the fields in the destination cardfile.

Match
Matches the selected field from each cardfile.

Remember the Matches
Saves the matches, so that these same fields will be automatically matched in the future. 

Delete Match Fields button
Displays the Delete Match Fields dialog box, where you change the list of remembered matches.  

Remove button
Removes the selected match (for this instance only, not affecting the permanent matches).

Created with the Personal Edition of HelpNDoc: Create HTML Help, DOC, PDF and print manuals from 1 single
source

Delete Match Fields Dialog Box

Delete
Deletes the selected match from the remembered matches.

Created with the Personal Edition of HelpNDoc: Qt Help documentation made easy

Remove Duplicate Cards Dialog Box

This dialog box opens when you click Open in the Merge Cardfiles dialog box.

Dialog Box Options

Replace Cards in the Current Cardfile
Replaces the duplicate cards in the open cardfile with cards from the second cardfile. 

Retain Cards in the Current Cardfile
Retains the duplicate cards in the open cardfile and ignores the cards in the second cardfile. 

Do Not Remove Cards
Keeps all cards, including any duplicates. 

Created with the Personal Edition of HelpNDoc: Benefits of a Help Authoring Tool
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Change Display Font Dialog Box

The Change Display Font dialog box contains options for changing the fonts you see onscreen. To open this
dialog box, choose Tools | Preferences | General (or Tools | General Preferences, in Report and EarthTime
views), and then click the Fonts button in the General Preferences dialog box.

Dialog Box Options

Font
Sets the font typeface.

Font Style
Sets the font style (for example, regular, italic, bold, or bold italic).

Size
Sets the point size for the font.

Select Font For
Sets the fonts to use for each part of the display of the selected view. Click to select an item, then make all the
font selections and click Apply or OK.

Sample
Displays a sample of the selected font.

Apply
Applies the specified font to the item selected in Select Font For. (If only one item is available in the Select
Font For list, this button does not appear; click OK to apply your changes.)  

Created with the Personal Edition of HelpNDoc: Full-featured EBook editor

Modify Cardfile Template Dialog Box

To open this dialog box, from the Contacts view, choose File | Template, and then click the Modify button in the
Set Up Cardfile Template dialog box.

Dialog Box Options

Field Name
Type a new field name (up to 39 characters) or select the field name you want to change. 

Add
Inserts the new field name after the highlighted position in the field name list box. This button is unavailable if
the field name already exists.

Delete
Deletes the selected field name from the field name list. This button is unavailable if no field name is selected.

Up
Moves the selected field higher in the list by one slot.

Down
Moves the selected field lower in the list by one slot.

Created with the Personal Edition of HelpNDoc: Qt Help documentation made easy

Paper Setup Dialog Box

You can edit the margins of the paper type on which you print your Sidekick daily calendar. Click the Edit
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button in the Print Sidekick Format dialog box to open the Paper Setup dialog box.

Dialog Box Options

Paper Type
Sets which paper type you modify. Type a new paper type name or select the one you want to change. 

Margins
Sets the left, right, top, and bottom margins of the current paper type.

Add
Adds a new paper type, if you have typed a new name in the Paper Type field.

Delete
Deletes the currently selected paper type.

Change
Saves the changes you have made to the paper type.

Created with the Personal Edition of HelpNDoc: Free iPhone documentation generator

Select Cardfile Template

In Contacts view, the New Cardfile command (File | New Cardfile) opens the Select Cardfile Template dialog
box.

Dialog Box Options

Cardfile Template
Sets the cardfile template to use as a basis for your new cardfile. Choose None to use no templates. 

Field Names
Shows the fields in the selected cardfile template.

Created with the Personal Edition of HelpNDoc: Easy to use tool to create HTML Help files and Help web sites

Print Dialog Box

This dialog box opens when you choose File | Print from Weekly, Monthly, or Yearly view and you choose a
Sidekick 98 format.

Dialog Box Options

From/To
Sets the range of dates to print. The default From day is the first day shown in that view. The default To day
depends on what type of format you choose to print.

Title
Type the title for the printed calendar.

Footer 
Type a running footer for the printed calendar.

Print Selection
Today's Date prints today's date at the bottom right corner of your calendar.

Mini Calendar prints small versions of the previous month's and next month's calendars in the top corners
of your calendar. If this option is selected, you will not be able to print graphics in the corners using the
Graphic Selection options.

Graphic Selection
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Sets a graphic to appear at the top left and/or the top right corners of the printed calendar. Choose which
corner to set the graphic at, and choose the graphic from the Picture list. Click Apply to set that graphic in the
selected corner. Click View to view that graphic.

Margins
Sets up the margins for the left, top, right and bottom of the printout. Type each margin number or use the up
or down arrow buttons to increment or decrement the margins.

Fonts button
Sets the fonts to be used in printing; opens the Font dialog box.

Setup button
Sets up your printer.

Preview button
Previews the calendar before you print it.

Created with the Personal Edition of HelpNDoc: Full-featured Kindle eBooks generator

Print Activities Dialog Box

The Print Activities dialog box opens when you choose File | Print in the Activities view.  The title that appears
on the dialog box, and the options available, change depending on which tab you have clicked.  Click the
Internet Events tab if you want to be able to print a summary or the details of your group events. For other
tabs, only Summary is available. 

Dialog Box Options

Print Summary/Internet Event Details
Click one button or the other to specify what you want to print. If you click Internet Event Details, specify the
events you want to include in the Internet Event Details to Print pane. 

Events/Event Details to Print
Click one button or the other to specify whether you want to print the details for only the selected items or for
all items.

Preview button
Click to see a preview of the printed output.

Created with the Personal Edition of HelpNDoc: iPhone web sites made easy

Sidekick Password Setup Dialog Box

To open this dialog box, choose Tools | Preferences | General (or Tools | General Preferences, in Report and
EarthTime views), and then click the Password button.

Dialog Box Options

Old Password
Enter your old password. This field is empty if this is the first time you are creating a password. 

New Password
Enter the new password. 

Repeat Password
Enter the password again, for confirmation. 

Note The Sidekick Password Setup dialog box is case-sensitive.
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Enter Password Dialog Box

Password
Enter your password. 

Note The Password dialog box is case-sensitive.

Created with the Personal Edition of HelpNDoc: Free Qt Help documentation generator

Deskpad Color Setup Dialog Box

Sets the Deskpad color for each Sidekick view.

To open this dialog box, click the Deskpad Colors button in the General Preferences dialog box. You can
choose a different Deskpad color for each Sidekick view. Click the arrow by the color box, and then click the
color you want from the drop-down palette.

Created with the Personal Edition of HelpNDoc: Create HTML Help, DOC, PDF and print manuals from 1 single
source

Extract Criteria Dialog Box

When you select Memos by Condition in the Extract Memos dialog box, this dialog box appears so you can
enter the conditions.

Dialog Box Options

Subject 
Enter any text you want to find in the memos  ̓subject lines.

Contents
Enter any text you want to find in the memos  ̓contents.

Date Range
Choose whether you want to search After a date, Before a date, or Between two dates.

Match Whole Word Only
Check this box to extract memos containing the search text only in whole words. For example, if you search
for the word “too” and check the Match Whole Word Only box, memos with the word “too” will be extracted,
but not memos with the word “tool.”

Match Case 
Check this box to extract memos containing the search text only when the capitalization matches exactly what
you type in the Subject or Contents field above.

Created with the Personal Edition of HelpNDoc: Create cross-platform Qt Help files

Toll Prefixes Dialog Box

Used to specify any exchanges within your area code that must be preceded by 1+area code when dialing. 
To open this dialog box, choose Phone | Setup, and then click the Toll Prefixes button.

Dialog Box Options
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Local Phone Numbers
This list initially contains all possible three-digit combinations, because all exchanges within an area code are
usually dialed without the area code itself. 

Dial 1-xxx First
Add to this list any exchanges within in your area code that require dialing the area code first.

Add button
Select a number in the Local Numbers list and click Add to move it to the Dial 1-xxx First: list.

Remove button
Select a number in the Dial 1-xxx First list and click Remove to move it to the Local Numbers list.

Add All button
Click this button to move all exchanges from the Local Numbers list to the Dial 1-xxx First list.

Remove All button
Click this button to remove all numbers from the Dial 1-xxx First list.

Created with the Personal Edition of HelpNDoc: Easily create EPub books

Setup Wizard: General Information

The Setup Wizard runs the first time you start Sidekick. It asks you for some essential information about
yourself and your location, such as where you live (your time zone) and your electronic mail information. 
Later, you can change these settings by starting the Setup Wizard again (Tools | Setup | Wizard or Tools |
Setup Wizard, depending on the active view), or by choosing Tools | Preferences | Group Scheduling.

Enter or revise the information about yourself. If Windows knows your name and company name, they are
automaticallly entered, although you can change them as desired.

When done, click Next to continue or click Cancel.

Created with the Personal Edition of HelpNDoc: Create iPhone web-based documentation

Setup Wizard: Choose Location

Click the arrow in the Choose the Country box, and click the country where you are located. Then click the
arrow in the Choose the City box, and specify your city.  

Note If your city doesnʼt appear in the list, pick the closest city to you that is in the same time zone.

When done, click Next to continue, Back for the previous page, or Cancel.

Created with the Personal Edition of HelpNDoc: Easily create Qt Help files

Setup Wizard: E-mail Type

Click one of the buttons to select your choice:

Automated Setup (recommended) lets Sidekick scan for e-mail services on your computer.

Custom Setup lets you specify your e-mail service yourself, after the Wizard scans to see what systems are
available on your system.

Do not set up now disables all electronic mail services. You will not be able to use Sidekickʼs group
scheduling features, which rely on e-mail.

The e-mail systems recognized by the Setup Wizard are the following: Eudora Pro, Eudora Light,  Microsoft
Exchange, Microsoft Internet Mail, Pegasus, Netscape Mail.
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Note If your hard disk contains lost clusters or other damaged data, it can interfere with the scanning
process.  If the scan takes a very long time, you can interrupt it by pressing Cancel, and run the
Windows 95 ScanDisk program. Click the Start button, Programs, Accessories, System Tools,
ScanDisk.

When done, click Next to continue, Back for the previous page, or Cancel.

Created with the Personal Edition of HelpNDoc: Free help authoring environment

Setup Wizard: Set Up Your Service

If you click the Continue Setup… option, the Wizard will set up the e-mail service it has found for the
messages required for group scheduling. 

If you click the Go to Custom Setup… option, the Wizard takes you to the option to select the e-mail transport
you want to use.

When done, click Next to continue, Back for the previous page, or Cancel.

Created with the Personal Edition of HelpNDoc: Easy CHM and documentation editor

Setup Wizard: Which Service?

If the Wizard found more than one e-mail systems on your computer, the list appears here. Click the one you
want to use for group scheduling messages.

When done, click Next to continue, Back for the previous page, or Cancel.

Created with the Personal Edition of HelpNDoc: Create iPhone web-based documentation

Setup Wizard: No Service Found

No Internet Mail service was found on your system. 

If you choose I Do Not Have an Internet E-mail System, the Wizard will check to see if you have Microsoft
Exchange installed. 

If you choose I Do Have an Internet E-mail System, you will be asked to provide information about it.

When done, click Next to continue, Back for the previous page, or Cancel.

Created with the Personal Edition of HelpNDoc: Produce online help for Qt applications

Setup Wizard: Choose Profile

Click the arrow next to Preferred Profile, and choose the Microsoft Exchange profile you want to use for
group scheduling (your profile includes information about the location of your Inbox, Outbox, and address
lists).

The Delete Messages after Retrieving box should be checked unless you need to be able to access group
scheduling messages from more than one location.

Enter your Internet address in the box so that Sidekick can use Exchange for group scheduling on the
Internet.

When done, click Next to continue, Back for the previous page, or Cancel.

Created with the Personal Edition of HelpNDoc: Easy EBook and documentation generator
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Setup Wizard: Mail Server Information

Sidekick needs to know the location of the mail servers for your incoming mail (called a POP3 server) and
outgoing mail (called an SMTP server). Enter the information in the text boxes provided. If necessary, ask
your network administrator or Internet service provider for assistance.

When done, click Next to continue, Back for the previous page, or Cancel.

Created with the Personal Edition of HelpNDoc: Benefits of a Help Authoring Tool

Setup Wizard: POP3 Information

Enter the required information about your electronic mail account for incoming mail. 

POP3 Account is the name you use for logging on to the POP3 server. Type the name exactly as it is entered
when you log on.

Delete messages after retrieving them, when checked, deletes messages after they have been read by
Sidekick.  Uncheck the box if you want to leave the messages on the server.

POP3 Password is the password associated with your account name. Type it again in the Retype box to
confirm.

When done, click Next to continue, Back for the previous page, or Cancel.

Created with the Personal Edition of HelpNDoc: Free EPub producer

Setup Wizard: Name and Address

Enter the name and electronic mail address to be used with group scheduling messages.

Name is your name as you would like it to appear in group scheduling messages. (This does not have to
match your log-in name.)

E-mail Address is the address to which you want e-mail messages for scheduling events and replying
invitations sent. 

When done, click Next to continue, Back for the previous page, or Cancel.

Created with the Personal Edition of HelpNDoc: Easy CHM and documentation editor

Setup Wizard: Flash Sessions

Check Activate Flash Sessions if you want Sidekick to automatically initiate electronic mail sessions to send
and receive group scheduling messages.

Specify the time when you want the first session, and how often sessions should occur after that.

Check each day when you want flash sessions to occur.

When done, click Next to continue, Back for the previous page, or Cancel.

Created with the Personal Edition of HelpNDoc: Free CHM Help documentation generator

Setup Wizard: Registration Information

Starfish Softwareʼs electronic registration makes it easy for you to become a registered user. Just fill in the
information in the text fields provided.  Be sure the Yes response at the top of the screen is selected.
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The completed registration form will be sent to Starfish Software automatically by e-mail during your next
online session.

When done, click Next to continue, Back for the previous page, or Cancel.

Created with the Personal Edition of HelpNDoc: Free help authoring tool

Setup Wizard: Registration Address

Type your address information in the text boxes.  By providing your mail address, you make it possible for
Starfish Software to keep you informed of updates to Sidekick 98 and new products.

When done, click Next to continue, Back for the previous page, or Cancel.

Created with the Personal Edition of HelpNDoc: Free EPub and documentation generator

Setup Wizard: Registration Options

Click the apprpropriate responses to the questions regarding e-mail notification and use of the Starfish
Software list.

When done, click Next to continue, Back for the previous page, or Cancel.

Created with the Personal Edition of HelpNDoc: Easy CHM and documentation editor

Setup Wizard: Mail Registration

Because you have not entered e-mail information, electronic registration is not available. If you want to enter
e-mail information now, click the Back button and choose Automated Setup (the recommended choice) or
Custom Setup. 

You can also double-click the file called REGISTER.TXT in the Sidekick 98 directory to open it.  Fill in your
information, and print a copy of the completed file to mail to Starfish Software.

When done, click Next to continue, Back for the previous page, or Cancel.

Created with the Personal Edition of HelpNDoc: Free Web Help generator

Setup Wizard: Finish

You have entered the required information. Click Finish to complete the setup process and return to Sidekick,
or click Back for the previous page, or Cancel.

Created with the Personal Edition of HelpNDoc: Free HTML Help documentation generator

Attach a Uniform Resource Locator

 Related topics

Lets you enter a  Web site address (URL) in the Message text field. Click the Attach URL button on the
Message page of the Schedule a Group Event dialog box to open the Attach a Uniform Resource Locator
dialog box.  

Recipients can click the URL to launch their default browsers and jump directly to the site (requires a 32-bit
browser).
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Dialog Box Options

Description
Type a description of the URL youʼre attaching. Recipients click on the URL to launch their browsers and go
directly to the site.

Uniform Resource Locator (URL)
Enter the URL address for the site, such as http://www.starfish.com.

Created with the Personal Edition of HelpNDoc: Full-featured EBook editor

E-mail Setup Dialog Box

Use the E-mail Setup dialog box to enter your Internet e-mail configuration.

Dialog Box Options

Outgoing Mail (SMTP) Server 
Enter the name of your outgoing server or host, such as mail.xyz.com.

Incoming Mail (POP3) Server
Enter the name of your incoming mail server or host, such as mail.xyz.com.

Pop User Name
Enter your user name, such as jsmith@xyz.com.

Pop User Password
Type your password.

Time Out After
Determines how long the POP3 server waits for data before “timing out.”

Your Name
Type your name as you would use it in correspondence.

Your E-mail Address
Enter your e-mail address, such as jsmith@xyz.com.

Your Organization
Type the name of your company or organization.

Created with the Personal Edition of HelpNDoc: Easy EBook and documentation generator

New Report Dialog Box

The New Report dialog box opens when you choose File | New Report from within Report view.

Dialog Box Options

New Report
Click to create a new report.

Open Report
Click to open a report saved on disk.

Current Report
Click to go to the currently open report.

Create New (report type)
If you check New Report, check the report type you want in this list.
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Created with the Personal Edition of HelpNDoc: Write eBooks for the Kindle

Select Cardfile To Save To Dialog Box

The Select Cardfile To Save To dialog box opens when you click Save To Card in the Phone Dialer. The
currently selected item in the Call History window is saved to the cardfile you specify in this dialog box. 

Click the cardfile you want to save to, and then click OK. 

Created with the Personal Edition of HelpNDoc: Generate Kindle eBooks with ease

Starfish TrueSync

To use Starfish TrueSync, click Tools | Synchronize | TrueSync, or click the TrueSync button  on the
Toolbar.

This dialog box shows handheld devices that Sidekick 98 recognizes. Starfish Software is constantly adding to
this list. For details, visit the Starfish Software Web site:
http://www.starfish.com

If a device is installed on your system, you can use this dialog box for synchronizing and related tasks, as
follows:

PalmPilot Handheld Device

If you have PalmPilot installed, click that device  in the list, and then click:

Synchronize to begin the synchronization process.

Configure to select your synchronization preferences.

View Output Log to see the results of your last synchronization.

HotSync Manager to select your HotSync Manager Startup Preferences.

For details about TrueSync for PalmPilot and synchronizing, click the Help button in any of the TrueSync
Wizard dialogs, and click Contents. 

REX Handheld Device

If you have REX installed, click that device  in the list, and then click:

Synchronize to begin the synchronization process.

Configure to select your synchronization preferences.

WinCE 2.0 Handheld Device

If you have WinCE installed, click that device  in the list, and then click:

Synchronize to begin the synchronization process.

Configure to select your synchronization preferences.

Created with the Personal Edition of HelpNDoc: Full-featured Documentation generator
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Introducing Starfish Sidekick 98

Welcome to Starfish Sidekick 98!

Sidekick 98, the #1 organizer, provides you with powerful new features that are designed to keep you
connected at any time, anywhere. You can synchronize your calendars, contacts, and communications with
the click of a button, whether youʼre connected to the Internet, a hand-held computer, or a laptop.

Key features 
Automatically synchronize your calendar, contacts, notes, and To Do items with your Pilot Organizer or
REX card, using TrueSync™ technology.

Easily drag and drop vCard and vCalendar objects into the Contacts and Daily Calendar views, or drag and
drop URLs from Sidekick into your Web browser.

Use Sidekick 98ʼs advanced technology for importing and exporting files in various formats. With just a few
clicks, you can import files into the Contacts view in formats ranging from ASCII tab-delimited files to
Microsoft Outlook 97 to dBASE, using Sidekick 98ʼs unique Import Wizard. You can export Sidekick
cardfiles to ASCII, tab- and comma-delimited text, dBASE, and Spreadsheet Data (DIF) using the Export
Wizard. You can also import Microsoft Outlook 97, Schedule+ 7.0, and Lotus Organizer 97 calendar files
into the Calendar view.

Manage your appointments and contacts by using the global resources of the Internet.

Take advantage of the most advanced calendar and contacts features available.

Use the Web Publisher to publish calendars and cardfiles in fully formatted and linked HTML files for
sharing on the Internet or corporate intranets.

Easily schedule events with people anywhere in the online world, whether they are in your own city or on
the other side of the world, with the peer-to-peer, agent-based design.The Sidekick 98 Internet-based
scheduling features handle event and resource scheduling automatically. All the messaging needed to
schedule the event is handled in the background. Your Eudora Pro (32-bit), Netscape Navigator, Microsoft
Exchange, or Windows address book can be used for event scheduling.

Enjoy the panoramic view and multi-functionality available in EarthTime, customize the Toolbar, and more –
just a few of the features that are now yours in Sidekick 98!

Created with the Personal Edition of HelpNDoc: Free EPub producer

Overview: Learning about Sidekick 98

 Related topics

Starfish Sidekick 98 is divided into a number of “views,” such as the Calendar view and the Contacts view. To
learn about Sidekick 98, use the series of “About…” topics, which introduce the views and major features. 

Here is how to use these overview topics:

Click the Related Topics button, above, for a list of the About… topics.

Read each topic, using the scroll bars to see all the information, if necessary.  

Click the >> button at the top of each screen to go to the next About… topic.  You can click the << button
to go back to the previous topic.  Each topic discusses one of the Sidekick views.

To see more information relating to the current subject, click the Related Topics button that appears below
the topic title in each topic. Double-click the topic you want in the list. 

To return to this topic, click the Related Topics button and choose the “Overview…” topic.

The overview topics are also listed in the Table of Contents at the start of each of the major sections that
discusses a view.

For more information about using the books and topics in this Help system, click the underlined text that
follows, and you will go directly to How to Use Sidekick Help.

Created with the Personal Edition of HelpNDoc: Easily create CHM Help documents
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About the Calendar View

 Related topics

{bml bm8.BMP}The Calendar view organizes your appointments, To Do items, and the calls you need to make,
all in one convenient place.  It includes the Viewport, which lets you see other Sidekick views and drag-and-
drop to create an activity with someone in your cardfile. You can also create group events in the Calendar (or
Activities view), where Sidekick 98 sends invitations and books the event for you automatically. 

You can import calender files with just a few clicks. Sidekick 98 supports Microsoft Outlook 97, Schedule+
7.0, and Lotus Organizer 97.

In addition, you can easily drag and drop vCalendar objects into the Daily Calendar view. For details, see
Using vCard and vCalendar.

Features and Options
Events pane is where you create and view scheduled events. At the top is the current time zone in which
Calendar events are displayed. Click any line and begin typing to enter a basic appointment. Double-click a
time slot or appointment icon to open the Schedule an Event dialog box. See Adding an Appointment.

To Do pane contains a list of the items you need to do. You can assign a due date and priority, and add text.
Click the Show By button to specify how the items are sorted. Click the left column to check off a completed
To Do item.  Uncompleted To Do items are automatically forwarded from day to day. See To Do / Goals Dialog
Box.

Calls pane lists calls you need to make. Click the left column to check off a completed call.  Uncompleted
calls are automatically forwarded from day to day. See Calls.

Viewport is at the bottom of the Events pane.  Click the arrow button to open or close it.  You can view Cards,
the Contact Log, or the Goals list in the Viewport. You can drag a card from the Viewport to a time slot in the
Events pane, or to the Calls or To Do panes, to create an event.

Calendar pane, above the To Do pane, displays the current date and calendar of the month.  Click a date in
the month calendar, or click the arrows next to the month and year, to change the date displayed.

Daily, Weekly, Monthly, Yearly tabs let you select the view of your calendar.  Double-click a date in the
Weekly, Monthly or Yearly views to jump directly to that date in Daily view.

Toolbar contains buttons you can click to perform various tasks. To see what a button does, hold the mouse
pointer over it and pause for a moment. A “tool tip” will appear. You can customize the Toolbar using the Tools
| Setup | Toolbar command.

Status bar appears at the bottom of the display.  You can turn it on or off using the View | Status Bar
command.

Created with the Personal Edition of HelpNDoc: Easily create Help documents

About Internet Group Scheduling and the Activities View

 Related topics

{bml bm9.BMP}The Activities view lists all your Internet events, plus your Calendar events: Calls, To Do items,
and appointments. Use it to view events, create event invitations, reply to incoming invitations, and more.  You
can also see an overview of all your Calendar activities for a time period you select.

Internet Scheduling uses Internet messaging to send invitations and collect replies automatically for a group
event you want to schedule.

The people you invite receive a message showing the meeting information, and they can click buttons to
Accept, Decline, Request Rescheduling, or Delegate the event to someone else. Sidekick 98 sends the
invitation and reply messages. The event information is displayed in the Activities view and automatically
added to participants  ̓calendars. 

You also can schedule resources, such as conference rooms, projectors, and vehicles. You get an automatic
response from the resourceʼs calendar confirming your reservation or listing available times.

The icon on the Deskpad (shown above) is animated and changes color when you have unread Internet
scheduling messages, including invitations or replies to your invitations. 

The easiest way to schedule an event is to use the Internet | Scheduling Wizard command in the Activities,
Calendar, or Contacts view.
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Activities View Features and Options
Tabs let you select what to display: All, Appointments, To Do items, Calls, or Internet  Events. The All tab
displays all events that appear in your Calendar view, including Appointments, To Do items, Calls, and
confirmed group scheduling events, plus Special Days and Multi-Day Events. 

Show box lets you choose the time period or events you want to see.

Column headings provide brief information about the event. For example, on the Internet Events page,
column headings are Type, New, Outbox, Date and Time, Subject, Initiator, Location (for group events).  Icons
in the New column indicate a new incoming invitation, reply or other message. An icon in Outbox indicates a
message that hasnʼt been sent yet. Click a column heading to sort entries on that field.

Details pane (Internet Events) shows the date and time, participants, and other information about the selected
event. Click the + next to an entry to expand it, if necessary.

Information pane (Internet Events) shows the specifics of the selected event, or the item selected in the
Details pane. 

Buttons change depending on the type of event that is selected. For example, the New button opens the
Schedule an Event dialog box when an incoming or outgoing event is selected, or the Resource Wizard if a
resource message is selected. For Calendar events, the Go To button takes you to the Calendar and highlights
the selected event.

Created with the Personal Edition of HelpNDoc: Easy to use tool to create HTML Help files and Help web sites

About the EarthTime View

 Related topics

{bml bm10.BMP}The EarthTime view displays a map showing daytime and night time around the world, and
shows the current time at eight different locations you select. You can use EarthTime to calculate the
difference in time between two locations, and you can configure it to show both your home location and the
local time as you travel. EarthTime includes helpful information about over 540 cities in its databse.

Features and Options
Map displays the sunrise/sunset line, updated every minute. Right-click a map location and choose Center
Map Here to shift the map horizontally, or double-click that location.

City Clocks show the current time in eight locations. Drag the time display area from one city clock to
another to see the Time Difference display for those two cities.  Drag one city name to another to switch the
positions of the two clocks.

You can right-click a clock or move the mouse to the menu arrow and select from a menu of options.  Facts
About the City shows you language, currency, telephone codes, and other useful information about the city. 
Other menu options let you modify the cityʼs information, change the displayed city, and more.

Icons

The house icon indicates your Home clock.

The person icon indicates your Local clock.

The sunburst is present if daylight saving time is in effect in that city.

Created with the Personal Edition of HelpNDoc: Full-featured EBook editor

About the Contacts View

 Related topics

{bml bm14.BMP}The Contacts view stores names, addresses, phone numbers, e-mail addresses, and any
other kind of data you need in a cardfile. The e-mail addresses are used for Internet scheduling in the
Calendar. You can store the Uniform Resource Locators (URL) of your favorite sites on the World Wide Web,
and use them to start your browser and jump directly to the site. You can use Mail Merge to combine
information from a cardfile with a memo or letter, and dial phone numbers automatically with the Phone Dialer.

You can import and export files with just a few clicks. Sidekick 98 supports dBASE III, dBASE IV,
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Spreadsheet Data (DIF), tab-delimited text, and comma-delimited text. You can also import from Microsoft
Outlook 97, Schedule+ 7.0, and Lotus Organizer 97.

In addition, you can easily drag and drop vCard objects into the Contacts view, or launch a URL from a
Sidekick card. You can also launch your default e-mail client from a Sidekick card e-mail address.

Features and Options
Look For box lets you search for contact cards using information in the cardʼs index line.

Index line in the left pane contains the indexes of each card in the cardfile. Each index consists of one to
three card fields. The cards are sorted according to their index lines. Click the index line of a card to see its
data.

Card data appears in the right pane. The field names appear at the left, and the data for the current card is to
the right.

Viewport is at the bottom of the card data pane. Click the arrow to open and close the Viewport.  Click the
button to choose what to display in the Viewport: Appointments, Calls, To Do items, Contact Log, or Goals List.

Cardfile tabs at the bottom of the window represent the open cardfiles. 

Created with the Personal Edition of HelpNDoc: Qt Help documentation made easy

About the Memos View

 Related topics

{bml bm15.BMP}Use the Memos view to create and format your letters and memos.  Auto Spell Check works
in the background to check spelling as you write. You can use Mail Merge (on the Memos menu) to create
memos using name and address information from the Contacts view, and you can send your memos by e-
mail or by fax directly from Sidekick 98 (requires an e-mail account and a fax modem).

In Memos view, your memos are stored in folders, with each folder represented by a tab at the bottom of the
screen. You can have many memos in a folder. A group of folders makes up a single Memo file. 

Features and Options
Index pane lists the memos in the current folder. Memos are sorted by date or subject (use Memos | Memo |
Sort to change the order). 

Text pane contains the text of the current memo.

Toolbar formatting buttons let you apply formats to the characters and paragraphs of your memos. 

Viewport is at the bottom of the text pane.  Click the arrow to open and close the Viewport.  Click the button
to choose what to display in the Viewport: Appointments, Calls, To Do items, Cards, or Goals List.  

Created with the Personal Edition of HelpNDoc: Full-featured multi-format Help generator

About the Expenses View

 Related topics

{bml bm17.BMP}The Expenses view lets you enter information from your receipts, and then it totals your
receipts in a formatted expense report, ready for you to print and sign. As you enter receipts, you choose
data such as city names and restaurants from lists that grow automatically to include your new entries. 

Features and Options
Receipt view (View | Receipt View) is where you enter the raw data from the pile of receipts you have
collected. Enter the receipts just as you find them, and Sidekick will take care of sorting and categorizing. 
The receipt type, date, and amount appear in the left pane, and the details of the currently selected receipt

appear at the right.  Click the Add button  to enter a new receipt.  

Report view (View | Receipt View) totals your receipts in a formatted expense report. You can edit the
personal information at the top. 
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By determines what is included in your report. By Week lets you create a report by week. By Range lets
you specify a range of dates. By Folder lets you create a report for the contents of the current folder.

Account lets you select an account, or all accounts, to include in the report. 

From Receipt view, click  to go to Report view.

From Report view, click  to go to Receipt view.

Created with the Personal Edition of HelpNDoc: Create help files for the Qt Help Framework

About the Phone Dialer

 Related topics

{bml bm21.BMP}The Phone Dialer can dial your voice calls using a phone number from your cardfile or a
number you type. It also can answer incoming calls and look up the callerʼs number in the current cardfile (if
you have Caller ID service and required hardware). You can type notes about the call to record in a cardʼs
Contact Log, which you can view in the Viewport. 

To open the Phone Dialer, either click its icon on the desktop, press F9, or, from Contacts view or the
Viewport, drag a card that contains a phone number to the icon.

Features and Options
Information pane displays the phone number(s) in the current card. You can leave the Phone Dialer open
and click a different card in the Viewport or Contacts view, and its phone numbers appear in the display. The
pane includes a status line that displays the current dialing status.

Number to Dial is the currently selected number in the Information pane, or a number you type or enter from
the keypad.

Dial button causes the number in the Number to Dial field to be dialed.

Redial button causes the last number dialed to be redialed. The number that will be redialed appears in the
title bar.

Answer button answers an incoming call, and stamps Answer to the Contact Log.

Hang Up button disconnects the modem.

History button opens the Call History pane, where you can see a log of recent Phone Dialer activity. If you
have been away from your desk, the History pane will contain a list of incoming calls and the number calling,
if you have Caller ID. When the History pane is open, this button changes to the Keypad button, which you
click to return to the keypad.

Call Note button opens the Call Note pane. You can type a Call note in the text area provided. Click Save to
Current Contact Log to save the note.  

Timer, at the top of the Call Note pane, times your calls.  The Start and Reset buttons control the operation of
the timer.

Setup button opens the Phone Dialer Setup dialog box.

Delete button (In Call History window) deletes the selected entry in the Call History.

Save to Card button (in Call History window) saves the current entry in the Call History pane to a new card.

Created with the Personal Edition of HelpNDoc: Full-featured EBook editor

About the Report View

 Related topics

The Report view displays reports, which collect and organize information from the Contacts or Calendar view. 

To see the Report view, choose a report type from the Reports menu in the Calendar or Contacts view. The
report types are 

Cardfile report

Calendar report
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Free Time report

To Do Items report

Contact Log report

Created with the Personal Edition of HelpNDoc: Free CHM Help documentation generator

About Internet Time Synchronizer

Internet Time Synchronizer precisely synchronizes your computerʼs system clock with an Internet time server,
ensuring that your system time is accurate and reliable.  To open the Time Synchronizer dialog box, choose
Tools | Synchronize | Time Synchronizer Setup, or right-click its icon in the System Tray (in the Windows
taskbar).

Internet Time Synchronizer can monitor your dial-up connections, and check the time once you are
connected for any other purpose. For example, if you periodically connect to check your mail, it can
automatically get the precise time in the background during your mail session.

If you have the Timex Datalink, you can set your watch from your computer, so it too is always accurate.

Created with the Personal Edition of HelpNDoc: Free Web Help generator

Using Sidekick 98 Help

Help Contents 
To get Help at any time, choose Contents from the Help menu. The Help Contents window contains three tabs.
Click the one you want to use.

Contents:  Double-click any closed book to “open” it and see its contents. Double-click any page to read
its contents. From there you can click the Contents button to return to the Contents window. Double-click
an open book to close it.

Index:  Type a word you want to search for in the index. Then double-click a topic in the list that appears to
jump to that topic. You can click the Contents button to return to the Contents window.

Find:  When you click this tab for the first time, a complete word list of the Help system is created (itʼs
automatically stored, so it doesnʼt need to be re-created after the first time). Type a word or part of a word,
and double-click the topic title you want. 

Context-sensitive Help
When you are in a dialog box that has a Help button, click the button for help on your current location. To see
detailed reference information about menu commands, highlight a menu command (using the keyboard) and
press F1. The Help topic for that command appears. 

ToolTips
Sidekick identifies each menu command or Toolbar button when you move the mouse pointer over it and
pause. A description appears in a small box next to the button, and disappears when you move the mouse off
the button.

Navigating in Help
Help topics appear in different kinds of windows depending on the nature of the topic.  Most Help windows
have buttons at the top to help you navigate, including some or all of the following:

Contents takes you to the Help Contents window.

Index takes you to the index for the Help system, where you can type a word you want information about. 

Back takes you to the previous Help topic you viewed.

>> and << are the browse buttons. They take you forward (>>) and back (<<) within a series of related
Help topics. 

Related Topics, appearing in the Help topic title region, shows you a list of related Help topics you can
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jump to.

Jumps appear as underlined text, which you click to see more information. A dotted underline indicates a
definition or other “pop-up” window, which closes as soon as you click the mouse button. Hereʼs an
example of a definition: Internet scheduling. A solid underline indicates a jump to another Help topic; for
example, Introducing Sidekick 98. 

More Information
For more details about standard Windows Help features, including Help menus and buttons, press F1 in any
Help window. 

Created with the Personal Edition of HelpNDoc: Easily create Help documents

Toolbar

A Toolbar appears at the top of the Calendar, Contacts, Memos, and Expenses views. The Toolbar contains
buttons that immediately execute certain Sidekick commands. For example, instead of choosing File | Save,
you can simply click the Save button. 

You can configure the Toolbar differently for most views of Sidekick. The list of buttons you can choose when
setting up the Toolbar varies for each part of Sidekick. In each view, the Toolbar contains three or four
“anchor” buttons, which cannot be customized.

For information about configuring a Toolbar, choose Tools | Setup | Toolbar. 

Created with the Personal Edition of HelpNDoc: Single source CHM, PDF, DOC and HTML Help creation

Contacting Starfish Software

Contacting Starfish Software

World Wide Web
Be sure to visit the Starfish Web site any time you want the latest product information. (If this link doesnʼt work
with your browser, go to: http://www.starfish.com)

Frequently Asked Questions
For the answers to frequently asked questions, jump directly to the FAQ page on the Starfish Web site. (If this
link doesnʼt work with your browser, go to: http://www.starfish.com/service/ti.html.)

Technical Support Services
For technical assistance with Sidekick 98, please contact one of the following services.

Compuserve
GO STARFISH

Starfish Web Site
http://www.starfish.com/service/service.html

Free Starfish BBS
408-461-5930 8-N-1 Up to 28.8 kbps

Free Fax Information
U.S. 1-800-503-3847 Requires a fax machine

Free Up and Running Support
970-522-4610 No-charge assistance for software installation and initial configuration.

Pay-as-you-go hotlines
6am - 5pm U.S. Pacific Time

1-900-555-1010 Billed to your phone bill
$2.00 per minute, first minute free

1-800-953-9995 Requires a credit card
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$2.00 per minute, first minute free

Product orders
24 hours a day, 7 days a week

800-765-7839

Starfish Product Registration
Be sure to register your Sidekick 98 using the electronic registration option during installation. If you prefer,
visit our Web site at http://www.starfish.com, or mail the information to:

Starfish Software
Product Registration
P.O. Box 4293
Woodland Hills, CA  91365-9908

Customer Feedback
Your feedback, wish lists, and ideas for future enhancements to our products are very important to us. Please
feel free to drop us a line via mail or fax with your ideas and suggestions. 

Starfish Software
Attn: Product Management
1700 Green Hills Road
Scotts Valley, CA 95066
Fax: 408-461-5900

International Support
For technical and customer support outside North America, please contact one of the online services listed
above or your local Starfish office. 

Australia:
Tech Support Phone: 02 899 5888

Tech Support Fax: 02 899 5728

France:
Tech Support Phone: 33 1 46 04 29 32

Tech Support Fax: 33 1 47 12 99 15

Monday through Friday, 9:30-12:00, 14:30-17:00

Germany:
Tech Support Phone: 49 0 89 143 12 666

Tech Support Fax: 49 0 89 143 12 670

Monday through Friday, 9:00 to 12:00, 13:00 to 17:00 

Italy:
Tech Support Phone: 39 2 9358 2260

Tech Support Fax: 39 2 9358 2280

Japan:
Tech Support Phone: 81 3 5352 1172

Tech Support Fax: 81 3 5352 1171

Spain:
Tech Support Phone: 91 352 62 00

Tech Support Fax: 91 352 94 31

Monday through Friday, 09:00 to 14:00

UK:
Tech Support Phone: 44 1923 209 107 (Registration)

Monday through Friday, 09:00-17:00
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Sidekick Files

Filename Extensions
The following extensions are used by Sidekick 98.

Extension Description

.SKTmpCard Cardfile temporary data file

.TMP Calendar temporary data file

.SKTmpContent Memos view temporary data file

.TPT Report template file

.LOG Back Up And Restore file that lists files being copied

.RPT Report file

.SKCard Contacts cardfile

.SEE Expense file

.SKB A backup copy of your Sidekick 97, Sidekick 95, or Sidekick 2.0 calendar file, if
you open one in Sidekick 98.

Calendar files
Your calendar file is actually eight files in the *????.SKW format, where * represents the name you enter.
When saving, opening, backing up, or restoring calendar files, Sidekick lists * as the name of the calendar.
The ???? part of the file name represents four characters that stand for the type of calendar file, as listed
here. Thus, a group of calendar files might have names in the form Jean WorkEVEN.SKW, Jean
WorkCALL.SKW, and so on.

*EVEN.SKW Appointment list data file

*CALL.SKW Call list data file

*TASK.SKW To Do list data file

*MAST.SKW Goals list data file

*RECR.SKW Recurring Event, Call, and To Do data file

*INIT.SKW Calendar initialization data file

*DATA.SKW Multi-day events and Special Days data file

*CSCA.SKW Categories, assigns, call status, and predefined activities data file

Memo files
A Memo file is composed of three files in the formats listed below. The asterisk represents the name you give
the file when you save it from the Memos view. 

*.SKWrite Memo folder file

*.SKNoteHeader Memo header file

*.SKContent Memo data file

Created with the Personal Edition of HelpNDoc: Full-featured Help generator
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Glossary

Click any topic below to see information about it.
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Contact Log
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Deskpad

Deskpad icons

drag and drop

exchange

Extract Cards

fields

field names
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resource

Ruler

Shortcut menu

To Do

Toolbar

Uniform Resource Locator (URL)

Unimodem V

Viewport
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An appointment, To Do, call, or Goal. 

Created with the Personal Edition of HelpNDoc: Free iPhone documentation generator

A scheduled meeting or event. Appointments can occur once or they can be recurring.

Created with the Personal Edition of HelpNDoc: Easily create CHM Help documents

A collection of Sidekick files representing the various parts of the Calendar. The files all begin with the user
name and have an .SKW extension. Calendar files can be located anywhere, as long as they are all in the
same directory (normally the Sidekick 98 Userdata directory, unless you have specified otherwise).

Created with the Personal Edition of HelpNDoc: iPhone web sites made easy

{bml bm21.BMP}A drag and drop target that triggers the Phone Dialer dialog box, when a card or other item
containing a phone number is dropped on it.

Created with the Personal Edition of HelpNDoc: Create help files for the Qt Help Framework

A database or organized collection of information, such as an address book. Each cardfile can have up to
30,000 cards.

Created with the Personal Edition of HelpNDoc: What is a Help Authoring tool?

A collection of field names to apply to a new cardfile. You can create your own cardfile templates, or use the
ones supplied with Sidekick.

Created with the Personal Edition of HelpNDoc: Easily create Help documents

An individual record or entry in a cardfile, such as a person in an address book. Each cardfile can have up to
30,000 cards.

Created with the Personal Edition of HelpNDoc: Produce Kindle eBooks easily

A temporary storage area for cut or copied text. The Clipboard holds the information until new text is cut or
copied.

Created with the Personal Edition of HelpNDoc: Free help authoring tool

An equation consisting of a field name, an operator, and a value used to find specific cards in a cardfile. For
example, City Equal to San Jose is a condition for finding all cards in a cardfile with San Jose in the City
field. 
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A person or company listed as a card in a cardfile. Manage your contacts with the Tools | Contact Manager
command.

Created with the Personal Edition of HelpNDoc: Easily create Qt Help files

A place for entering memos specific to a particular card in the cardfile, or for recording a history of phone
calls made or answered, appointments, and mail merges performed with the card. Each card has its own
Contact Log.

Created with the Personal Edition of HelpNDoc: Free Kindle producer

{bml bm24.BMP}A drag and drop target on the Sidekick Deskpad for deleting cards, memos, or calendar
activities.

Created with the Personal Edition of HelpNDoc: Create HTML Help, DOC, PDF and print manuals from 1 single
source

The visual metaphor used by Sidekick. Each of the components of Sidekick appears in a  desk-like area
where you organize your activities.

Created with the Personal Edition of HelpNDoc: Easily create Web Help sites

A vertical column of icons to the right of the Sidekick Deskpad. Most of these icons correspond to the various
views in Sidekick. There are eight icons: Contacts, Calendar, Memos, Expenses, Activities, EarthTime, Call,
and Delete.

Created with the Personal Edition of HelpNDoc: Full-featured EBook editor

Dragging an object onto another and “dropping” it is an easy way to move the object or use it to launch
another process.  To drag, move the mouse over the object. Hold down the left (primary) mouse button and
then move the mouse toward the drop “target.”  Release the button over the drop target.

Examples:

Dragging a cardfile card from the Viewport and dropping it on a time in the Calendar Appointments, Calls
or To Do pane creates an entry using the card information.

Dragging any Calendar event to the Call icon and dropping it opens the Phone Dialer. If there is a phone
number in the Calendar event, it is ready to dial.

Dragging the index of a memo or a Contacts card to a tab moves the memo or card to that tab.

Created with the Personal Edition of HelpNDoc: Full-featured Kindle eBooks generator

The exchange is the first three digits of a telephone number, such as 555 in the phone number 555-1234.

Created with the Personal Edition of HelpNDoc: Write eBooks for the Kindle

A command that lets you copy the results of a cardfile search to a new cardfile. You can extract cards either
on text, on an index range, or on condition.

Created with the Personal Edition of HelpNDoc: iPhone web sites made easy

Pieces of data that make up a card, such as a name, address, phone number, and so on. Each cardfile can
have up to 100 fields defined.
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Created with the Personal Edition of HelpNDoc: Free EPub producer

The description or label for a cardfile field to identify its use and distinguish it from other fields. Field names
can be up to 39 characters long, either uppercase or lowercase.

Created with the Personal Edition of HelpNDoc: Write eBooks for the Kindle

An e-mail session which sends all your pending outbound group scheduling messages and collects all
inbound messages before logging off automatically.

Created with the Personal Edition of HelpNDoc: Free EPub producer

A report showing your free time for the next 30 days. You can attach it to a reply declining an invitation or
requesting rescheduling.  Appointments that are Public or Personal are indicated as booked time; Confidential
appointments do not appear on the report.  

Created with the Personal Edition of HelpNDoc: Benefits of a Help Authoring Tool

Though similar to the To Do list, the Goals list can contain tasks that are longer term or have due dates in the
distant future. The tasks don't need your immediate attention, but you don't want to forget them.

Unlike the To Do list, which changes with each day, the Goals list shows all long-term tasks for an entire
calendar year, independent of the date displayed in the calendar.

Created with the Personal Edition of HelpNDoc: Easily create Web Help sites

A black square box that appears at the corners and edges of a graphic element (such as the fields in a label
printing template) when you select it.  Handles let you re-size the element. Move the mouse over a handle until
the double-headed arrow appears. Then click and hold down the left mouse button while you drag the handle
to a new position.

Created with the Personal Edition of HelpNDoc: Create HTML Help, DOC, PDF and print manuals from 1 single
source

In EarthTime, the time you designate as your home. Home Clock remains unchanged when you travel, but
you set Local Clock for your current location.

Created with the Personal Edition of HelpNDoc: Free PDF documentation generator

Hypertext Markup Language, the standard language for documents used on the World Wide Web.

Created with the Personal Edition of HelpNDoc: Produce Kindle eBooks easily

The “title” of a card. An index line (or simply “index”) is composed of any three fields in a cardfile. The
cardfileʼs cards are sorted according to their indexes.

Created with the Personal Edition of HelpNDoc: Easily create CHM Help documents

Internet scheduling lets you create a meeting or other event and select a list of participants. Sidekick 98 uses
electronic messaging to automatically notify attendees, collect their replies, and add the event to the calendars
of those who will attend. 

Created with the Personal Edition of HelpNDoc: Create help files for the Qt Help Framework
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The Local Clock is normally the same as your Home Clock. When you travel, you change the Local Clock to
your current location. All your appointments are displayed in Local Clock time.  Sidekick 98 does not change
your computer system time to the Local Clock time. 

Created with the Personal Edition of HelpNDoc: Free EPub producer

A search box at the top of the Cards list and memo list that lets you quickly find any card or memo by typing a
few characters of text from the desired cardʼs index or desired memoʼs subject. The first card matching the
text is selected. Press Enter to get a list of the first 20 cards or memos that contain that text string anywhere in
their indexes or subjects.

Created with the Personal Edition of HelpNDoc: Free PDF documentation generator

The person whose computer stores the reservation schedule information for a resource. The managerʼs
Sidekick 98 receives reservation requests and sends back confirming or denying messages in the
background, without direct involvement by the manager. The manager should have flash sessions at fairly
frequent intervals so resource requests can be handled promptly. 

Created with the Personal Edition of HelpNDoc: Easily create HTML Help documents

ages
In Sidekick, paper refers to a physical printing sheet, most commonly 8 1/2 x 11 inches, in the U.S.. Each
piece of paper can be one section or divided into two, three, or four sections, called pages, each with it's own
index tab and page number.

The term page can also refer to tabs in a dialog box. For example, the Schedule an Event dialog box has two
pages: the Events page and the Notes page.

Created with the Personal Edition of HelpNDoc: Easy CHM and documentation editor

A report file containing the font settings, title, and subtitles saved from an existing report. The saved formatting,
or style, can then be applied to another report to change its formatting.

Created with the Personal Edition of HelpNDoc: Full-featured Kindle eBooks generator

A resource is a facility such as a conference room, or equipment such as a projector or vehicle. You can
reserve a resource automatically using the Internet | Resource Wizard command from Activities view. 

Created with the Personal Edition of HelpNDoc: Easily create EBooks

An optional tool to show the dimensions of the current memo. You also use the Ruler to change margins and
set tabs. Use View | Ruler to show or hide the ruler.

Created with the Personal Edition of HelpNDoc: Easily create PDF Help documents

A menu that appears when you right-click certain objects in Sidekick. For example, if you right-click an
appointment on the Calendar, a Shortcut menu appears letting you perform tasks such as Undo, Cut, Copy,
Paste, Edit, or make it a Recurring appointment..

Created with the Personal Edition of HelpNDoc: Free EPub and documentation generator

Any task in need of attention that is not scheduled for a particular time of day. To Dos can occur once or they
can be recurring.

Created with the Personal Edition of HelpNDoc: Free Kindle producer
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A collection of preset buttons for each view. The Toolbar contains buttons to let you perform standard actions
for that view. You can choose to hide the Toolbar. You can also customize the buttons on the Toolbar using the
Tools | Setup | Toolbar command.

Created with the Personal Edition of HelpNDoc: Write EPub books for the iPad

An address on the Internet. The World Wide Web uses URLs to specify the locations of files on other
servers.

Created with the Personal Edition of HelpNDoc: Free Kindle producer

A modem driver that is required for using Caller ID and other advanced modem features.

Created with the Personal Edition of HelpNDoc: Easily create Web Help sites

A window in the lower right corner of the Contacts, Calendar, and Memos views that lets you work with a part
of another view without having to leave the one you're in. You can use the Viewport to drag information from
one part of Sidekick to another, or simply to display information.

Created with the Personal Edition of HelpNDoc: Easily create CHM Help documents

Shortcut Keys

Calendar Shortcut Keys

EarthTime Shortcut Keys

Contacts Shortcut Keys

Memos Shortcut Keys

Expense Shortcut Keys

Activities View Shortcut Keys

Report Shortcut Keys

Calculator Function Keys

Created with the Personal Edition of HelpNDoc: Full-featured EBook editor

Calendar Shortcut Keys

Command Keys Description

File menu

New Calendar Ctrl+N Creates a new, untitled calendar.

Open Calendar Ctrl+O Opens a calendar.

Save Calendar Ctrl+S Saves the calendar.

Save Calendar As F12 Saves the calendar under a new name.

Save All Ctrl+L Saves all open Sidekick files in all views.

Print Sidekick Format Ctrl+P Prints the daily calendar in various Sidekick formats.

Exit Alt+F4 Exits Sidekick.

Edit menu

Undo Ctrl+Z Reverses the last edit operation.

https://www.helpndoc.com/create-epub-ebooks
https://www.helpndoc.com/feature-tour/create-ebooks-for-amazon-kindle
https://www.helpndoc.com/feature-tour
https://www.helpndoc.com/feature-tour
https://www.helpndoc.com/create-epub-ebooks


Sidekick 98 Help

65 / 200

Cut Ctrl+X Removes selected text and puts it on the Clipboard.

Copy Ctrl+C Copies selected text onto the Clipboard.

Paste Ctrl+V Inserts the Clipboard contents at the insertion point.

Go to Today Ctrl+G Goes to today's date in the Daily View. 

Find Ctrl+F Searches the calendar for specified text.

Add Card Ctrl+A Adds new contact cards to the cardfile.

View menu

Contacts F5 Switches to the Contacts view.

Memos F7 Switches to the Memos view.

Expenses F8 Switches to the Expense view.

Phone menu

Dialer F9 Opens and closes the Phone Dialer.

Help menu

Contents F1 Displays help on the selected command or dialog box, or
displays the help contents.

Screen actions

Tab Moves the keyboard focus of the screen from one part of the Calendar to
another in this order: To Do list, Calls list, Appointments list, Month selection,
Year selection, and Date selection (mini calendar).

Arrow Up/Down Moves the insertion point up/down one line.

Ctrl+PgUp/PgDn Moves the insertion point to the top/bottom line in the selected list.

Page Up/Down Moves the insertion point up/down one screen.

Ctrl+Alt+Enter Add daily appointments, calls, and tasks.

Ctrl+Alt+C Check off current activity as completed.

Ctrl+Alt+A Set or take off the current lineʼs alarm icon.

Ctrl+Alt+U Set or take off the unconfirmed icon for the current appointment, the urgent icon
for the current call, or the due date setting for the current To Do item or goal.

Ctrl+Alt+T Set or take off the default call status for the current call.

Ctrl+Alt+O Set or take off the default priority setting for the current To Do item or goal.

Ctrl+Alt+E Set or take off the default category for the current To Do item or goal.

Ctrl+Alt+I Set or take off the default assignment of the current To Do item or goal.

Alt+W Opens/closes the Viewport.

Ctrl+T Inserts the current time into the Contact Log, if selected.

Ctrl+D Inserts the current date into the Contact Log, if selected.

Created with the Personal Edition of HelpNDoc: Free Qt Help documentation generator

EarthTime Shortcut Keys

Command Keys Description

File menu

Save All Ctrl+L Saves all open Sidekick files in all views.

Exit Alt+F4 Exits Sidekick.

https://www.helpndoc.com
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View menu

Contacts F5 Switches to the Contacts view.

Calendar F6 Switches to the Calendar.

Memos F7 Switches to the Memos view.

Expenses F8 Switches to the Expense view.

Phone menu

Dialer F9 Opens and closes the Phone Dialer.

Help menu

Contents F1 Displays help on the selected command or dialog box, or
displays the help contents.

Created with the Personal Edition of HelpNDoc: Produce online help for Qt applications

Contacts Shortcut Keys

Command Keys Description

File menu

New Cardfile Ctrl+N Creates a new, untitled cardfile.

Open Cardfile Ctrl+O Opens a cardfile.

Close Cardfile Ctrl+W Closes the active cardfile.

Save Cardfile Ctrl+S Saves the active cardfile.

Save Cardfile As F12 Saves the active cardfile under a new name.

Save All Ctrl+L Saves all open Sidekick files in all views.

Print | Cards Ctrl+P Prints cards and/or Contact Log information.

Exit Alt+F4 Exits Sidekick.

Edit menu

Undo Ctrl+Z Reverses the last edit operation.

Cut Ctrl+X Removes selected text and puts it on the Clipboard.

Copy Ctrl+C Copies selected text onto the Clipboard.

Paste Ctrl+V Inserts the Clipboard contents at the insertion point.

Copy Special Ctrl+Y Copies fields and text to the Clipboard. Use Copy Special
Setup to define the contents.

Go to Cardfile Ctrl+G Goes to specified cardfile.

Find Text Ctrl+F Opens the Find Text dialog box. Searches for the text you
specify.

Find Next F3 Finds the next occurrence of the last text specified.

Find Previous Shift-F3 Finds the previous occurrence of the last text specified.

View menu

Calendar F6 Switches to the Calendar.

Memos F7 Switches to the Memos view.

Expenses F8 Switches to the Expense view.

Index/Card View Ctrl+E Switches the Contacts view between Card view and Indexed
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view.

Cards menu

Add Ctrl+A Adds new contact cards.

Mark Current Card Ctrl+K Marks or unmarks the active contact card.

Sort Ctrl+R Sorts the cardfile by any three fields by changing the index
line of each contact card.

Reorder Tabs F11 Reorders the cardfile tabs at the bottom of the screen.

Phone menu

Dialer F9 Opens and closes the Phone Dialer.

Help menu

Contents F1 Displays help on the selected command or dialog box, or
displays the help contents.

Screen actions

Alt+L Moves the insertion point to the Look For text box.

Ctrl+Home Moves the insertion point to the first field on the selected card.

Ctrl+End Moves the insertion point to the last field on the selected card.

Ctrl+Shift+Home Jumps to first contact card in the cards list.

Ctrl+Shift+End Jumps to last contact card in the cards list.

Ctrl+Shift+PgUp Moves up one contact card in the cards list.

Ctrl+Shift+PgDn Moves down one contact card in the cards list.

Ctrl+PgUp Selects the previous cardfile along the cardfile tabs as the active cardfile.

Ctrl+PgDn Selects the next cardfile along the cardfile tabs as the active cardfile.

Alt+W Opens/closes the Viewport.

Ctrl+T Inserts the current time into the Contact Log, if selected.

Ctrl+D Inserts the current date into the Contact Log, if selected.

Created with the Personal Edition of HelpNDoc: Easy to use tool to create HTML Help files and Help web sites

Memos Shortcut Keys

Command Keys Description

File menu

New Memo File Ctrl+N Creates a new, untitled Memo file.

Open Memo File Ctrl+O Opens a Memo file.

Save Memo File Ctrl+S Saves all memos.

Save Memo File As F12 Saves the Memo file under a new name.

Save All Ctrl+L Saves all open Sidekick files in all views.

Print Ctrl+P Prints memos.

Exit Alt+F4 Exits Sidekick.

Edit menu

Undo Ctrl+Z Reverses the last edit operation.

https://www.helpndoc.com/help-authoring-tool
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Cut Ctrl+X Removes selected text and puts it on the Clipboard.

Copy Ctrl+C Copies selected text onto the Clipboard.

Paste Ctrl+V Inserts the Clipboard contents at the insertion point.

Go to Folder Ctrl+G Goes to the specified folder.

Find Ctrl+F Opens the Find dialog box. Searches for the text you specify.

View menu

Contacts F5 Switches to the Contacts view.

Calendar F6 Switches to the Calendar.

Expenses F8 Switches to the Expense view.

Folder/Memo View Ctrl+E Switches Memos view between Memo view and Folder view.

Memos menu

Memo | Add Ctrl+A Adds a new memo.

Memo | Sort Ctrl+R Sorts the memos.

Memo | Mark Current Ctrl+K Marks or unmarks the current memo.

File | Reorder Folders F11 Reorders the folder tabs at the bottom of the screen.

Phone menu

Dialer F9 Opens and closes the Phone Dialer.

Help menu

Contents F1 Displays help on the selected command or dialog box, or
displays the help contents.

Screen actions

Ctrl+Delete Delete next word

Ctrl+Backspace Delete previous word

Ctrl+B Set selected text as bold.

Ctrl+I Set selected text as italic.

Ctrl+U Set selected text as underline.

Alt+L Moves the insertion point to the Look For text box.

Alt+W Opens/closes the Viewport.

Ctrl+Home Moves to the top of the memo.

Ctrl+End Moves to the bottom of the memo.

Arrow Up/Down Moves the insertion point one line up/down.

Home Moves the insertion point to the start of the line.

End Moves the insertion point to the end of the line.

PgUp Moves the insertion point up one window.

PgDn Moves the insertion point down one window.

Ctrl+Left/Right Arrow Moves to the previous/next word.

Ctrl+Up/Down Arrow Moves to the previous/next paragraph.

Ctrl+Shift+Home Selects from insertion point to the top of the memo.

Ctrl+Shift+End Selects from insertion point to the bottom of the memo.

Shift+movement keys Performs the same action as the movement keys, but selects from the insertion
point.
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Created with the Personal Edition of HelpNDoc: Easily create Web Help sites

Expense Shortcut Keys

Command Keys Description

File menu

New Expense File Ctrl+N Creates a new, untitled expense file.

Open Expense File Ctrl+O Opens an expense file.

Save Expense File Ctrl+S Saves the expense file.

Save Expense File As F12 Saves the expense file under a new name.

Save All Ctrl+L Saves all open Sidekick files in all views.

Print Ctrl+P Prints the expense file.

Exit Alt+F4 Exits Sidekick.

View menu

Contacts F5 Switches to the Contacts view.

Calendar F6 Switches to the Calendar.

Memos F7 Switches to the Memos view.

Expenses menu

Receipt | New Ctrl+A Adds a new receipt.

Phone menu

Dialer F9 Opens and closes the Phone Dialer.

Help menu

Contents F1 Displays help on the selected command or dialog box, or
displays the help contents.

Created with the Personal Edition of HelpNDoc: News and information about help authoring tools and software

Activities View Shortcut Keys

Command Keys Description

File menu

Save All Ctrl+L Saves all open Sidekick files in all views.

Print Ctrl+P Prints the Activities view.

Exit Alt+F4 Exits Sidekick.

View menu

Contacts F5 Switches to the Contacts view.

Calendar F6 Switches to the Calendar.

Memos F7 Switches to the Memos view.

Expenses F8 Switches to the Expense view.
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Phone menu

Dialer F9 Opens and closes the Phone Dialer.

Help menu

Contents F1 Displays help on the selected command or dialog box, or
displays the help contents.

Created with the Personal Edition of HelpNDoc: Easy to use tool to create HTML Help files and Help web sites

Report Shortcut Keys

Command Keys Description

File menu

New Report Ctrl+N Creates a new, untitled report.

Open Report Ctrl+O Opens a report.

Save Report Ctrl+S Saves the report.

Save Report As F12 Saves the report under a new name.

Save All Ctrl+L Saves all open Sidekick files in all views.

Print Ctrl+P Prints the report.

Exit Alt+F4 Exits Sidekick.

Edit menu

Copy Ctrl+C Copies the highlighted area to the Clipboard.

View menu

Contacts F5 Switches to the Contacts view.

Calendar F6 Switches to the Calendar.

Memos F7 Switches to the Memos view.

Expenses F8 Switches to the Expense view.

Layout menu

Font Ctrl+Shift+F Sets the fonts used in the report.

Change Column Width Ctrl+U Changes the width of specified columns.

Help menu

Contents F1 Displays help on the selected command or dialog box, or
displays the help contents.

Screen actions

Ctrl+Home Moves to the first cell.

Ctrl+End Moves to the last cell.

Arrow Keys Moves from cell to cell.

Ctrl+Down/Up Arrow Moves to the last/first cell in the current column.

Ctrl+Right/Left Arrow Moves to the last/first cell in the current row.

Shift+Arrow Keys Highlights multiple cells.

Ctrl+Shift+Arrow Keys Highlights the current row or column.

https://www.helpndoc.com/help-authoring-tool
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Ctrl+Shift+Home/End Highlights the entire report.

Created with the Personal Edition of HelpNDoc: Free help authoring environment

Calculator Function Keys

Button Keys Function

M+ P Adds the displayed value to any value already in memory. 

MS M Stores the displayed value in memory. 

MR R Recalls the value stored in memory. 

MC C Clears any value stored in memory. 

+/- Crtl+F9 Changes the sign of the displayed number. 

. . Inserts a decimal point in the displayed number. 

sqrt @ Calculates the square root of the displayed value. 

+ + Adds. 

- - Subtracts. 

* * Multiplies. 

/ / Divides. 

= Enter Performs any operation on the previous two numbers. 
Choose again to repeat the last operation. 

1/x Ctrl+R Calculates the reciprocal of the displayed number. 

F1 Ctrl+F1 Applies the operation set up for F1 to the displayed number.

Shift+F1 Resets the operation set up for F1.

F2 Ctrl+F2 Applies the operation set up for F2 to the displayed number.

Shift+F2 Resets the operation set up for F2.

F3 Ctrl+F3 Applies the operation set up for F3 to the displayed number.

Shift+F3 Resets the operation set up for F3.

Backspace Deletes the right-most digit of the displayed number. 

C Esc Clears the current calculation. 

CE Del Clears the displayed number. 

Created with the Personal Edition of HelpNDoc: Generate Kindle eBooks with ease

Calendar Menu

The Calendar menu provides most of the tools for creating, modifying, and managing your scheduled events. 

For more information, highlight one of the Calendar menu options, and press F1.

Created with the Personal Edition of HelpNDoc: Easy to use tool to create HTML Help files and Help web sites

Events Command

The Calendar | Events command lets you schedule one-time and recurring appointments. 
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For more information, highlight one of the Events menu choices, and press F1.

Created with the Personal Edition of HelpNDoc: Easily create HTML Help documents

To Do Items Command

The Calendar | To Do Items command lets you schedule one-time and recurring To Do items. 

For more information, highlight one of the To Do Items menu choices, and press F1.

Created with the Personal Edition of HelpNDoc: Free help authoring environment

Calls Command

The Calendar | Calls command lets you schedule one-time and recurring Calls. 

For more information, highlight one of the Calls menu choices, and press F1.

Created with the Personal Edition of HelpNDoc: Full-featured Documentation generator

Sort Command

The Calendar | Sort command lets you sort your To Do items and Goals. 

For more information, highlight one of the Sort menu choices, and press F1.

Created with the Personal Edition of HelpNDoc: Free Qt Help documentation generator

Recurring Events Command

In the Daily Calendar view, the Recurring Events command (Calendar | Events | Recurring) opens the
Recurring Event dialog box, where you can create an appointment that occurs at regular intervals. Recurring
appointments appear with a  in the Daily view.

Dialog Box Options

All Recurring Events List
Lists already defined recurring events. Select an item from the list if you want to make changes to it.

Subject
Sets the name (up to 180 characters) of the recurring appointment. For quick entry, select an appointment
from the All Recurring Events List.

Start
Sets the time of day of the recurring appointment.

End
Sets the ending time for the recurring appointment.

Notes
Type a description or note about the recurring appointment. The Notes text can be up to 640 characters. In
Daily view, a paperclip icon appears next to appointments that have text in the Notes box.

Recurring
Specifies how often the appointment occurs (specific weeks of the month, days of the month, weekly, or
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daily). The box below the Recurring options changes depending on which Recurring option you choose.

From/To
Sets the date range in which the recurring appointment could possibly occur.

Reminder
Check the Remind Me box if you want an alarm to alert you of the appointment a specified amount of time
before the start time. Tone sets the Wave file used to sound an alarm for a scheduled appointment; click Play
to hear the tone.

Add button
Saves the appointment and adds it to the All Recurring Events List.

Delete button
Deletes the selected recurring appointment from the Recurring Events List. You can choose to delete all
occurrences, past occurrences, or future occurrences.

Change button
Replaces the selected recurring appointment with the new settings.

Created with the Personal Edition of HelpNDoc: Easy EPub and documentation editor

Multi-Day Command

In Calendar view, the Multi-Day command (Calendar | Events | Multi-Day) opens the Multi-Day Event dialog
box, where you can schedule events (such as conferences) that extend over several days.

You can also schedule important one-day events as multi-day events, to call attention to them.

In the Daily Calendar view, multi-day events appear at the top of the Appointments list. 

Shortcuts

Toolbar:

Dialog Box Options

Multi-Day Events List
Lists the multi-day events you have already added. Choose one from the list if you want to change or delete
it. 

Description
Type in the text that will be used to name and describe the multi-day event.

Date Range
From/To sets the starting and ending date for the multi-day event.

Full Day sets the multi-day event to occur during the entire work day.

AM sets the multi-day event to occur in the morning of each day.

PM sets the multi-day event to occur after noon of each day.

Color
Sets the color used to display the multi-day event in the Weekly, Monthly, and Yearly views.

Add button
Adds a newly defined multi-day event to the Multi-Day Events List.

Change button
Replaces a selected multi-day event with the new settings.

Delete button
Deletes a selected multi-day event from the Multi-Day Events List.

https://www.helpndoc.com
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Created with the Personal Edition of HelpNDoc: Free EPub producer

Group Command

The Group command (Calendar | Events | Group) opens the Schedule Group Event dialog box, where you
can enter information about the meeting, including Date and Time, Participants, Message, Resources,and
other options.

Created with the Personal Edition of HelpNDoc: Easily create CHM Help documents

Single Day Event Command

The Single Day To Do Items command (Calendar | Event | Single Day) opens the Schedule an Event dialog
box, where you can create a new one-time appointment.

Event page

Notes page

Created with the Personal Edition of HelpNDoc: Easily create EBooks

Event Page (Schedule an Event Dialog Box)

The Event page of the Schedule an Event dialog box (Calendar | Events | Single Day) is where you specify
the details of the event, such as the description, date and time, and whether you want an alarm to remind you
of the event. Use the Notes page to add more detailed notes about the event.

Dialog Box Options

Subject
Sets the description text (up to 180 characters) of the event.

Date
Specifies the date on which the event will occur. Use the spin buttons to adjust the date one day at a time; or
click the down arrow button to the right of the spin buttons to see a small monthly calendar, and choose a date
from the calendar.

Start/End
Specifies the starting and ending times of the event.

Time Zone
Specifies the time zone in which the event will occur. Use this setting if, for example, you live in Chicago but
have to travel to a meeting in Los Angeles. Your usual time zone would be USA Central, but the meeting will
occur at USA Pacific time.

Place
Specifies where the event will occur.

Reminder
Sets an alarm to alert you a specified amount of time before the event occurs. Tone lets you choose the
sound the alarm makes; click Play to test the sound. You can also have Sidekick 98 page you before the
event.

Created with the Personal Edition of HelpNDoc: Easy EBook and documentation generator
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Notes Page (Schedule an Event Dialog Box)

The Notes page of the Schedule an Event dialog box (Calendar | Events | Single Day) is where you can enter
detailed notes about the appointment. The Notes text can be up to 640 characters. In Daily view, a paperclip
icon appears next to events that have text in the Note box.

Created with the Personal Edition of HelpNDoc: Easily create Web Help sites

Single Day To Do Items Command

The Single Day To Do Items command (Calendar | To Do Items | Single Day) opens the To Do dialog box,
where you can create a new To Do.

For help on the options in this dialog box, see To Do/Goals Dialog Box.

Created with the Personal Edition of HelpNDoc: Free Qt Help documentation generator

Recurring To Do Items Command

In the Daily Calendar view, the Recurring To Do Items command (Calendar | To Do Items | Recurring) opens
the Recurring To Do dialog box, where you can create a To Do that repeats at regular intervals. Recurring To
Dos appear with a  in the Daily view.

Dialog Box Options

All Recurring To Do List
Lists already defined recurring To Dos. Select an item from the list if you want to make changes to it.

Subject
Sets the description text (up to 180 characters) of the recurring To Do. For quick entry, select a To Do from
the Recurring To Do List.

Notes
Type any notes about the recurring To Do. The Notes text can be up to 640 characters. In Daily view, a
paperclip icon appears next to To Dos that have text in the Notes box.

Recurring
Specifies how often the To Do occurs (specific weeks of the month, days of the month, weekly, or daily). The
pane below the Recurring options changes depending on which Recurring option you choose.

From/To
Sets the date range in which the recurring To Do could possibly occur.

Options
Category specifies the category for the To Do. You can later sort To Dos by category. Select a category
from the drop-down list.

Assign specifies the person assigned to the To Do (or a person who assigned it to you). Select a name
from the Assign drop-down list. Names can be defined through the Personal List Setup dialog box
(Calendar | Personal List Setup).

Priority sets the priority for the To Do or goal to Low, Medium, High,  Advanced, or No Priority. If
Advanced is chosen, you can click the Advanced button to specify additional levels of priority. 

Add button
Saves the recurring To Do and adds it to the All Recurring To Do List.

Delete button
Deletes the selected recurring To Do from the All Recurring To Do List. You can choose to delete all
occurrences, past occurrences, or future occurrences.
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Change button
Replaces the selected recurring To Do with the new settings.

Created with the Personal Edition of HelpNDoc: Qt Help documentation made easy

Single Day Calls Command

In Calendar view, the Single Day Calls command (Calendar | Calls | Single Day) opens the Call dialog box,
where you can create a new call.

Dialog Box Options

Predefined Activities
Displays a list of predefined activities you can choose from. Predefined Activities are usually composed of
text and one or more field names, which are replaced with information from the current card. For example,
Call {Firstname} {Lastname} at {Phone}, when filled in with the current card information, might read Call
Michael Smith at 555-8943. If you choose an item from the Predefined Activities list, you can edit the item in
the Subject field. If no Predefined Activities are listed, click the Setup button to open the Personal List Setup
dialog box (see below).

Subject
Sets the description text (up to 180 characters) of the call. For quick entry, select a call from the Predefined
Activities list.

Notes
Type any notes about the call. The Notes text can be up to 640 characters. In Daily view, a paperclip icon
appears next to calls that have text in the Notes box.

Call Status
Sets the status of the call. The call status code (the initial letter of each word in the call status) appears on the
Calls list in the Daily view to remind you of the type of call or follow-up needed. Examples of call status are
Call, Busy, and Voice Mail Message. Change the types of Status by clicking the Setup button.

Completed

When checked, indicates that the call is completed. A  appears next to completed calls in the Daily view.

Urgent

When checked, indicates that a call is urgent. An exclamation point  appears next to urgent calls in the
Daily View.

Recurring button
Opens the Recurring Call dialog box, where you can set the call to recur. Recurring calls appear with a  in
the Daily view.

Default button
Saves the call status, completed, and urgent settings as defaults for new calls.

Setup button
Opens the Personal List Setup dialog box, where you customize predefined activities and call status codes.

Created with the Personal Edition of HelpNDoc: Free Kindle producer

Recurring Calls Command

In the Daily Calendar view, the Recurring Calls command (Calendar | Calls | Recurring) opens a dialog box
where you can create a recurring call. Recurring calls appear with a  in the Daily view.

Dialog Box Options
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Recurring Calls List
Lists already defined recurring calls. Select an item from the list if you want to make changes to it.

Subject
Sets the description text (up to 180 characters) of the recurring call. For quick entry, select a call from the
Recurring Calls List.

Note
Type any notes about the recurring call. The Note text can be up to 640 characters. In Daily view, a paperclip
icon appears next to calls that have text in the Note box.

Recurring
Specifies how often the call occurs (specific weeks of the month, days of the month, weekly, or daily). The
pane below the Recurring options changes depending on which Recurring option you choose.

From/To
Sets the date range in which the recurring call could possibly occur.

Urgent Option

When checked, indicates that a call is urgent. An exclamation point  appears next to urgent calls in the
Daily view.

Add button
Saves the recurring call and adds it to the Recurring Calls List.

Delete button
Deletes the selected recurring call from the Recurring Calls List. You can choose to delete all occurrences,
past occurrences, or future occurrences.

Change button
Replaces the selected recurring call with the new settings.

Created with the Personal Edition of HelpNDoc: Produce online help for Qt applications

Goals Command

In the Daily Calendar view, the Calendar | Goals command adds a new item to the Goals list. The Goals list
contains goals that have due dates in the distant future. Goals list items are things that do not require
immediate attention, but you want to be aware of them. You can create up to 480 goals for one calendar year.
Once the end of the year is reached, the goals remain in that year. They will not be forwarded into the next
year.

If you want, you can set a due date for a goal. When that day is reached, Sidekick automatically transfers the
goal to the To Do list.

When you choose the Goals command, the Goals dialog box opens, letting you define the goal. For help on
the options in this dialog box, see To Do/Goals Dialog Box.

Created with the Personal Edition of HelpNDoc: Free help authoring tool

Special Day Command

In the Daily Calendar view, the Special Day command (Calendar | Events | Special Day) opens a dialog box
where you can schedule special days, such as holidays, birthdays, and anniversaries. You can use Special
Day to remind yourself about office events or family events.

In the Daily Calendar view, special days appear in the top left corner. If you have several special days
scheduled for the same day, you can right-click the visible special day to see a list of them all.

Shortcuts
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Toolbar:

Dialog Box Options

Special Days List
Click the down arrow to display a list of special days that have been defined. Select one from the list if you
want to change or delete it. 

Description
Type a description of a special day.

Alarm
When checked, sets an alarm to indicate a special day.  A  appears next to special days with alarms.

Play button lets you hear the currently selected Wave (.WAV) file.

Lead Time sets the number of days prior to a special day that an alarm sounds. This option is available
only when Alarm is checked. 

Tone sets the Wave file used to sound an alarm for a special day. This option is available only when Alarm
is checked. 

Time
Day of Month sets the special day to occur on a specific day of the month. 

Day of Week sets the special day to occur on a specific day of the week. 

Month sets the month of the year on which the special day falls (1=JAN, 12=DEC). 

Day sets the day of the month on which the special day falls. This option is unavailable if the Day of Week
option is chosen. 

Repeat Annually sets the day of the year on which the special day falls.

Week
Sets the week of the month on which the special day falls; select either 1st, 2nd, 3rd, 4th, or Last. This group
of choices is unavailable if the Day of Month option is chosen.

Week Day
Sets the day of the week on which the special day falls. This group of choices is unavailable if the Day of
Month option is chosen.

Add button
Adds a newly defined special day to the list of descriptions.

Change button
Replaces the selected special day with the new settings.

Delete button
Deletes a special day from the Special Days List.

Created with the Personal Edition of HelpNDoc: Generate EPub eBooks with ease

Delete Command (Calendar)

The Delete command in Calendar view (Calendar | Delete) opens the Delete Activities dialog box, where you
can delete Calendar activities within a specified range of days. You can delete appointments, calls, To Do
items, or goals.

Note The Delete command removes all events, including group events.

Dialog Box Options

From/To
Sets the date range from which to delete the specified activities in the calendar.

Delete
Determines the type of activities to delete.

https://www.helpndoc.com/create-epub-ebooks


Sidekick 98 Help

79 / 200

Created with the Personal Edition of HelpNDoc: Produce Kindle eBooks easily

Sort To Do Items Command

In Calendar view, the Calendar | Sort | To Do Items command opens the Sort To Do Items dialog box, where
you can sort items on the To Do list. For a description of the sorting options, see Sort To Do Items/Goals List
Dialog Box.

Created with the Personal Edition of HelpNDoc: Write EPub books for the iPad

Sort Goals Command

The Sort Goals command (Calendar | Sort | Goals) sorts the items on the Goals list. For a description of the
sorting options, see Sort To Do Items/Goals List Dialog Box.

Created with the Personal Edition of HelpNDoc: Full-featured EBook editor

Almanac Command

In the Calendar view, the Calendar | Almanac command displays almanac information for the current Local
Clock city. The information applies to the city for the current date: time zone (relative to Greenwich Mean
Time), sunrise, sunset, hours of daylight, moon phase, daylight saving time dates, day of the year.

You can also see facts about the current Local Clock city by clicking the Facts tab in this dialog box.

Created with the Personal Edition of HelpNDoc: Free Qt Help documentation generator

Personal List Setup Command

The Calendar | Personal List Setup command lets you define your own lists of predefined activities, call
status, activity categories, and assignments. For a description of the setup options, see Personal List Setup
Dialog Box.

Created with the Personal Edition of HelpNDoc: Produce Kindle eBooks easily

Daily Activity Command

Use the Schedule New Activity dialog box to choose the kind of activity you want to schedule (Appointment,
Call, or To Do item).  To open this dialog box, choose Calendar | Daily Activity in the Calendar Weekly,
Monthly, or Yearly views, or Edit | New Activity in the Activities view.

Dialog Box Options

Schedule
Sets the type of activity to schedule: single-day event, group event, call, or To Do item.

Date
Sets the date for the activity. Click the small arrows to increment the date, or click the large arrow to see a
calendar for selecting the date.

When you click OK, Sidekick displays the appropriate dialog box for the type of activity you have chosen.
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Created with the Personal Edition of HelpNDoc: Free HTML Help documentation generator

Cards Menu

The Cards menu lets you control the content and order of your cardfile. For more information, highlight a
specific Cards menu choice and press F1.

Created with the Personal Edition of HelpNDoc: Create help files for the Qt Help Framework

Add Card Command

In Contacts view, the Cards | Add command adds a contact card. For a description of the dialog box options,
see the topic Add Card Dialog Box.

Shortcuts

Toolbar:

Keyboard: Ctrl+A

Created with the Personal Edition of HelpNDoc: Write eBooks for the Kindle

Duplicate Card Command

In Contacts view, the Duplicate Card command (Cards | Duplicate) opens the Duplicate Card dialog box,
where you specify the number of copies to make of the current contact card.

Number of Duplicates
Type or select the number of duplicate contact cards you want to make.

Created with the Personal Edition of HelpNDoc: Single source CHM, PDF, DOC and HTML Help creation

Move Cards Command

In Contacts view, the Move Cards command (Cards | Move) opens the Move Cards dialog box, where you can
move contact cards from the current cardfile to another open cardfile. This menu item is dimmed unless at
least two cardfiles are open.

Shortcuts
Mouse: Click and drag the card from the Cards list to another cardfile tab to use drag and drop.

Dialog Box Options

Select Cards to Move
Current Card moves the current card.

Marked Cards moves marked cards. If no cards are marked, this option is dimmed. (To mark or unmark a
card, right-click it in the Cards list.)

Selected Cards moves the selected card or cards. If no cards are selected, this option is dimmed. (To
select cards, see Selecting Cards.)

All Cards moves all cards. 

To Cardfile
Chooses the cardfile to move cards to. 
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Copy Instead of Move
Copies the cards to the destination cardfile instead of moving them.

OK
Click OK to move cards. The Match Cardfile Fields dialog box is displayed. 

Created with the Personal Edition of HelpNDoc: Free CHM Help documentation generator

Delete Cards Command

In Contacts view, the Delete Cards command (Cards | Delete) opens the Delete Cards dialog box, where you
can set up criteria for deleting contact cards from the cardfile.

Dialog Box Options

Delete
Current Card deletes the current card.

Marked Cards deletes marked cards. If no cards are marked, this option is dimmed. (To mark or unmark a
card, right-click it in the Cards list.)

Selected Cards deletes the selected card or cards. If no cards are selected, this option is dimmed. (To
select cards, see Selecting Cards.)

Cards with Blank Index deletes any cards that have no data in any of the three index fields. If no cards
have blank indexes, this option is dimmed.

Index Range deletes a range of cards. In the From and To boxes, type the index line information for the
first and last cards in the range of cards you want to delete. If Index Range is not selected, the From/To
option is dimmed.

Confirm Each Delete
When checked, Sidekick prompts you before deleting each card.

Created with the Personal Edition of HelpNDoc: Create help files for the Qt Help Framework

Mark/Unmark Current Card Command

In Contacts view, the Cards | Mark/Unmark Current Card command marks or unmarks the selected contact
card.

Marking cards is a way to specify a group of cards for certain functions. It is more lasting than selecting
cards, because marked cards will remain marked until specifically unmarked. Marked cards are distinguished
by a red triangle on the left side of their indexes.

Shortcuts
Keyboard: Ctrl+K

Mouse: Right-click cards in the Cards list to mark or unmark them.

Created with the Personal Edition of HelpNDoc: Easy EBook and documentation generator

Unmark All Command

In Contacts view, the Cards | Unmark All command unmarks all marked contact cards in the active cardfile.

Created with the Personal Edition of HelpNDoc: Free Kindle producer
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Define Fields Command

In Contacts view, the Cards | Define Fields command opens the Define Cardfile Fields dialog box, where you
can define contact card fields and determine how the cards are sorted.

Dialog Box Options

Field Name
Sets the name of a new field you want to add or an existing field name you want to change. Click the down
arrow for a list of some commonly used field names.

Add button
Inserts a field name after the highlighted position in the field names list. If the field name you typed already
exists, Add is dimmed.

Add Before button
Inserts a field name before the highlighted position in the field names list. If the field name you typed already
exists, Add Before is dimmed.

Change button
Changes a field name in the Field Names list. This command is dimmed if the field name you typed already
exists or a field name has not been selected.

Delete button
Deletes the selected field from the cardfile. This command is dimmed if no field name is selected.

Sort By button
Opens the Sort Cardfile dialog box, where you change the index line (or title) used for sorting the cards in the
cardfile.

OK button
Updates the cardfile with the changes made to the field names. If no changes have been made to the cardfile
fields, this button is dimmed.

Created with the Personal Edition of HelpNDoc: Free help authoring tool

Reorder Fields Command

In Contacts view, the Cards | Reorder Fields command opens the Reorder Cardfile Fields dialog box, where
you can reorder the fields in the active cardfile.

Dialog Box Options

Current Order
Displays the current order of field names in the active cardfile. Select a field name, and then click the >
button to move it to the New Order list.

New Order
Displays the new order for the field names. Click > to move a field to the New Order list; click < to remove a
field from the New Order list.

Reset button
Resets the field order to the original settings. This button is dimmed if the field order has not been changed.

Up button
Moves the selected field up in the New Order list. This button is dimmed if there are fewer than two fields in
the New Order list.

Down button
Moves the selected field down in the New Order list. This button is dimmed if there are fewer than two fields in
the New Order list.
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Created with the Personal Edition of HelpNDoc: Create help files for the Qt Help Framework

Sort Cards Command

In Contacts view, the Sort Cards command (Cards | Sort) opens the Sort Cardfile dialog box, where you can
create an index (or title) line for the contact cards based on any three of the cardfileʼs fields. A cardfile is
sorted by its index line.

Note: If you do not select any fields to sort a cardfile, Sidekick uses the first three fields as they appear on
the cards.

Shortcuts

Toolbar:

Keyboard: Ctrl+R

Dialog Box Options

Field Name

Select a field name, and then click the  button to add it to the Sort By list.

Sort By
Displays the fields you want to use to sort the cardfile. You can select up to three fields from the Field Name

list. Click  to add a field to the Sort By list. Click  to remove a field from the Sort By list.

Up button
Moves the selected field in the Sort By list up by one. This button is dimmed if there are fewer than two fields
in the Sort By list.

Down button
Moves the selected field in the Sort By list down by one. This button is dimmed if there are fewer than two
fields in the Sort By list.

Sorting Order
Chooses the sorting order, either alphabetical or reverse alphabetical. 

Created with the Personal Edition of HelpNDoc: News and information about help authoring tools and software

Reorder Tabs Command (Contacts View)

In Contacts view, the Cards | Reorder Tabs command opens the Reorder Cardfile Tabs dialog box, where you
can change the order of the cardfile tabs. The default order of cardfile tabs is the order in which they were
opened. This command is dimmed when only one tab exists.

Shortcuts
Keyboard: F11

Dialog Box Options

Current Cardfile Order
Lists the cardfiles displayed on the tabs in their current order. 

Up button
Changes the order of cardfiles in the Current Cardfile Order list. Choose a cardfile and click Up to move the
cardfile tab to the left.

Down button
Changes the order of cardfiles in the Current Cardfile Order list. Choose a cardfile and click Down to move
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the cardfile tab to the right.

Created with the Personal Edition of HelpNDoc: Free EPub and documentation generator

Edit Menu

The Edit menu provides tools for revising your existing items. The commands offered vary depending on the
active view.

For more details, highlight an Edit menu choice and press F1. 

Created with the Personal Edition of HelpNDoc: Full-featured Kindle eBooks generator

Edit Menu (Contacts View)

The Edit menu provides tools for revising your existing items. 

For more details, highlight an Edit menu choice, and press F1. 

Created with the Personal Edition of HelpNDoc: Easy CHM and documentation editor

Find Command (Contacts View)

The Edit | Find command lets you search for cardfile items. 

For more details, highlight a Find menu choice, and press F1. 

Created with the Personal Edition of HelpNDoc: Create cross-platform Qt Help files

Edit Menu (Calendar View)

The Edit menu provides tools for revising your existing items. 

For more details, highlight an Edit menu choice, and press F1. 

Created with the Personal Edition of HelpNDoc: Easy EPub and documentation editor

Edit Menu (Memos View)

The Edit menu provides tools for revising your existing items. 

For more details, highlight an Edit menu choice, and press F1. 

Created with the Personal Edition of HelpNDoc: Generate EPub eBooks with ease

Edit Menu (Expense View)

The Edit menu provides tools for revising your existing items. 

For more details, highlight an Edit menu choice, and press F1. 
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Created with the Personal Edition of HelpNDoc: Easily create HTML Help documents

Edit Menu (Report View)

The Edit menu provides tools for revising your existing items. 

For more details, highlight an Edit menu choice, and press F1. 

Created with the Personal Edition of HelpNDoc: Free help authoring environment

Edit Menu (EarthTime View)

The Edit menu provides tools for viewing and changing city information.

Select a Different City

Facts about the City

Modify City Information

Created with the Personal Edition of HelpNDoc: Easily create EPub books

Undo Command

The Edit | Undo command reverses the last action performed, returning Sidekick back to the state it was in
before the action was taken. These are some of the actions it is possible to undo:

Undo Cut

Undo Paste

Undo Typing

Undo Delete

Undo Backspace

Undo Drag and Drop Cards

Undo Move

Shortcuts
Keyboard: Ctrl+Z

Created with the Personal Edition of HelpNDoc: Benefits of a Help Authoring Tool

Cut Command

The Edit | Cut command removes selected text and puts it on the Clipboard. This command is dimmed if you
have not selected any text.

Shortcuts

Toolbar:

Keyboard: Ctrl+X

Created with the Personal Edition of HelpNDoc: Free iPhone documentation generator
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Copy Command

The Edit | Copy command copies selected text onto the Clipboard. This command is dimmed if you have not
selected any text.

Shortcuts

Toolbar:

Keyboard: Ctrl+C

Created with the Personal Edition of HelpNDoc: Qt Help documentation made easy

Paste Command

The Edit | Paste command inserts a copy of the Clipboard contents at the insertion point. This command is
dimmed if the Clipboard is empty.

Shortcuts

Toolbar:

Keyboard: Ctrl+V

Created with the Personal Edition of HelpNDoc: Create HTML Help, DOC, PDF and print manuals from 1 single
source

Copy Special Command

In Contacts view, the Edit | Copy Special command copies specified fields from the current contact card to
the Windows Clipboard. You can then paste the information into a memo or anywhere you can paste
Clipboard contents.

Use the Copy Special Setup command to specify the fields you want to copy.

Created with the Personal Edition of HelpNDoc: Easy EPub and documentation editor

Copy Special Setup Command

In Contacts view, the Edit | Copy Special Setup command opens a dialog box where you specify what fields
of the current cardfile you want to copy using the Copy Special command. 

Dialog Box Options

Card Fields
Displays a list of fields. Click one or more that you want to add to the contents.

Add/Insert
Click the Fields >> button to add the selected fields.  Click the New Line, Space or Comma buttons to add
those elements, or type them in the contents work space.

Select or Type Contents
The work space where you create the contents from fields you select or text you type.

Created with the Personal Edition of HelpNDoc: Generate Kindle eBooks with ease
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Go to Cardfile Command

In Contacts view, the Go to Cardfile command (Edit | Go to Cardfile) opens the Go to Cardfile dialog box,
where you can choose another cardfile to use. (This option is not available when you are viewing an Untitled
cardfile.)

Shortcuts
Keyboard: Ctrl+G

Dialog Box Options

Select a Cardfile
Displays a list of cardfiles.

Go To button
Makes the cardfile name selected in the list box the active cardfile.

Created with the Personal Edition of HelpNDoc: Easily create Web Help sites

Find Text Command

In Contacts view, the Find Text command (Edit | Find | Text) opens the Find Text dialog box, where you can
specify text to search for in the cardfile, as well as what part of the cardfile to search.

Shortcuts

Toolbar:  

Keyboard: Ctrl+F

Dialog Box Options

Text to Find
Type the text (string) that you want to find in the cardfile.

Search Within
Index searches the card indexes only in the cardfile.

Contact Log searches the Contact Logs in the cardfile.

Cards searches the card contents in the cardfile.

Marked Cards searches only the marked cards in the cardfile. If no cards are marked, this option is
dimmed.

Find button
Finds and displays a card with matching text. The first card found becomes the current card.

Created with the Personal Edition of HelpNDoc: Generate EPub eBooks with ease

Find Condition Command

In Contacts view, the Find Condition command (Edit | Find | Condition) searches for cards that meet
specified conditions. For a description of the dialog box options, see the Find Condition dialog box.

Created with the Personal Edition of HelpNDoc: Easily create Help documents

https://www.helpndoc.com/feature-tour
https://www.helpndoc.com/create-epub-ebooks
https://www.helpndoc.com/feature-tour


Sidekick 98 Help

88 / 200

Find Next Command (Contacts View)

In Contacts view, the Edit | Find Next command finds the next card with the search text or condition that is
specified in the Find Text or Find Condition dialog box.

Shortcuts
Keyboard: F3

Created with the Personal Edition of HelpNDoc: Create cross-platform Qt Help files

Find Previous Command (Contacts View)

In Contacts view, the Edit | Find Previous command finds the previous card with the search text or condition
that is specified in the Find Text or Find Condition dialog box.

Shortcuts
Keyboard: Shift+F3

Created with the Personal Edition of HelpNDoc: Free PDF documentation generator

Go To Command (Calendar View)

In Calendar view, the Go To commands let you quickly jump to today's date or to a date you specify.

Today

Specific Date

Created with the Personal Edition of HelpNDoc: Easy EPub and documentation editor

Go to Today Command

In Calendar view, use the Go to Today command (Edit | Go To | Today) to quickly jump to today's date (as set
internally by your computer's system clock) in the Daily view. If you are already at today's date on the
Calendar, the Edit | Go To | Today command is dimmed.

Shortcuts
Keyboard: Ctrl+G (Calendar only)

Created with the Personal Edition of HelpNDoc: Free help authoring environment

Go to Specific Date Command

In Calendar view, the Go to Specific Date command (Edit | Go To | Specific Date) opens a dialog box where
you specify a selected date to quickly jump to in the Daily view.

Dialog Box Options

Pick a Date
Specifies the date to go to. Type a new date or click the list box arrow to display a calendar. Click a date on
the calendar to select that date. You can use the arrows next to the month title to change the month displayed.

Go To __ Days Later
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Lets you jump ahead by a specific number of days from the current date. Type the number of days (up to
90), or click the list box arrow to set the number of days.

Created with the Personal Edition of HelpNDoc: Easily create Qt Help files

Find Command (Calendar View)

In Calendar view, the Edit | Find command opens the Find dialog box, where you specify search criteria and
text you want to find in the Calendar.

Shortcuts

Toolbar:

Keyboard: Ctrl+F

Dialog Box Options

Search Range
From sets the beginning date to be searched. The default day is a week before today.

To sets the ending date to be searched. The default day is today.

Search For
Enter strings to search for in Subject or Notes fields. The text can be the same for both. If the strings for
Subject and Notes are different, the search results contain both search criteria.

Include
Check the sections of the Calendar to search. Choose from Events, Calls, To Do Items, and Goals List.

Activities Found
Displays the results of the search. 

Find button
Begins searching. Choose Find after the parameters of the search are properly defined.

Go To button
Goes to an an activity selected in the Activities Found list. You can go to an activity without clicking this button
by double-clicking the activity.

Created with the Personal Edition of HelpNDoc: News and information about help authoring tools and software

Reschedule Command

In Calendar view, the Reschedule command opens the Reschedule Activity dialog box, where you can
reschedule calls or To Do items to another day or time. In Daily view, the Reschedule command opens the
Schedule an Event dialog box.

Highlight an item to reschedule, then choose Calendar | Reschedule.

Dialog Box Options

Time
Sets the time to reschedule an appointment to. The Time option is dimmed when rescheduling To Dos and
calls.

Date
Sets the date to reschedule the item to. You can click the arrow to choose a date from a mini calendar.

Created with the Personal Edition of HelpNDoc: Easy EBook and documentation generator
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Add Card Command

In Calendar and Memos views, the Edit | Add Card command adds new cards to the cardfile. It is equivalent
to the Cards | Add command from the Contacts view. For a description of the dialog box options, see Add
Card Dialog Box.

Shortcuts
Keyboard: Ctrl+A

Created with the Personal Edition of HelpNDoc: Easily create HTML Help documents

Select All Command

In Memos view, the Edit | Select All command selects all text in the current memo. If the cursor is in the
subject text, the Select All command selects all text in the subject line.

Created with the Personal Edition of HelpNDoc: Produce Kindle eBooks easily

Go to Folder Command

In Memos view, the Go to Folder command (Edit | Go to Folder) opens the Go to Folder dialog box, where you
can choose a folder to switch to. 

Shortcuts
Keyboard: Ctrl+G

Dialog Box Options

Select a Folder
Displays the folders currently available. Click the folder you want to switch to.

Go To button
After you have selected a folder, click Go To to switch to that folder.

Created with the Personal Edition of HelpNDoc: Benefits of a Help Authoring Tool

Find Command (Memos View)

In Memos view, the Find command (Edit | Find) opens the Find dialog box, where you specify search criteria
and text that you want to find in memos.

Shortcuts

Toolbar:

Keyboard: Ctrl+F

Dialog Box Options

Find Text
Type the text to find on the memo subject line.

Match Case
Check this box to find the search text only when the capitalization matches exactly.

Match Whole Word Only
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Check this box to find the search text only when it is not contained within another word.

Find Next button
Click this button to find the next occurrence of the specified text.

Advanced Options button
Click this button to expand the dialog box to show the following advanced options.

Date Range lets you search for memos entered within a date range, or entered before or after a specific
date.

Select Folders tells which folders to include in the search. By default, only the current memo is searched.

All Folders includes all folders in the search.

Find Text in Subject lets you type additional text to find in the memos' subject lines.

Created with the Personal Edition of HelpNDoc: What is a Help Authoring tool?

Replace Command (Memos View)

In Memos view, the Replace command (Edit | Replace) opens the Find and Replace dialog box, where you
specify search criteria, text to find, and replacement text. You can search for text and replace it in the subject
and/or contents of memos in a selected folder or in all folders.

Dialog Box Options

Find Text
Type the text to find in the memos.

Replace With
Type the replacement text.

Match Case
Check this box to find the search text only when the capitalization matches exactly.

Match Whole Word Only
Check this box to find the search text only when it is not contained within another word.

Find Next button
Click this button to find the next occurrence of the specified text.

Replace button
Click to replace the found text and move to the next occurrence.

Replace All button
Click to replace all occurrences of the specified text.

Advanced Options button
Click this button to expand the dialog box to show the following advanced options.

Include Subject includes subject lines in the find and operation.

Search within Folders tells which folders to include in the search. By default, only the current memo is
searched.

All Folders includes all folders in the search.

Created with the Personal Edition of HelpNDoc: Full-featured EPub generator

Found Text Command

Found Text Command
In Memos view, the Edit | Found Text command displays the Found window with the results of the last Find
command. You must use Edit | Find before you can use Edit | Found.
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The Found window lists the subject lines and folder names of all memos that match the search criteria. To
switch to a memo, click its subject line in the list. The Found windowʼs title bar lists the number of memos
found. 

The Find Next button selects the next line in the dialog box and selects the corresponding text in the memo.

Clicking the windowʼs close button or choosing Edit | Found again closes the window. 

Created with the Personal Edition of HelpNDoc: News and information about help authoring tools and software

Find Next Command (Expense View)

In Expenses view, the Edit | Find Next command finds the next match for the specified search text.

Shortcuts
Keyboard: F3

Created with the Personal Edition of HelpNDoc: Qt Help documentation made easy

Find Previous Command (Expense View)

In Expenses view, the Edit | Find Previous command finds the previous match for the specified search text.

Shortcuts
Keyboard: Shift+F3

Created with the Personal Edition of HelpNDoc: Write eBooks for the Kindle

Find Command (Expense View)

In Expenses view, the Edit | Find command opens the Find dialog box.

Find Text
Enter the text you want to find.

Find Next button
Click to find the next occurrence of the specified text.

Created with the Personal Edition of HelpNDoc: Create HTML Help, DOC, PDF and print manuals from 1 single
source

Delete Column/Row Command

In Report view (cardfile and calendar reports), the Edit | Delete Column/Row command deletes selected
columns or rows from the report. Only complete rows and columns can be deleted; the command is dimmed if
an entire column or row is not selected.

Note You cannot use Edit | Undo to restore rows or columns that have been deleted using Edit | Delete
Column/Row. Regenerate the report to restore the deleted columns or rows.

Created with the Personal Edition of HelpNDoc: Free EPub and documentation generator
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Go To Command (Activities View)

The Edit | Go To command in the Activities view takes you to the currently selected calendar item
(appointment, To Do item, or call).  You also can click the event and click the Go To button at the bottom of the
window, or double-click the event.

Created with the Personal Edition of HelpNDoc: Full-featured Documentation generator

Delete Command

The Edit | Delete command in the Activities view deletes the currently selected event or calendar item.  

Deleting group scheduling events in the Activities view does not remove them from your calendar, and does
not send cancelation notices to participants. Use the Delete command to clean up your Activities view without
affecting events on your calendar.  

Note: Here are some issues to consider when you delete a group event:

1. If the item is for a group event that you initiated and that has not been completed, you will not be able to
track and modify the deleted event.

2. If the item is a group event that is still in your calendar, deleting the item will delete all participant and
resource information for the event. You can safely do so after the event has taken place. 

3. If you delete an item in Activities view and then delete it from the Calendar, you will not be prompted to send
cancelation notices to participants, because the participant and resource information has been deleted. 

4. If you delete an event, incoming replies to that event are discarded.

Created with the Personal Edition of HelpNDoc: Full-featured EPub generator

File Menu

The File menu has options for opening, saving, printing, and other file-related activities.

For more information, highlight one of the File menu options, and press F1.

Created with the Personal Edition of HelpNDoc: Easily create CHM Help documents

File Menu (Activities View)

The File menu has options for saving, printing, and other file-related activities.

For more information, highlight one of the File menu options, and press F1.

Created with the Personal Edition of HelpNDoc: Free EPub producer

File Menu (Contacts View)

The File menu has options for opening, saving, printing, and other file-related activities.

For more information, highlight one of the File menu options, and press F1.

Created with the Personal Edition of HelpNDoc: Full-featured Kindle eBooks generator
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Print Command (Contacts View)

In Contacts view, the File | Print menu has options for printing your cardfile data.

For more information, highlight one of the menu options, and press F1.

Created with the Personal Edition of HelpNDoc: Free EPub and documentation generator

File Menu (Calendar View)

The File menu has options for opening, saving, printing, and other file-related activities.

For more information, highlight one of the File menu options, and press F1.

Created with the Personal Edition of HelpNDoc: Easily create Qt Help files

File Menu (Memos View)

The File menu has options for opening, saving, printing, and other file-related activities.

For more information, highlight one of the File menu options, and press F1.

Created with the Personal Edition of HelpNDoc: iPhone web sites made easy

File Menu (Report View)

The File menu has options for opening, saving, printing, and other file-related activities.

For more information, highlight one of the File menu options, and press F1.

Created with the Personal Edition of HelpNDoc: Free Kindle producer

File Menu (Expenses View)

The File menu has options for opening, saving, printing, and other file-related activities.

For more information, highlight one of the File menu options, and press F1.

Created with the Personal Edition of HelpNDoc: Full-featured EBook editor

File Menu (EarthTime View)

The File menu has options for saving, backing up, and other file-related activities.

For more information, highlight one of the File menu options, and press F1.

Created with the Personal Edition of HelpNDoc: Write EPub books for the iPad

New Cardfile Command
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In Contacts view, the File | New Cardfile command creates a new cardfile in Sidekick, using a pre-defined
template if you select one. See Select Cardfile Template Dialog Box for more information.

Shortcuts

Toolbar:

Keyboard: Ctrl+N

Created with the Personal Edition of HelpNDoc: Easily create EPub books

Open Cardfile Command

In Contacts view, the File | Open Cardfile command opens an existing cardfile in Sidekick. 

In addition to opening cardfiles from previous versions of Sidekick, you can import files created in other
programs by selecting the format in the Files of Type list. 

Shortcuts

Toolbar:

Keyboard: Ctrl+O

For a description of common dialog box options, see File-Handling Options.

Created with the Personal Edition of HelpNDoc: Easy CHM and documentation editor

Close Cardfile Command

In Contacts view, File | Close Cardfile closes the current cardfile. 

Shortcut
Keyboard: Ctrl+W

Created with the Personal Edition of HelpNDoc: Benefits of a Help Authoring Tool

Close Cardfiles Command

In Contacts view, the Close Cardfiles command (File | Close Cardfiles) opens the Close Cardfiles dialog box. 

From the list of opened cardfiles, select each file you want to close (use Ctrl+click to select multiple files, and
Shift+click to select a range of files). When you have selected all the files you want to close, click OK.

Created with the Personal Edition of HelpNDoc: Single source CHM, PDF, DOC and HTML Help creation

Import Cardfile Command

In Contacts view, the Import Cardfile command (File | Import Cardfile) opens the Import Wizard. 

For more information, see Importing Files in Different Formats.

Created with the Personal Edition of HelpNDoc: Easily create Qt Help files
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Export Cardfile Command

In Contacts view, the Export Cardfile command (File | Export Cardfile) opens the Export Wizard. 

For more information, see Exporting Files.

Created with the Personal Edition of HelpNDoc: Free Kindle producer

Setup Cardfile Template Dialog Box

In Contacts view, the Template command (File | Template) displays the Set Up Cardfile Template dialog box.

Dialog Box Options

Cardfile Template
Sets the cardfile template to use as a basis for your new cardfile. Select a template from the list, or type in a
new name. 

New button
Creates a new template with the name you have specified. Opens the Modify Cardfile Template dialog box so
you can define the new templateʼs fields.

Modify button
Modifies the selected template. Opens the Modify Cardfile Template dialog box.

Rename button
Renames the selected template to the name in the Cardfile Template field.

Delete button
Deletes the selected cardfile template.

Created with the Personal Edition of HelpNDoc: Full-featured Help generator

Save Cardfile Command

In Contacts view, the File | Save Cardfile command saves the file under its current name. If you use File |
Save Cardfile on a cardfile that has not yet been saved, Sidekick displays the File | Save Cardfile As dialog
box.

Shortcuts
Keyboard: Ctrl+S

Toolbar:

For a description of common Save As dialog box options, see File-Handling Options.

Created with the Personal Edition of HelpNDoc: Easy EPub and documentation editor

Save Cardfile As Command

In Contacts view, the File | Save Cardfile As command saves a cardfile under a new name or to a different
location or format. You can save to the Sidekick 98, Sidekick 97, or Sidekick 95 Cardfile format (*.SKCard),
Sidekick 2.0 format (*.SDB), or other formats found in the Save as Type list.

Shortcuts
Keyboard: F12
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For a description of the dialog box options, see File-Handling Options.

Created with the Personal Edition of HelpNDoc: Easily create Help documents

Save All Command

The File | Save All command saves all open files: cardfiles, calendar, Memo files, expense files, and reports.

Shortcuts
Keyboard: Ctrl+L

Created with the Personal Edition of HelpNDoc: Create help files for the Qt Help Framework

Back Up and Restore Command

File | Back Up and Restore backs up and restores files from any or all Sidekick views.

For more information, see:

Back Up and Restore Dialog Box

Back Up Dialog Box

Restore Dialog Box

Created with the Personal Edition of HelpNDoc: iPhone web sites made easy

Print Setup Command

The File | Print Setup command specifies the target printer, and sets its properties. This command opens the
Windows 95 Print Setup dialog box.

Created with the Personal Edition of HelpNDoc: Free help authoring environment

Print Cards Command

In Contacts view, the Print Cards command (File | Print | Cards) opens the Print Cards dialog box, where you
specify cards and printing options. You can print cards and/or Contact Log information.

Shortcuts

Toolbar:

Keyboard: Ctrl+P

Dialog Box Options

What to Print
Current Card prints the current card of the active cardfile.

Selected Cards prints the selected cards of the active cardfile.

Marked Cards prints the marked cards in the active cardfile.

All Cards prints all the cards in the active cardfile.

Index Range prints cards from a range of cards in the active cardfile.

From/To: Type the index line information for the first and last card in the range of cards to print.

Print
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Select whether you want to print the card, Contact Log, and/or field names.

Cards Per Page
Select the number of cards you want to have printed per page. As you specify more cards per page, the
cards themselves become smaller. If a card becomes too small to contain all its fields, Sidekick drops the
extra fields from the bottom of the card.

If you specify Continuous, Sidekick will print all information from each card in continuous form without regard
to page breaks. If you choose Separate, each card will begin on a new page, but will not be restricted to fit on
one page. If you specify One Card, Sidekick will drop fields if needed to make the card fit.

Margins
Sets up the margins for the left, top, right and bottom of the printout. Type each margin number or use the up
or down arrow buttons to increment or decrement the margins.

Font button
Displays the Font dialog box in which you can set the fonts for the index, card, and Contact Log.

Setup button
Sets up your printer.

Preview button
Lets you see how the printed cards will look.

Created with the Personal Edition of HelpNDoc: Full-featured multi-format Help generator

Print Labels Command

In Contacts view, the File | Print | Labels command prints card information to any size label. For a description
of the dialog box options, see Print Labels/Address Book/Envelopes Dialog Box.

Created with the Personal Edition of HelpNDoc: Easily create CHM Help documents

Print Address Book Command

In Contacts view, the File | Print | Address Book command prints card information in an address book format.
For a description of the dialog box options, see Print Labels/Address Book/Envelopes Dialog Box.

Created with the Personal Edition of HelpNDoc: Free Kindle producer

Print Envelopes Command

In Contacts view, the File | Print | Envelopes command prints address information on envelopes. For a
description of the dialog box options, see Print Labels/Address Book/Envelopes dialog box.

Created with the Personal Edition of HelpNDoc: Free Web Help generator

Exit Command

The File | Exit command exits Sidekick. You can also use the Close command on the application Control
menu. Sidekick prompts you to save any active files if it has unsaved changes.

Shortcuts

Mouse: Click the  button on Sidekick's title bar.

Keyboard: Alt+F4
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Created with the Personal Edition of HelpNDoc: Full-featured EPub generator

File 1,2,3,4 Commands

The File | File 1,2,3,4 commands at the bottom of the File menu display the names of the four most recently
opened files. Choose the number of the file you want to open. 

Note Even if you delete a file, its name will still appear here until it is bumped out of the list by more recently
opened files.

Created with the Personal Edition of HelpNDoc: Easily create HTML Help documents

New Calendar Command

In Calendar view, the File | New Calendar command creates a new calendar.

Shortcuts

Toolbar:

Keyboard: Ctrl+N

Created with the Personal Edition of HelpNDoc: Easily create Help documents

Open Calendar Command

In Calendar view, the File | Open Calendar command opens an existing calendar. Each calendar consists of a
group of files all beginning with a four-letter User Name.

In addition to opening calendar files from previous versions of Sidekick, you can import files created in other
programs by selecting the format under List Files of Type.

Shortcuts

Toolbar:

Keyboard: Ctrl+O

For a description of common dialog box options, see Calendar File-Handling Options.

Created with the Personal Edition of HelpNDoc: Full-featured EPub generator

Save Calendar Command

In Calendar view, the File | Save Calendar command saves the calendar files under their current name. If you
use File | Save Calendar on a calendar that has not yet been saved, Sidekick displays the File | Save
Calendar As dialog box.

Shortcuts
Keyboard: Ctrl+S

Toolbar:

For a description of common Save As dialog box options, see Calendar File-Handling Options.

Created with the Personal Edition of HelpNDoc: Free Web Help generator
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Save Calendar As Command

In Calendar view, the File | Save Calendar As command saves your calendar under a new name or to a
different location. Your calendar file is actually eight files in the XXXX????.SKW format, where XXXX stands
for the letters you enter as your initials when you install Sidekick (from one to four letters). When saving,
opening, backing up, or restoring calendar files, Sidekick lists the initials (XXXX) as the name of the
calendar. For more information about the calendar files, see Sidekick Files. 

Shortcuts
Keyboard: F12

For a description of common dialog box options, see Calendar File-Handling Options.

Created with the Personal Edition of HelpNDoc: Easily create CHM Help documents

Import Calendar Command

In Calendar view, use the Import Calendar command (File | Import Calendar) to import calendar files.
Sidekickʼs calendar importing feature supports Microsoft Outlook 97, Schedule+ 7.0, and Lotus Organizer 97.
The Import Calendar menu offers the following choices:

Outlook 97

Schedule+ 7.0

Lotus Organizer 97

Created with the Personal Edition of HelpNDoc: Free help authoring environment

Outlook 97 Command

In Calendar view, you can import Microsoft Outlook 97 calendar files. Choose File | Import Calendar | Outlook
97.

Created with the Personal Edition of HelpNDoc: Easily create Qt Help files

Schedule+ 7.0 Command

In Calendar view, you can import Schedule+ 7.0 calendar files. Choose File | Import Calendar | Schedule+
7.0, and then specify the file to import in the Open dialog box.

Created with the Personal Edition of HelpNDoc: Easily create CHM Help documents

Open Dialog Box (Schedule+ 7.0)

When you choose File | Import Calendar | Schedule+ 7.0, you'll see an Open dialog box with the options
described below. Use this dialog box to specify the Schedule+ 7.0 file to import.

Look In
Displays the folder or directory whose contents are listed in the window in the dialog box. To move to a higher
directory, select it from the drop-down list. To move to a lower subdirectory, double-click it in the window in
the dialog box.

File Name
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Displays the name you enter for the file to be imported. Either type the name in this field or click its name in
the window in the dialog box. 

Files of Type
Specifies Schedule+ 7.0 files (.SCD).

Created with the Personal Edition of HelpNDoc: Easily create iPhone documentation

Lotus Organizer 97 Command

In Calendar view, you can import Lotus Organizer 97 calendar files. Choose File | Import Calendar | Lotus
Organizer 97, and then specify the file to import in the Open dialog box.

Created with the Personal Edition of HelpNDoc: Free help authoring tool

Open Dialog Box (Lotus Organizer 97)

When you choose File | Import Calendar | Lotus Organizer 97, you'll see an Open dialog box with the options
described below. Use this dialog box to specify the Lotus Organizer 97 file to import.

Look In
Displays the folder or directory whose contents are listed in the window in the dialog box. To move to a higher
directory, select it from the drop-down list. To move to a lower subdirectory, double-click it in the window in
the dialog box.

File Name
Displays the name you enter for the file to be imported. Either type the name in this field or click its name in
the window in the dialog box. 

Files of Type
Specifies Lotus Organizer 97 files (.OR3).

Created with the Personal Edition of HelpNDoc: Create HTML Help, DOC, PDF and print manuals from 1 single
source

Print Command (Calendar View)

Different Print options are available for each view of the Calendar:

Sidekick 98 Daily Format prints the daily calendar in various Sidekick formats.

At-A-Glance Daily Format prints the daily calendar on various At-A-Glance forms.

At-A-Glance Weekly Format prints the weekly calendar on various At-A-Glance forms.

At-A-Glance Monthly Format prints the monthly calendar on various At-A-Glance forms.

Day Runner Format prints the calendar on various Day Runner forms.

Day-Timer Daily Format prints the daily calendar on various Day-Timer forms.

Franklin Daily Format prints the daily calendar on various Franklin Planner forms.

Filofax Format prints the calendar on weekly and monthly Filofax forms.

One-Week Sidekick 98 Format prints the weekly calendar.

Two-Week Sidekick 98 Format prints the bi-weekly calendar.

Six-Week Sidekick 98 Format prints a six-week calendar.

One-Month Sidekick 98 Format prints the monthly calendar.

Sidekick 98 Year Planner prints a yearly calendar.
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Four Months by Three Rows prints a yearly calendar in a 4 x 3 months grid.

Two Months by Six Rows prints a yearly calendar in a 2 x 6 months grid.

Created with the Personal Edition of HelpNDoc: Free Kindle producer

Print Sidekick Format Dialog Box

In Calendar view, the Sidekick Daily Format command (File | Print | Sidekick Daily Format) opens the Print
Sidekick Format dialog box, where you set Sidekick format options for printing your daily calendar.

Shortcuts

Toolbar:

Keyboard: Ctrl+P

Dialog Box Options

From/To
Sets the dates to print. The default date is the currently visible day of the calendar.

Style
Sets the type of calendar to print: Single Column, Double Columns, Triple Columns, and Organizer. The
Organizer style is very similar to the Sidekick Daily Calendar view.

Contents in Columns
Sets what type of activity is listed in each column.

Paper Type
Sets the type of paper to print to. A list of paper types is provided to get you started. However, since all
printers are different, you should make sure the paper type you choose prints correctly to your printer before
printing many pages. You may have to adjust the margins slightly. Click the Edit button to edit the margins.

Options button
Opens up more printing options:

Include Mini Calendar includes the mini calendar in the printout.

Include Notes prints the Notes text for each activity.

Include Completed Item prints completed items.

Skip Empty skips all empty cells, printing only those with information in them.

Text Wrap includes all text of entries (up to 500 characters) wrapping to multiple lines if needed.

One Page prints only what will fit on a single page.

Font button
Sets the fonts to be used in printing; opens the Fonts dialog box.

Setup button
Sets up your printer defaults.

Preview button
Previews the printed calendar with the settings you chose.

Created with the Personal Edition of HelpNDoc: Single source CHM, PDF, DOC and HTML Help creation

Print At-A-Glance Daily Format Dialog Box

In Calendar view, the At-A-Glance Daily Format command (File | Print | At-A-Glance Daily Format) opens the
Print At-A-Glance Daily Format dialog box, where you set At-A-Glance format options for printing your daily
calendar.
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Dialog Box Options

From/To
Sets the dates to print. The default date is the currently visible day of the calendar.

Format
The drop-down list contains the various At-A-Glance forms available for printing. Choose the desired forms
here.

Start On
Specify whether to start printing on a left page or a right page.

Origin of Left/Right Page
Specify the printing margins of both the left and right pages. You may have to adjust the left and top margins
for printing to forms on your printer. The margins can be negative, if necessary. Make sure to test your
settings before printing many pages.

Fonts button
Sets the fonts to be used in printing; opens the Fonts dialog box.

Setup button
Sets up your printer defaults.

Preview button
Previews the printed calendar with the settings you choose.

Created with the Personal Edition of HelpNDoc: Easy EPub and documentation editor

Print At-A-Glance Weekly Format Dialog Box

In Weekly Calendar view, the At-A-Glance Weekly Format command (File | Print | At-A-Glance Weekly)
opens the Print At-A-Glance Weekly Format dialog box, where you set At-A-Glance format options for printing
your weekly calendar.

Dialog Box Options

From/To
Sets the dates to print. The default date is the currently visible week.

Format
The drop-down list contains the various At-A-Glance forms available for printing. Choose the desired forms
here.

Paper
Specify whether the paper you are using includes the date or not.

Origin of Left/Right Page
Specify the printing margins of both the left and right pages. You may have to adjust the left and top margins
for printing to forms on your printer. The margins can be negative, if necessary. Make sure to test your
settings before printing many pages.

Fonts button
Sets the fonts to be used in printing; opens the Fonts dialog box.

Setup button
Sets up your printer defaults.

Preview button
Previews the printed calendar with the settings you chose.
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Created with the Personal Edition of HelpNDoc: Easy CHM and documentation editor

Print At-A-Glance Monthly Format Dialog Box

In Monthly Calendar view, the At-A-Glance Monthly Format command (File | Print | At-A-Glance Monthly
Format) opens the Print At-A-Glance Monthly Format dialog box, where you set At-A-Glance format options for
printing your monthly calendar.

Dialog Box Options

From/To
Sets the dates to print. The default date is the currently visible month.

Format
The drop-down list contains the various At-A-Glance forms available for printing. Choose the desired forms
here.

Paper
Specify whether the paper you are using includes the date or not.

Origin of Left/Right Page
Specify the printing margins of both the left and right pages. You may have to adjust the left and top margins
for printing to forms on your printer. The margins can be negative, if necessary. Make sure to test your
settings before printing many pages.

Fonts button
Sets the fonts to be used in printing; opens the Fonts dialog box.

Setup button
Sets up your printer defaults.

Preview button
Previews the printed calendar with the settings you chose.

Created with the Personal Edition of HelpNDoc: Easily create CHM Help documents

Print Day Runner Format Dialog Box

In Calendar view, the Day Runner Format command (File | Print | Day Runner Daily/Weekly/Monthly Format)
opens Print Day Runner Format dialog box, where you set Day Runner format options for printing your daily,
weekly, or monthly calendar. You can print the calendar directly to Day Runner personal organizer notebook
pages of various sizes.

Dialog Box Options

From/To
Sets the dates to print. The default date is the currently visible date in the calendar.

Format
The drop-down list at the top of this dialog contains the various Day Runner forms available for printing.

Entrepreneur Edition: 8 x 11

Classic Edition: 5.5 x 8

Running Mate Edition: 3.75 x 6.75

Start On (Daily only)
Sets the first page for printing to dated Day Runner daily forms. Select Left Page if the first page you're
printing to is on the left (back side). Select Right Page if the first page you're printing to is on the right (front
side). 

Paper (Weekly and Monthly only)

https://www.helpndoc.com
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Sets the printing for dated or non-dated Day Runner pages. 

Origin of Left/Right Page
Sets the printing margins for both the left and right pages. The margins can be negative, if necessary. Make
sure to test your settings before printing many pages.

Fonts button
Sets the fonts to be used in printing; opens the Fonts dialog box.

Setup button
Sets up your printer.

Preview button
Previews the printed calendar with the settings you chose.

Created with the Personal Edition of HelpNDoc: Produce online help for Qt applications

Print Day-Timer Format Dialog Box

In Daily Calendar view, the Day-Timer Daily Format command (File | Print | Day-Timer Daily Format) opens
the Print Day-Timer Format dialog box, where you set options for printing the daily calendar in various Day-
Timer forms.

Dialog Box Options

From/To
Sets the dates to print. The default date is the currently visible day of the calendar.

Format
The drop-down list at the top of this dialog contains the various Day-Timer forms available for printing. The
desired forms should be chosen here.

Day-Timer Sr. Desk: 8.5 x 11

Day-Timer Jr. Desk: 5.5 x 8.5

Day-Timer Sr. Pocket: 3.75 x 6.75

Day-Timer Jr. Pocket: 2.75 x 5

Day-Timer Sr. Reference: 8.5 x 11

Day-Timer Jr. Reference: 5.5 x 8.5

Margins
You may have to adjust the left and top margins for printing to forms on your printer. The margins can be
negative, if necessary. Make sure to test your settings before printing many pages.

Font button
Sets the fonts to be used in printing; opens the Fonts dialog box.

Setup button
Sets up your printer defaults.

Preview button
Previews the printed calendar with the settings you chose.

Created with the Personal Edition of HelpNDoc: Free Web Help generator

Print Franklin Format Dialog Box

In Daily Calendar view, the Franklin Daily Format command (File | Print | Franklin Daily Format) opens the
Print Franklin Format dialog box, where you set options for printing the daily calendar in various Franklin
Planner forms.
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Dialog Box Options

From/To
Sets the dates to print. The default date is the currently visible day of the calendar.

Format
The drop-down list at the top of this dialog contains the various Franklin forms available for printing.

Franklin Monarch: 8.5 x 11

Franklin Classic: 5.5 x 8.5

Franklin Compact: 4.25 x 6.75

Margins
Adjust the left and top margins for printing to forms on a specific printer. The margins can be negative, if
necessary.

Font button
Sets the fonts to be used in printing; opens the Fonts dialog box.

Setup button
Sets up your printer.

Preview button
Previews the printed calendar with the settings you chose.

Created with the Personal Edition of HelpNDoc: Create iPhone web-based documentation

Print Filofax Format Dialog Box

In Weekly or Monthly Calendar view, the Filofax Format command (File | Print | Filofax Weekly/Monthy
Format) opens the Print Filofax Format dialog box, where you set options for printing the weekly or monthly
calendar directly to Personal size Filofax dated organizer paper.

Dialog Box Options

From/To
Sets the dates to print. The default date is the currently visible date in the calendar.

Origin of Left/Right Page
Sets the printing margins for both the left and right pages. The margins can be negative, if necessary. Make
sure to test your settings before printing many pages.

Fonts button
Sets the fonts to be used in printing; opens the Fonts dialog box.

Setup button
Sets up your printer.

Preview button
Previews the printed calendar with the settings you chose.

Created with the Personal Edition of HelpNDoc: Produce online help for Qt applications

One-Month Sidekick Format Command

In Monthly Calendar view, the File | Print | One-Month Sidekick Format command prints the monthly calendar
in Sidekick format. 

Shortcuts
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Toolbar:

Keyboard: Ctrl+P (from Monthly view)

For a description of dialog box options, see Print Dialog Box.

Created with the Personal Edition of HelpNDoc: Easy EPub and documentation editor

One-Week Sidekick Format Command

In Weekly Calendar view, the File | Print | One-Week Sidekick Format command prints the weekly calendar in
Sidekick format. 

Shortcuts

Toolbar:

Keyboard: Ctrl+P (from Weekly view)

For a description of dialog box options, see Print Dialog Box.

Created with the Personal Edition of HelpNDoc: Easily create Qt Help files

Two-Week Sidekick Format Command

In Weekly Calendar view, the File | Print | Two-Week Sidekick Format command prints the weekly calendar,
two weeks per page. For a description of dialog box options, see Print Dialog Box.

Created with the Personal Edition of HelpNDoc: Create help files for the Qt Help Framework

Six-Week Sidekick Format Command

In Weekly Calendar view, the File | Print | Six-Week Sidekick Format command prints the weekly calendar,
six weeks per page. For a description of dialog box options, see Print Dialog Box.

Created with the Personal Edition of HelpNDoc: Free PDF documentation generator

Sidekick Year Planner Command

In Yearly Calendar view, the File | Print | Sidekick Year Planner command prints the yearly calendar in
Sidekick format. 

Shortcuts

Toolbar:

Keyboard: Ctrl+P

For a description of dialog box options, see Print Dialog Box.

Created with the Personal Edition of HelpNDoc: Easily create HTML Help documents

Four Months by Three Rows Command
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In Yearly Calendar view, the File | Print | Four Months by Three Rows command prints the yearly calendar,
four months horizontally, and three months vertically. For a description of dialog box options, see Print Dialog
Box.

Created with the Personal Edition of HelpNDoc: Easily create CHM Help documents

Two Months by Six Rows Command

In Yearly Calendar view, the File | Print | Two Months by Six Rows command prints the yearly calendar, two
months horizontally, and six months vertically. This format lists multi-day events and special days between the
two columns. For a description of dialog box options, see Print Dialog Box.

Created with the Personal Edition of HelpNDoc: Single source CHM, PDF, DOC and HTML Help creation

New Memo File Command

In Memos view, the File | New Memo File command creates a new Memo file.

Shortcuts

Toolbar:

Keyboard: Ctrl+N

Created with the Personal Edition of HelpNDoc: What is a Help Authoring tool?

Open Memo File Command

In Memos view, the File | Open Memo File command opens an existing Memo file.

In addition to opening files from previous versions of Sidekick, you can import files created in other programs
by choosing the format in the Files of Type list.

Shortcuts

Toolbar:

Keyboard: Ctrl+O

For a description of common dialog box options, see File-Handling Options.

Created with the Personal Edition of HelpNDoc: Free help authoring environment

Save Memo File Command

In Memos view, the File | Save Memo File command saves all Memo files and folders.

Shortcuts
Keyboard: Ctrl+S 

Toolbar:

Created with the Personal Edition of HelpNDoc: Free help authoring environment

https://www.helpndoc.com/feature-tour
https://www.helpndoc.com/help-authoring-tool
https://www.helpauthoringsoftware.com
https://www.helpndoc.com/help-authoring-tool
https://www.helpndoc.com/help-authoring-tool


Sidekick 98 Help

109 / 200

Save Memo File As Command

In Memos view, the File | Save Memo File As command saves the Memo file to a new name.

Shortcuts
Keyboard: F12

For a description of common dialog box options, see File-Handling Options.

Created with the Personal Edition of HelpNDoc: Produce online help for Qt applications

Print Memos Dialog Box

In Memos view, the File | Print command opens the Print Memos dialog box, where you specify memos to
print. You can print the current memo, the selected memo, all memos, marked memos, or memos found in the
last search from one or more folders.

Shortcuts

Toolbar:

Keyboard: Ctrl+P

Dialog Box Options

Print
Select which memos to print (Current Memo, Selected Memos, Found Memos, Marked Memos, or All
Memos). 

Check Include Subject to print the subject line with the memos.

Select Folders to Print
Select the folders from which to print all or marked memos. 

Check All Folders to print from all folders.

Style
Continuous prints the memos without page breaks.

Start Each Memo on a New Page prints the memos with each starting on a separate page.

Options
Number of copies determines how many copies of each page are printed.

Print Page Numbers adds page numbers to the printed memo.

Print Misspelled Words in Strikeout Font Style prints all words found by Auto Spell Check to be
incorrectly spelled in strikeout font, as they appear on-screen.

Preview button
Previews the memos before you print.

Created with the Personal Edition of HelpNDoc: Generate EPub eBooks with ease

Page Setup Dialog Box

In Memos view, the File | Page Setup command sets up the page for printing. 

Dialog Box Options

Size
Sets the page dimensions. You can choose from a number of different paper and envelope sizes.

https://www.helpndoc.com/feature-tour/create-help-files-for-the-qt-help-framework
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Source
Sets the printerʼs paper feed source.

Orientation
Sets whether you are printing to a tall page, or a wide page.

Margins
Sets the margins for the page.

Printer button
Opens the Windows 95 Page Setup dialog box, which is used to select another printer or to change its
properties.

Created with the Personal Edition of HelpNDoc: Produce online help for Qt applications

New Report Command

When youʼre viewing a report, you can use the New Report command (File | New Report) to open the New
Report dialog box, where you can choose the kind of report you want to create next.

Shortcuts
Keyboard: Ctrl+N

Dialog Box Options

Card Report
Generates a report from the cardfile.

Calendar Report
Generates a report from appointments, calls, To Dos, Task List items, multi-day events, and/or special days.

Free Time Report
Generates a report of the free time between appointments.

To Do Items Report
Generates a report from To Dos and/or Goals List items.

Contact Log Report
Generates a report from the Contact Log for each card.

Created with the Personal Edition of HelpNDoc: Create iPhone web-based documentation

Open Report Command

In Report view, the File | Open Report command opens an existing expense report in Sidekick. Report files
have the extension .RPT.

Shortcuts
Keyboard: Ctrl+O

For a description of common dialog box options, see File-Handling Options.

Created with the Personal Edition of HelpNDoc: iPhone web sites made easy

Save Report Command

In Report view, the File | Save Report command saves the report file under its current name. If you use File |
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Save Report on a report that has not yet been saved, Sidekick displays the File | Save Report As dialog box.

Shortcuts
Keyboard: Shift+S

For a description of common Save As dialog box options, see File-Handling Options.

Created with the Personal Edition of HelpNDoc: Free HTML Help documentation generator

Save Report As Command

In Report view, the File | Save Report As command saves a report under a new name or to a different
location. Report files are saved with the extension (*.RPT).

Shortcuts
Keyboard: F12

For a description of common dialog box options, see File-Handling Options.

Created with the Personal Edition of HelpNDoc: Free iPhone documentation generator

Print Command (Report View)

In Report view, the File | Print command sends the current report to the printer.

Shortcuts
Keyboard: Ctrl+P

Created with the Personal Edition of HelpNDoc: Produce online help for Qt applications

Print Preview Command (Report View)

In Report view, the File | Print Preview command previews the report before you print it.

Created with the Personal Edition of HelpNDoc: Write eBooks for the Kindle

Print Preview Command (Memos View)

In Memos view, the File | Print Preview command lets you preview a memo before you print it.

Created with the Personal Edition of HelpNDoc: Qt Help documentation made easy

Print Preview Command (Expenses View)

In Expenses view, the File | Print Preview command lets you preview an expense receipt or report before you
print it.

Created with the Personal Edition of HelpNDoc: Free PDF documentation generator

https://www.helpndoc.com
https://www.helpndoc.com/feature-tour/iphone-website-generation
https://www.helpndoc.com/feature-tour/create-help-files-for-the-qt-help-framework
https://www.helpndoc.com/feature-tour/create-ebooks-for-amazon-kindle
https://www.helpndoc.com/feature-tour/create-help-files-for-the-qt-help-framework
https://www.helpndoc.com


Sidekick 98 Help

112 / 200

New Expense File Dialog Box

In Expenses view, the File | New Expense File command opens the New Expense File dialog box, where you
can create a new expense file in Sidekick.

Shortcuts

Toolbar:

Keyboard: Ctrl+N

Dialog Box Options

Name for First Folder
When you create a new Expense file, this name will be used for the first folder. (You can change it using the
Expenses | Folder | Properties command.)

Personʼs Name
The name of the person whose expenses will be entered here.

Department
The personʼs department, or the department incurring the expenses.

Organization
The name of the company or organization.

Purpose of Expenses
The purpose of the expenditures.

File Currency Setting
Select the currency from the drop-down list.

Expense Report Types
Highlight the expense types you want displayed in the default pick list for expense types.

File Country Setting
Check the one that applies to your location. The tax designations are VAT (Value Added Tax), GST (Goods
and Services Tax), and PST (Provincial Sales Tax).

U.S.A. and other countries (without VAT/GST/PST)

European Countries (with VAT)

Canada (with GST/PST)

Created with the Personal Edition of HelpNDoc: Free HTML Help documentation generator

Open Expense File Command

In Expenses view, the File | Open Expense File command opens an existing expense file in Sidekick. The file
must be in the Sidekick expense file format (.SEE or Sidekick 95ʼs .SKExpense format).

Shortcuts

Toolbar:

Keyboard: Ctrl+O

For a description of common Save As dialog box options, see File-Handling Options.

Created with the Personal Edition of HelpNDoc: Easily create HTML Help documents
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Save Expense File Command

In Expenses view, the File | Save Expense File command saves the file under its current name. If you use File
| Save Expense File on an expense file that has not yet been saved, Sidekick displays the File | Save Expense
File As dialog box.

Shortcuts
Keyboard: Ctrl+S

Toolbar:

For a description of common dialog box options, see File-Handling Options.

Created with the Personal Edition of HelpNDoc: Free EBook and documentation generator

Save Expense File As Command

In Expenses view, the File | Save Expense File As command saves a expense file under a new name or to a
different location. 

Shortcuts
Keyboard: F12

For a description of common dialog box options, see File-Handling Options.

Created with the Personal Edition of HelpNDoc: Easily create Help documents

Print Receipt/Report Command

In Expenses view, the File | Print Receipt command (available from Expense Receipt view) prints your
receipts. The File | Print Report command (available from Expense Report view) prints your expense report.
When printing receipts, you have the option to print the current receipt or all receipts in the folder. 

Shortcuts

Toolbar:

Keyboard: Shift+P

Created with the Personal Edition of HelpNDoc: Create HTML Help, DOC, PDF and print manuals from 1 single
source

Print Command (Activities View)

The File | Print command prints events in the Activities view. For Internet events, you can choose either
summary or detail format, and print selected events or all events. This command opens the Print Activities
dialog box. 

Shortcuts
Keyboard: Ctrl+P

Created with the Personal Edition of HelpNDoc: Free EPub and documentation generator
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File-Handling Options

Commands that operate on files require the name of a file to work on. When you choose one of these
commands, you'll see a dialog box with the options described below.

Look In
Displays the folder or directory whose contents are listed in the window below. To move to a higher directory,
select it from the drop-down list. To move to a lower subdirectory, double-click it in the window below.

File Name
Displays the name you enter for the file to be saved or opened. Either type the name in this field or click its
name in the window above. 

Files of Type
Selects the file type shown in the window. Where importing or exporting files of another format is available,
choose the file type in this list.

Created with the Personal Edition of HelpNDoc: Produce online help for Qt applications

File-Handling Options (Calendar View)

Commands that operate on files require the name of a file to work on. When you choose one of these
commands, you'll see a dialog box with the options described below.

File Name
The name that identifies the calendar files. 

Folders
Displays the startup directory. To change to a different directory, double-click it.

Drives
Lets you switch to another drive. Click the arrow at the right of the box and double-click the drive name you
want to switch to.

List Files of Type
Selects the file type shown in the window. To import files of another format, choose the file type in this list.

Created with the Personal Edition of HelpNDoc: Full-featured Kindle eBooks generator

Help Menu

 Related topic

Contents
Displays the table of contents for the Sidekick Help file (also accessible by clicking the Contents button in the
Help window).

Search
Opens the Windows Help Search dialog box, which lets you select a word or phrase you want to search for.

Toolbar
Displays information about using Sidekick's Toolbar.

Keyboard
Displays Shortcut keys.

Register and Win
Be sure to register Sidekick 98. By doing so, you could win great prizes. Choose Help | Register and Win! for
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Internet registration, or print register.txt and mail it in if you do not have Internet access. The register.txt file is
in your Sidekick 98 directory on your computer's hard drive.

About 
Displays the Sidekick version number and copyright information.

Created with the Personal Edition of HelpNDoc: Free PDF documentation generator

Memos Menu

The Memos Menu includes the tools for managing memos, folders, and files, and for Mail Merge.

For more information, highlight one of the Memos menu options, and press F1.

Created with the Personal Edition of HelpNDoc: Easily create Help documents

Memo Command

The Memos | Memo menu provides tools for working with memos. 

For more information, highlight one of the Memo menu options, and press F1.

Created with the Personal Edition of HelpNDoc: Full-featured Documentation generator

Folder Command

The Memos | Folder Menu includes the tools for managing folders.

For more information, highlight one of the Folder menu options, and press F1.

Created with the Personal Edition of HelpNDoc: Produce online help for Qt applications

Mail Merge Command

The Memos | Mail Merge Menu provides tools for creating merge templates and performing a mail merge.

For more information, highlight one of the Mail Merge menu options, and press F1.

Created with the Personal Edition of HelpNDoc: Full-featured multi-format Help generator

Add Memo Command

The Memos | Memo | Add command creates a new memo in the current folder.

Shortcuts

Toolbar:

Keyboard: Ctrl+A

Created with the Personal Edition of HelpNDoc: Produce online help for Qt applications
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Delete Memo Command

In Memos view, the Memo Delete command (Memos | Memo | Delete) opens the Delete Memos dialog box,
where you specify memos to delete from a folder.

Dialog Box Options

Delete
Current Memo deletes the current memo.

Marked Memos deletes all marked memos in the current folder. If no memos are marked, this option is
dimmed.

Selected Memos deletes the selected memos. If no memos are selected, this option is dimmed.

Confirm Each Delete
When checked, Sidekick prompts you before deleting each memo.

Created with the Personal Edition of HelpNDoc: What is a Help Authoring tool?

Move Memo Command

In Memos view, the Move Memo command (Memos | Memo | Move) opens the Move Memos dialog box, where
you specify the memos to move from one folder to another. If there is only one folder in the open Memo file,
this command is dimmed. 

You can also drag and drop memos to another folder. 

Dialog Box Options

Select Memos to Move
Current Memo moves the current memo.

Marked Memos moves all marked memos in the current folder. If no memos are marked, this option is
dimmed.

Selected Memo moves the selected memos. If no memos have been selected, this option is dimmed.

All Memos moves all memos. 

To Folder
Indicates the folder to move memos to. 

Created with the Personal Edition of HelpNDoc: Easily create PDF Help documents

Sort Memos Command

In Memos view, the Sort Memos command (Memos | Memo | Sort) opens the Sort Memos By dialog box,
where you specify memos and sort order. 

You can sort memos by subject or date created, in ascending or descending order; you can sort memos in
the current folder or in all folders.

Shortcuts
Keyboard: Ctrl+R

Dialog Box Options

Sort Memos By
Subject sorts memos by the text contained in the Subject line of each memo.

Date sorts memos by date. 

Memo List Order

https://www.helpauthoringsoftware.com
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Ascending sorts memos in ascending order according to subject (A-Z) or date (oldest first). 

Descending sorts memos in descending order according to subject Z-A) or date (most recent first). 

Apply to All Folders
Performs the sort on all folders, including the current one.

Created with the Personal Edition of HelpNDoc: Free Web Help generator

Mark/Unmark Current Memo Command

The Memos | Memo | Mark/Unmark Current Memo command marks or unmarks the current memo.

Shortcuts
Keyboard: Ctrl+K

Mouse: Right-click memos in the memo list to mark or unmark them.

Created with the Personal Edition of HelpNDoc: Create HTML Help, DOC, PDF and print manuals from 1 single
source

Unmark All Memos Command

The Memos | Memo | Unmark All command unmarks all memos in the current folder. If no memos are marked,
this command is dimmed.

Created with the Personal Edition of HelpNDoc: Free EPub and documentation generator

Extract Memos Command

In Memos view, the Extract Memos command (Memos | Memo | Extract) opens the Extract Memos dialog box,
where you specify memos to copy to a new Memo file. 

Dialog Box Options

What to Extract
Choose All Memos, Marked Memos, Selected Memos, Found Memos, or Memos by Condition.

Select Folders
Select which folders to extract from.

If you choose Memos by Condition, the Extract Criteria dialog box appears after you click OK. Use this dialog
box to specify further conditions of the memos to extract.

Created with the Personal Edition of HelpNDoc: Easy CHM and documentation editor

Import Memo Command

In Memos view, the Import Memo command (Memos | Memo | Import) opens the Import Files dialog box,
where you specify the files to import. You can import text and RTF (Rich Text Format) files into Memos view. 

Dialog Box Options

File Name
Choose the file(s) you want to import into the current folder.
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List Files of Type
Controls the file names that are displayed in the File Name list.

Directories
Displays the current directory. To change to a different directory, double-click it.

Drives
Displays the current drive. To change drives, click the arrow at the right of the box and double-click the drive
you want.

Import File List
Displays the files to be imported into the current folder.

Network button
Click to map a network drive to a drive letter.

Add button
Click the Add button to add the file selected in the File Name list to the Import Files List. 

Delete button
Click the Delete button to remove the selected file from the Import Files List. 

Created with the Personal Edition of HelpNDoc: Benefits of a Help Authoring Tool

Export File Command

In Memos view, the Export Memo Command (Memos | Memo | Export) exports the current memo to a rich text
(RTF) file. The new RTF fileʼs name is the name of the memo, with an RTF extension.

Created with the Personal Edition of HelpNDoc: Create HTML Help, DOC, PDF and print manuals from 1 single
source

Export Memo Command

In Memos view, the Export Memo Command (Memos | Memo | Export) exports the current memo to a rich text
(RTF) file. The new RTF fileʼs name is the name of the memo, with an RTF extension.

Created with the Personal Edition of HelpNDoc: Easily create Web Help sites

Add Folder Command (Memos View)

In Memos view, the Add Folder command (Memos | Folder | Add) opens the Add Memo Folder dialog box,
where you can create a new folder.

Dialog Box Options

Folder Name
Type the name of the new folder. 

Folder List
Lists the folders in the current Memo file. 

Sort Folders Alphabetically
Sorts folder tabs alphabetically. 

Add button
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Adds each new folder to the Memo file. 

Created with the Personal Edition of HelpNDoc: Easily create Help documents

Modify Folder Command

In Memos view, the Modify Folder command (Memos | Folder | Modify) opens the Modify Folder dialog box,
where you can change the name of a folder.

Dialog Box Options

Folder Name
Type the new name of the folder.

Folder List
Lists the folders in the current Memo file.

Sort Folders Alphabetically
Sorts folder tabs alphabetically. 

Modify button
Changes the folder to the new name.

Created with the Personal Edition of HelpNDoc: Create help files for the Qt Help Framework

Delete Folder Command

In Memos view, the Delete Folder command (Memos | Folder | Delete) opens the Delete Folder dialog box,
where you select folders and delete them. This menu option is dimmed if there is only one folder.

Dialog Box Options

Folder List
Lists the folders in the current Memo file. 

Delete button
Deletes the selected folder from the Memo file.

Created with the Personal Edition of HelpNDoc: Full-featured EBook editor

Combine Folders Command

Combine Folders Command
The Memos | Folder | Combine command merges the memos and folders from one Memo file into another. In
the Merge with Memo Files dialog box, open the Memo file you want to add memos to.

For a description of the dialog box options, see File-Handling Options.

Note If the second Memo file has any folder names in common with the open one, new folders are not
added. Instead, their memos are added to the open Memo file's in the folder of the same name.

Created with the Personal Edition of HelpNDoc: Full-featured Help generator

Reorder Tabs Command (Memos View)
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In Memos view, the Reorder Folders command (Memos | File | Reorder Folders) opens the Reorder Folder
Tabs dialog box, where you can change the tab order of the files. By default, folders are shown in the order of
creation.

Shortcuts
Keyboard: F11

Dialog Box Options

Current Folder Order
Lists the folders displayed on the tabs in their current order. 

Up button
Changes the order of folders in the Current Folder Order list. Choose a folder and click Up to move the folder
tab to the left.

Down button
Changes the order of folders in the Current Folder Order list. Choose a folder and click Down to move the
folder tab to the right.

Created with the Personal Edition of HelpNDoc: Full-featured multi-format Help generator

Export File Command

In Memos view, use the Export command (Memos | File | Export) if you want to export multiple memos, or if
you want to export the current memo to one of several formats. You can export the memos to a text file, an
RTF (Rich Text Format) file, or the Clipboard.

Dialog Box Options

Memos to Export
Current Memo exports the current memo.

Found Memos exports memos found using Edit | Find.

Marked Memos exports all marked memos in the current folder. If no memos are marked, this option is
dimmed.

All Memos exports all memos. 

Include Subject
Includes each memoʼs subject in the export file.

Select Folders
Sets the folders to export memos from. You can choose one folder, multiple folders, or all folders.

Export Memos To
Sets the export destination as the Clipboard or a text or rich text file. If you choose Text File or Rich Text File,
the Save As dialog box appears so you can name the file.

Created with the Personal Edition of HelpNDoc: Single source CHM, PDF, DOC and HTML Help creation

Create Template Command

In Memos view, the Create Template command (Memos | Mail Merge | Create Template) opens the Insert Card
Fields dialog box. This dialog box inserts fields from the active cardfile into the current memo.

Dialog Box Options

Field Names
Choose the name of the field to insert into the memo. 

Insert button
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Click the Insert button to insert the field into the memo template. 

Created with the Personal Edition of HelpNDoc: Free HTML Help documentation generator

Mail Merge Cardfile Command

In Memos view, the Memos | Mail Merge | Cardfile command merges the memo template with the active
cardfile and creates new memos. If the current memo has no field placeholders, such as {First Name}, this
command will bring the first ten cardfields of the current card into the body of a new memo, and give the
memo the same subject as the cardʼs index line. If the current memo does have field placeholders, a dialog
box opens.

Dialog Box Options

Merge
Choose which cards (current, selected, marked, or all) to merge. 

Options
Print Merged Result prints the merged memos immediately. 

Enter in Contact Log stamps the subject lines of the new memos to the selected cards' logs. 

Save Merged Memos to Folder saves the new memos in a different folder than the template. Choose the
folder in the Which Folder drop down box. 

Created with the Personal Edition of HelpNDoc: Free Kindle producer

Phone Menu

The Phone menu provides tools for using and managing the Phone Dialer.

For more information, highlight one of the Phone menu choices, and press F1.

Created with the Personal Edition of HelpNDoc: Free HTML Help documentation generator

Phone Dialer

 Related topics

The Phone Dialer dials the phone number displayed in the Number to Dial field, making the connection for
your voice call. Usually the number to dial is the number in the default phone field in the current card. You can
change the number or card, or key in a different number. 

To open the Phone Dialer, do one of the following:

Choose Phone | Dialer.

Click the Call icon  on the Deskpad.

Drag a phone number in the Calendar onto the Call icon.

Press F9.  (Press F9 again to close the Phone Dialer)

Phone Dialer Options

Information Pane
The information pane at the top shows the index line of the current card in the Contacts view, and other
telephone fields for that card. You can click the up-arrow or down-arrow to select a different field. You can
select a different card by clicking it in the Contacts view or Viewport, and its telephone numbers will appear in
the Phone Dialer.
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The bottom line of the information panel shows the current status of your call, such as “Ready to Make Call” or
“Dialing.”

Dial button
Click to dial the selected number. This can be a phone number in the Number to Dial field, or an entry you
select in the Call History pane. When you see the Call Status dialog box, pick up your telephone handset and
click Talk. Sidekick disconnects the modem so you can use the handset.  (Note: You must use the handset
even if you have a voice modem and microphone.)

Redial button
Click to redial the latest number dialed. The redial number appears in the title bar. 

Answer button
Click this button and pick up your telephone handset to answer an incoming call.

Hang Up button
Click to hang up and end the connection. The timer is stopped, and the Call Note information is stamped to
the Contact Log (if the “Automatically Enter Call Information…” option is checked in the Phone Dialer Setup).

Number to Dial
Shows the number to dial. You can choose a different phone number from the information pane or Call
History pane. Or enter a new number using your keyboard or the keypad in the Phone Dialer. You can also
click the index line of a different card in the Contacts view or Viewport while the Phone Dialer is open, and
that card will be used by the Phone Dialer. (If you do not see the Number to Dial and the dialing keypad, click
the Keypad button in the lower left corner of the Phone Dialer.)

Call History
Click the History button in the lower left corner of the Phone Dialer to open the Call History pane.  Each
incoming call is recorded here with three lines of information. Click the scroll arrows if necessary  to see
more call entries (the 40 most recent calls are displayed). Click the Keypad button to close the History pane
and restore the dialing keypad.

Delete button removes the selected call entry from the History window.

Save to Card button saves the selected call entry information in the History window to a cardfile. If no
matching card exists, a new card is created.

Setup button 
Click to set up the dialing properties, line properties, and other settings. Opens the Phone Dialer Setup dialog
box. 

Call Note button
Click Call Note to open a panel for writing notes and timing the call. To close the notes panel, click the Call
Note button again.

Created with the Personal Edition of HelpNDoc: Easy EBook and documentation generator

Setup Default SpeedDial Field Dialog Box

 Related topics

The Phone | Cardfile SpeedDial Field command opens the Setup Default SpeedDial Field dialog box, where
you can specify which field in the current cardfile contains the number you will be using to dial most calls.

Dialog Box Options

Select a Phone Field
Click the field that contains the telephone number, and click OK. That number will be selected and put into the
Number to Dial field when you open the Phone Dialer, although you can always choose another phone field in
the card or the Phone Dialer, or type a number to dial.

Created with the Personal Edition of HelpNDoc: Single source CHM, PDF, DOC and HTML Help creation
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Phone Dialer Setup Dialog Box

 Related topics

The Phone | Setup command opens the Phone Dialer Setup dialog box, where you specify dialing properties
and modem settings.

Dialog Box Options

Dialing Properties
I Am Dialing From: Choose the location you are calling from. 

Ignore “My Locations” Settings:  Check the box to bypass the settings for the current location when
dialing (see Setup button, next).

Setup button: Click to open the Windows 95 Dialing Properties dialog box, where you can change the
dialing information for your location.  Use Setup to create new locations, or to change properties, such as
your area code, and any special numbers you must dial before making a call (such as outside line
numbers, or calling card numbers). If you travel with a portable computer, you can create dialing locations
for different places you travel to.

Toll Prefixes button: Click to open the Toll Prefixes dialog box. Here you can specify local phone
exchanges that must be prefixed with 1+Area Code.

Modem Properties
Current Modem: Select the current modem from the drop-down list. 

Setup button: Click Setup to open the Windows 95 Modem Properties dialog box, where you can specify
settings such as communications port, modem speed, and other options.

Phone Dialer Properties
Dial Using the Handset Instead of the Modem: Check this box if you want to dial calls manually using
your telephone.

Automatically Enter Call Information into Contact Log at the End of Call: Check if you want Sidekick
to automatically record an entry in the Contact Log of the current card when you complete the call.

Phone Dialer Options
Monitor Current Modem for Incoming Calls:  Click Yes if you want Sidekick to monitor for incoming calls
and open the Phone Dialer automatically when an incoming call arrives.

Enable Caller Lookup in All Open Cardfiles: Check to enable Caller ID for incoming calls. Sidekick
checks the number of the incoming call to see if it is in an open cardfile. If it is, the card is displayed.

Created with the Personal Edition of HelpNDoc: Write EPub books for the iPad

Call Note

 Related topics

The Call Note panel in the Phone Dialer opens or closes when you click the Call Note button. 

Call Note
Type notes about the call. When you click the Save to Current Contact Log button (see below), this
information is saved in the Contact Log of the current card. You can select a different card before saving.

Start button
Click Start to start or stop the timer.

Reset button
To reset the timer, click the Reset button.

Save to Current Contact Log button
Click to stamp the word CALLED in the Contact Log of the card you have called, plus the start time and call
duration (from the Timer), and Call Notes.
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Created with the Personal Edition of HelpNDoc: Generate Kindle eBooks with ease

Reports Menu

In Calendar and Contacts views, the Reports menu lets you create, open, or return to a report on other
Sidekick views. 

For more information, highlight one of the Reports menu choices, and press F1.

Created with the Personal Edition of HelpNDoc: Free help authoring tool

Layout Menu

In Report view, the Layout menu lets you modify the style and formatting of your report.

For more information, highlight one of the Layout menu choices, and press F1.

Created with the Personal Edition of HelpNDoc: Free HTML Help documentation generator

Card Report Dialog Box

The Reports | Cardfile command opens the Card Report dialog box, where you can create a cardfile report.

Dialog Box Options

Report On
All Cards reports on the entire cardfile.

Index Range reports on only those cards that fall within an alphanumeric index range. Enter the range
limits in the From and To boxes.

Marked Cards reports on only those cards marked with a red triangle on their index lines.

Selected Cards reports on only selected cards.

Cardfile Fields
Selects the cardfile fields to include in the report by moving them from the Cardfile Fields list to the Report
Columns list using the >> or All --> buttons. Move individual fields out of the Report Columns list using the <<
button, or move all fields out using the <-- All button.

Created with the Personal Edition of HelpNDoc: Single source CHM, PDF, DOC and HTML Help creation

Calendar Report Dialog Box

The Reports | Calendar command opens the Calendar Report dialog box, where you can create a calendar
report. 

Dialog Box Options

From/To
Sets the date range in the calendar to include in the report. One day is the minimum range.

Text to Find
Type text here to limit your report to items related to a specific person or key word.

Report On
Sets the type of activities from the calendar to include in the report: appointments, calls, To Do items, goals,
special days, and multi-day events.
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Completed Items Only
Includes only completed activities in the report.

Notes
Includes any Notes text attached to activities in the report.

Options button
Adjusts the level of detail for your report. Options become available as the selections are made in the Report
On group. 

Details 
Sets further levels of details about appointments, calls, To Do items, and goals.

Include All Details
Selects all of the available options at once instead of selecting each option individually.

Created with the Personal Edition of HelpNDoc: Generate Kindle eBooks with ease

Free Time Report Dialog Box

The Reports | Free Time command opens the Free Time Report dialog box, where you can create a report on
the times when you have no scheduled appointments.

Dialog Box Options

Date Range
Sets the date range in the Appointment list to report on. One day is the minimum setting.

Time Range
Sets the time range for each day to include in the report. One hour is the minimum setting.

Time Increments
Sets the level of detail for the report, displaying either 15 minute, half hour, or hour increments.

Created with the Personal Edition of HelpNDoc: Easily create PDF Help documents

To Do Items Report Dialog Box

The Reports | To Do Items command opens the To Do Items Report dialog box, where you can create a report
based on goals and To Dos.

Dialog Box Options

From/To
Sets the date range in the calendar to include in the report. One day is the minimum range.

Report On
Sets which tasks to include in the report: To Dos and/or goals.

Report on All
Includes all To Dos or goals in the report, regardless of their properties, due dates, or entry dates.

Text to Find
Type text here to limit your report to items related to a specific keyword.

With Due Date Between
Includes only those tasks with due dates within a specified date range.

Enter Date Between
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Includes only those tasks with enter dates within a specified date range. 

Category
Selects the task categories to include in the report. Check All Categories to include all categories listed.

Assign
Selects the assigned people to include in the report. Check All Assigns to include all assigned names listed.

Priorities
Selects the priority levels to include in the report. Check No Priorities to include tasks that are not assigned a
priority. Check All Priorities to include all priorities listed.

Include
Time Used includes a record of the accumulated time on the timer for each task in the report.

Completed only includes only completed tasks in the report.

Notes includes the Notes text attached to each task in the report.

Created with the Personal Edition of HelpNDoc: Create help files for the Qt Help Framework

Contact Log Report Dialog Box

The Reports | Contact Log command opens the Contact Log Report dialog box, where you can create a
Contact Log report.

Dialog Box Options

From/To
Sets the date range to report on. A minimum of one day must be designated.

Categories
Sets the type of logged entries to include in the report: Call, Document, Answer, or Appointment.

Report On
All Cards reports on the entire cardfile.

Marked Cards reports on only those cards marked with a red triangle on their index lines.

Selected Cards reports on only the selected cards (chosen by clicking, Shift+clicking, or Ctrl+clicking).

Index Range reports on only those cards that fall within an alphanumeric index range. Enter the range
limits in the From and To boxes.

Cardfile Fields
Selects the cardfile fields to include in the report by moving them from the Cardfile Fields list to the Report
Columns list using the >> or  All --> buttons. Move individual fields out of the Report Columns list using the <<
button, or move all fields out at once using the <-- All button.

Created with the Personal Edition of HelpNDoc: Easily create Web Help sites

Open Report Command

The Reports | Open Report command opens a report that was saved using File | Save Report. Choose the
report you want from the Open dialog box (for information about the dialog box options, see File-Handling
Options).

Created with the Personal Edition of HelpNDoc: Full-featured Kindle eBooks generator
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Go to Current Report Command

Go to Current Report Command
The Reports | Go to Current Report command switches to the current report in the Report view. 

Created with the Personal Edition of HelpNDoc: Create help files for the Qt Help Framework

Choose Report Style Command

In Report view, the Layout | Choose Report Style command copies the formatting from a report template to the
current report. For information about the dialog box options, see File-Handling Options.

Created with the Personal Edition of HelpNDoc: Free help authoring environment

Save Report Style Command

In Report view, the Layout | Save Report Style command saves the current font settings and headers as a
template. For information about the dialog box options, see File-Handling Options.

Created with the Personal Edition of HelpNDoc: Easily create Help documents

Update Report Command

In Report view, the Layout | Update Report command updates the data in the current report. It opens the same
dialog box as the one you used to create the current report, with all the same options as you selected before.
You can change the options if you want.

Created with the Personal Edition of HelpNDoc: News and information about help authoring tools and software

Font Command (Report View)

The Layout | Font command sets the fonts used in the report. For information about the dialog box options,
see Font Dialog Box.

Shortcuts
Keyboard: Ctrl+Shift+F

Mouse: Right-click

Created with the Personal Edition of HelpNDoc: Easily create Web Help sites

Report Title Dialog Box

When viewing a report, you can use the Layout | Header command to add a title and subtitles to the report
header in the Report Title dialog box.

Dialog Box Options

Report Title
Type a title for the report.
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Subtitles
Type subtitles for the report. Subtitles can contain up to three lines of text.

Note Sidekick prints reports with a footer indicating the page number and the placement of each page in a
multi-page array (if necessary) in (row, column) format. For example, if three pages in a report are to
be viewed side by side, to see all the fields (columns) for each record (row), the footers for the last
page will read “Page 3 (1,3)”.

Created with the Personal Edition of HelpNDoc: Easily create iPhone documentation

Change Column Width Command

When viewing a report, you can use the Layout | Change Column Width command to set column widths for a
report in the Change Column Width dialog box.

Dialog Box Options

Column
Sets the column you want to resize.

Width
Sets the width for the selected column in the Column list.

Choice
Fitted Width changes the width of each column to the length of its longest entry.

Fixed Width changes the width of all columns to the setting in the Width box.

Assign Width changes the width of the selected column to the setting in the Width box.

Wrap Text
When checked, wraps information in report cells to multiple lines.

Change button
Saves the requested changes to the specified column.

Created with the Personal Edition of HelpNDoc: Create cross-platform Qt Help files

Hide Row Title Command

In Report view, the Layout | Hide Row Title command hides row titles. If the title is already hidden, choosing
this command displays it again.

Created with the Personal Edition of HelpNDoc: Easily create PDF Help documents

Hide Column Title Command

In Report view, the Layout | Hide Column Title command hides column titles. If the title is already hidden,
choosing this command displays it again.

Created with the Personal Edition of HelpNDoc: Generate Kindle eBooks with ease

Tools Menu

The Tools menu contains a number of convenient utilities and options for working with Sidekick. Different
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commands are available from different views.

For more information, highlight one of the Tools menu options, and press F1.

Created with the Personal Edition of HelpNDoc: Write EPub books for the iPad

Tools Menu (Contacts View)

The Tools menu contains a number of convenient utilities and options for working with Sidekick. 

For more information, highlight one of the Tools menu options, and press F1.

Created with the Personal Edition of HelpNDoc: Free PDF documentation generator

Tools Menu (Calendar View)

The Tools menu contains a number of convenient utilities and options for working with Sidekick. 

For more information, highlight one of the Tools menu options, and press F1.

Created with the Personal Edition of HelpNDoc: Easily create Help documents

Tools Menu (Memos View)

The Tools menu contains a number of convenient utilities and options for working with Sidekick. 

For more information, highlight one of the Tools menu options, and press F1.

Created with the Personal Edition of HelpNDoc: Full-featured multi-format Help generator

Tools Menu (Expense View)

The Tools menu contains a number of convenient utilities and options for working with Sidekick. 

For more information, highlight one of the Tools menu options, and press F1.

Created with the Personal Edition of HelpNDoc: Free Web Help generator

Tools Menu (Activities View)

The Tools menu contains a number of convenient utilities and options for working with Sidekick. 

For more information, highlight one of the Tools menu options, and press F1.

Created with the Personal Edition of HelpNDoc: Free PDF documentation generator

Tools Menu (Report View)

The Tools menu contains a number of convenient utilities and options for working with Sidekick. 

For more information, highlight one of the Tools menu options, and press F1.
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Created with the Personal Edition of HelpNDoc: Full-featured Documentation generator

Extract Cards Command

The Tools | Extract Cards menu contains options for extracting cardfile data to a new cardfile.

For more information, highlight one of the Extract menu options, and press F1.

Created with the Personal Edition of HelpNDoc: Easily create EPub books

Contact Manager Command

The Contact Manager command (Tools | Contact Manager) searches your calendar and cardfile for calls,
appointments, To Dos, and Contact Log entries relating to a specific card (or contact). Use this command to
quickly review past and future activities with a contact, and schedule new activities.

Dialog Box Options

Activities For
Specifies the text searched for in the Calendar and Contacts views. (By default, this text is the index line of
the current card.)

Date Range
Sets the date range to search. Choose from: Today, Tomorrow, This Week, Next Week, This Month, Next
Month, or Pick A Date Range. If you select the Pick A Date Range option, the Select Date Range dialog box
appears, prompting you to specify the dates. You can then choose After, Before, or Between specific dates.

The default date range is set to Pick A Date Range, with the range being one month: from two weeks previous
to today to two weeks after.

Activities List
Shows all activities found after you choose Search. This can include appointments, To Dos, calls, goals, multi-
day events, and special days, as well as Contact Log entries, including [Notes Text], [Called], and [Calendar].
The activities are listed in this format: Date, Type, Text, such as "7/26   To Do   Send thank-you note to Ed."

Search Setup button
Opens the Search Setup dialog box, which lets you specify which types of activities to search in.

Refresh button
Performs another search based on the current settings.

Schedule New button
Opens the Schedule New Activity dialog box, which lets you create new appointments, calls, or To Dos.

Go To button
Takes you to the exact location of the selected call, appointment, or To Do in the Activities List. If a file name
entered in the Contact Log is selected, Go To opens the file in its respective application.

Created with the Personal Edition of HelpNDoc: Write eBooks for the Kindle

Quick Letter Command

The Quick Letter command (Tools | Quick Letter) opens the Create a Letter dialog box, where you can create
a letter using data on the current card.

In the Create a Letter dialog box, choose the desired memo template, and click OK. A mail merge function is
performed on the selected template using the current card. 
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The fields in the pre-defined templates are based on the fields from the Business and Personal cardfile
templates. If there are fields in the selected template that donʼt exist in your active cardfile, the fields are not
replaced with cardfile data. Instead, the field names enclosed in brackets remain in the letter.

If you uncheck the box labeled “Show this dialog when clicking Quick Letter Button,” you can still see the
dialog box by choosing Tools | Quick Letter.

Shortcuts

Toolbar:

Created with the Personal Edition of HelpNDoc: Easily create CHM Help documents

Synchronize Command

The Synchronize menu contains commands for using Starfish TrueSync and the Internet Time Synchronizer.

TrueSync

About Internet Time Synchronizer.

Created with the Personal Edition of HelpNDoc: Full-featured Help generator

Conversions Command

 Example

The Conversions command (Tools | Conversions) opens the Conversions dialog box, where you can convert
between English and metric measurement, or between numerous other units of standard or scientific
measurement.

Dialog Box Options

Categories
Specify the category of units you want to convert, such as length, area, capacitance, weight, mass,
luminance, or other category.

From
In the Value box, type the number you want to convert. 

Specify the Unit you are converting from by selecting it from the drop-down list. 

To
In the Unit box, specify the unit you are converting to. 

Read the converted quantity in the Value box.

Precision
You can set the number of significant digits in the Precision box. Type a number between 4 and 12, or use the
spin control arrows to change the number. 

Created with the Personal Edition of HelpNDoc: Benefits of a Help Authoring Tool

To convert 75 square kilometers to acres, 

1. Choose Area as the Category.

2. Type 75 in the Value box.

3. Select square kilometers as the From unit.

4. Select acres as the To unit.

5. Read the answer: 75 square kilometers = 18532.8 acres. This result has a precision of 6 significant digits.
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Created with the Personal Edition of HelpNDoc: Generate EPub eBooks with ease

Calculator Command

The Tools | Calculator command shows the Sidekick Calculator.

Shortcuts

Toolbar:

Options

Off
Closes the Calculator.

Up/Down Arrows
Scrolls through the Calculator tape containing results from the current calculations.

Reset
Resets the Calculator completely, clearing the tape and all function keys.

F1, F2, F3
Customizable function keys for special calculator operations.

Created with the Personal Edition of HelpNDoc: Easily create PDF Help documents

Setup Command

 Related topics

The Tools | Setup menu has options for using the Setup Wizard and for customizing the Toolbar.

Wizard

Toolbar

Created with the Personal Edition of HelpNDoc: Single source CHM, PDF, DOC and HTML Help creation

Toolbar Command

The Toolbar command (Tools | Setup | Toolbar) opens the Customize Toolbar dialog box, which lets you
choose the buttons that appear in the Toolbar for the active view.

Dialog Box Options

Available Buttons
Displays the available buttons. Select the button you want to add to the Toolbar.

Toolbar Buttons
Displays the currently selected buttons in the order in which they appear on the Toolbar. Select any button
you want to remove from the Toolbar.

Add button
Adds the selected available button before the button highlighted in the Toolbar Buttons list. You can also
double-click an available button to add it to the Toolbar Buttons list.

Remove button
Removes the selected button from the Toolbar Buttons list.

Move Up
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Moves the selected button in the Toolbar Buttons list up one slot.

Move Down
Moves the selected button in the Toolbar Buttons list down one slot.

Reset
Reinstates the default Toolbar.

Tip You can drag and drop to move buttons in the list.

Created with the Personal Edition of HelpNDoc: Easy CHM and documentation editor

Preferences Command

The Tools | Preferences menu has options for customizing Sidekick.

General

Calendar

Memos

Expense

Group Scheduling

Web Publisher

Created with the Personal Edition of HelpNDoc: News and information about help authoring tools and software

General Preferences Command

Use the General Preferences command (Tools | Preferences | General, or Tools | General Preferences in
Report and EarthTime views) to set up the overall program defaults in the General Preferences dialog box.

Dialog Box Options

Location of Icons
Right Side displays icons on the right side of the Deskpad. 

Left Side displays icons on the left side of the Deskpad. 

Hide Icons hides the icons. 

Deskpad Colors button
Click to setup colors for Sidekick's views. 

Default View
Sets the default view at startup. Choose between Calendar (Daily view), Weekly View, Monthly View, Yearly
View, EarthTime, Contacts, Memos, Expense, or Activities. This option is dimmed if the Remember Last Active
Deskpad View box is checked.

Remember Last Active View
When this box is checked, Sidekick opens at the view you last used in your previous session. (However, the
Expense view always opens on the Receipt view, even if you were viewing an expense report when you
exited.) When this box is unchecked, you can select the default view from the Default Deskpad View list.

Options
Password at Start-Up asks for a password when you start Sidekick.

Start Maximized starts Sidekick in a maximized window.

Digital Clock, when checked, gives the EarthTime Deskpad icon clock a digital display. If Digital Clock is
not checked, the EarthTime icon clock has an analog display.

Prompt for Save on Exit prompts you to save files when you exit.

Show Animation uses an animated effect each time you select a card or memo.
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Choose Key to Move between Fields in Card Entry
Choose the Tab key or the Enter key to move from field to field in the Add Card dialog box.

Password button
Click to set a Sidekick password. 

Fonts button
Click to change the display font for the Contacts and Memos views. 

Default Working Directory
Shows the default directory where Sidekick will look for or store files. You can type a different path, or click
the Browse button, to change the default directory.

Created with the Personal Edition of HelpNDoc: Free iPhone documentation generator

Calendar Preferences Command

 Related topics

The Calendar Preferences command (Tools | Preferences | Calendar) lets you set your preferred
configuration for the Calendar views. For more information, click a topic in the following list:

Daily Page

Weekly Page

Monthly Page

Yearly Page

Created with the Personal Edition of HelpNDoc: News and information about help authoring tools and software

Daily Page (Calendar Preferences)

 Related topics

Use the Daily page of the Calendar Preferences dialog box to set options for the Daily Calendar. The
Calendar Preferences command (Tools | Preferences | Calendar) opens this dialog box.

Dialog Box Options

Time
From/To sets the beginning and ending time for the Events schedule.

Increment sets the time intervals to show on the Events schedule; select 15, 30, or 60 minutes.

Forward Incomplete Items
Check or uncheck any of the following items to reschedule overdue items to the next day if they remain
uncompleted: calls, To Dos, and (overdue) goals.

Auto Forward from X Days Back sets the number of days back that Sidekick checks when searching for
incomplete items to forward to today.

Alarm Snoozes For
Sets the "snooze" duration for alarms. If you click the Snooze button on an alarm message, Sidekick will wait
this duration before displaying another alarm message.

Display Appointment Starting and Ending Time
Determines whether the appointments in the Events list display their starting and ending times. 

Work Space
Choose what you want to see in the four quadrants of the work space. The Viewport is always displayed in the
Bottom Right quadrant.
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Weekly Page (Calendar Preferences)

 Related topics

Use the Weekly page of the Calendar Preferences dialog box to set options for the Weekly view of the
Calendar. The Calendar Preferences command (Tools | Preferences | Calendar) opens this dialog box.

Dialog Box Options

View
Check all entries you want to display in the view: Multi-Day Events, Special Days, Appointments, Calls, and To
Dos.

Option
Check or uncheck the following options:

Summary displays items in summary. For example, if you have four appointments scheduled, the
Summary displays "4 Appointments." Notes, icons, and durations do not display.

Detail displays calendar items in full detail.

Completed Items displays completed items.

Wrap Text wraps text of long entries to new line; otherwise, long lines are truncated. 

Notes displays the description from the Notes field for all activities.

Appts. w/Duration displays the starting and ending times of appointments.

Leading Icon displays the activity icons next to the appointments, To Dos, and calls.

Week of Year displays the week of year.

Fonts button
Opens the Change Display Font dialog box.
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Monthly Page (Calendar Preferences)

 Related topics

Use the Monthly page of the Calendar Preferences dialog box to set options for the Monthly view of the
Calendar. The Calendar Preferences command (Tools | Preferences | Calendar) opens this dialog box.

Dialog Box Options

View
Check all entries you want to display in the view: Multi-Day Events, Special Days, Appointments, Calls, and To
Dos.

Option
Check or uncheck the following options:

Summary displays items in summary. For example, if you have four appointments scheduled, the
Summary displays "4 Appointments." Notes, icons, and durations do not display.

Detail displays calendar items in full detail.

Completed Items displays completed items.

Wrap Text wraps text of long entries to new line; otherwise, long lines are truncated. 

Notes displays the description from the Notes field for all activities.

Appts. w/Duration displays the starting and ending times of appointments.

Leading Icon displays the activity icons next to the appointments, To Dos, and calls.

Day of Year displays the day of the year on each day.

1st Day of the Week sets the first day of the week to display.
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Fonts button
Opens the Change Display Font dialog box.

Created with the Personal Edition of HelpNDoc: Free help authoring tool

Yearly Page (Calendar Preferences)

 Related topics

Use the Yearly page of the Calendar Preferences dialog box to set options for the Yearly view of the Calendar.
The Calendar Preferences command (Tools | Preferences | Calendar) opens this dialog box.

Dialog Box Options

Yearly Planner
Shows the entire year in a planner format with each column representing a different day of the week and
each row representing a month.

Horizontal Yearly View
Shows the yearly calendar in a 4x3 grid format. The months are shown in order horizontally from left to right
for each row.

Vertical Yearly View
Shows the yearly calendar in a 4x3 grid format. The months are shown in order vertically from top to bottom
for each row.

Created with the Personal Edition of HelpNDoc: Easy to use tool to create HTML Help files and Help web sites

Memo Preferences Command

Use the Memo Preferences command (Tools | Preferences | Memos) to set options for the Memos view in the
Memos Preferences dialog box.

Dialog Box Options

Default Font for Subject
Select the default font and size that appears in the subject of the memo.

Default Font for Memo Text
Select the default font and size used for the memo text.

Auto Spell Check
Check to have automatic spelling check turned on by default.

Created with the Personal Edition of HelpNDoc: Full-featured Documentation generator

Expense Preferences Command

 Related topics

Use the Expense Preferences command (Tools | Preferences | Expenses) to open the Expense Preferences
dialog box. You can change your expense report defaults, such as mileage rate and currency, and you can
add your own custom expense types.

Shortcut

Toolbar:

Note Changes you make in Expense preferences affect only new receipts you create after changing the
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preferences.

For more information, see:

Defaults

Currency

Expense Type

Pick List

Created with the Personal Edition of HelpNDoc: Easily create Help documents

Defaults Page (Expense Preferences)

 Related topics

Use the Defaults page of the Expense Preferences dialog box to set defaults for Expense View. The Expense
Preferences command (Tools | Preferences | Expenses) opens this dialog box.

Dialog Box Options

Home Currency
Select your home currency from the drop-down list.

Mileage Rate
Enter the mileage reimbursement rate. When you enter a mileage receipt, this rate will be multiplied by the
number of miles you enter to calculate the amount.

1st Day of the Week in the Report
Choose the first day of the week for expense reports from the drop-down list.

My Preferred Country Setting
Check the one that applies to your location. The tax designations are VAT (Value Added Tax), GST (Goods
and Services Tax) and PST (Provincial Sales Tax).

U.S.A. and other countries (without VAT/GST/PST)

European Countries (with VAT)

Canada (with GST/PST)

Show Currency in the Receipt
Check the box if you want the Currency field displayed in the receipt. If you enter receipts in only one
currency, you can uncheck the box to hide the Currency field. 

Created with the Personal Edition of HelpNDoc: Qt Help documentation made easy

Currency Page (Expense Preferences)

 Related topics

Use the Currency page of the Expense Preferences dialog box to specify the current exchange rate for the
currency you specified on the Defaults page. The Expense Preferences command (Tools | Preferences |
Expenses) opens this dialog box.

Dialog Box Options

Currency Exchange Rate

One ___ 
Select the basic currency you use, typically $.

= ___   ___
Type an exchange rate value in the first field, and select the currency in the second field. For example, if you
are from the U.S. and travel to France, you would enter (using the whatever is then current exchange rate ): 
one $ = 5.0352 FF.
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Modify button
If you change the exchange rate value, click the Modify button to save the change.

Created with the Personal Edition of HelpNDoc: Create help files for the Qt Help Framework

Expense Type Page (Expense Preferences)

 Related topics

Use the Expense Type page of the Expense Preferences dialog box to set up custom expense types (for
example, Office Supplies or Education). The Expense Preferences command (Tools | Preferences |
Expenses) opens this dialog box.

Dialog Box Options

Custom Expense Type
Type the name of a new expense type you want to create.

Based On
Select an existing type that the new type is to be based on.

Add to the Category
Select the category you want the new type to belong to.

Add to Expense Report
Check if you want the new type added to your expense report. 

Add button
Click to add the custom expense type to the list.

Delete button
Click an expense type and click the Delete button to remove it from the list.

Created with the Personal Edition of HelpNDoc: iPhone web sites made easy

Pick List Page (Expense Preferences)

 Related topics

Use the Pick List page of the Expense Preferences dialog box to add or delete pick list items for fields on
expense receipts. The Expense Preferences command (Tools | Preferences | Expenses) opens this dialog
box.

The pick list items consist of entries you have typed as you enter expense receipts. For example, once you
type a name in the City field of a receipt, it automatically appears in the drop-down list for the City field on all
receipts. On the Pick List page, you can add more items to as many fields as you like.

Dialog Box Options

Select a Field
Click a field. Its current pick list items appear under Pick List items. 

Pick List Items
Type a new item for the Field in the top text box.

Add Item button
After typing a new item, click Add Item to add it to the selected field.

Delete Item button
Click a Pick List item, and click Delete Item to remove it.
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Group Scheduling Preferences Command

Use the Group Scheduling Preferences command (Tools | Preferences | Group Scheduling) to open the
Group Scheduling Preferences dialog box, where you set options that control Internet group scheduling and
e-mail messaging on your computer.

The Scheduling Page is covered below. For information on the other pages, click an option:

Electronic Mail

Signature

Scheduling Page Options

Flash Sessions
Activate Flash Sessions turns on or off automatic sessions to send and receive group scheduling
messages. These messages include invitations for events you create, reply messages, and Sidekick-
generated messages for any resources you manage.

Every sets the interval. Specify how often you want your system to check for incoming schedule messages
and send your outgoing ones.

On the Following Days
Check all days of the week that you want automatic message sending and receiving.

Delete Entries from Activities View ___ days after completion
Determines how long events that have passed stay in your Activities list before being automatically deleted. 
Uncheck the box if you do not want automatic deletion of completed events.
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Electronic Mail Page (Group Scheduling Preferences)

The Electronic Mail page of the Group Scheduling Preferences dialog box (Tools | Preferences | Group
Scheduling) contains messaging options.

Dialog Box Options

Transports to Use
Click the service you use for messaging.

Microsoft Exchange
Select this option if you are using Microsoft Exchange mail. Click the Exchange button to set up account
information. 

Internet 
Select this option if you are using Internet mail. Click the Internet button to set up account information. 

None
Select this option if you do not have e-mail, or if you do not want to enable Internet group scheduling. If you
select multiple participants for an event, you will have to use the phone or fax options for notifying them. 

Delete Internet Scheduling Messages After Retrieving Them 
Check the box if you want Sidekick messages in the Inbox or POP3 server to be deleted automatically after
retrieving them.

Would you like Sidekick 98 to send and receive Microsoft Schedule+ compatible messages? If you
click Yes, the following option is not available. 

Authenticate Incoming Scheduling Messages
Check this option to have incoming group scheduling messages or replies automatically tested for
authenticity. If a non-Sidekick user is replying manually and makes changes in the “do not modify” section of
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the message, for example, the reply will fail authentication.  Note: when this option is checked, any message
that fails the authenticity test is discarded.
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Signature Page (Group Scheduling Preferences)

The Signature page of the Group Scheduling Preferences dialog box (Tools | Preferences | Group
Scheduling) lets you define a signature for your messages. The text of the signature appears at the end your
replies and other Internet scheduling messages.

Under Your Personal Signature, type the signature you want at the end of your messages. For example, you
might include your real name, company name, phone and fax information.  It initially contains information you
entered in the Setup wizard. 

Note You should limit your signature to a few brief lines, to ensure efficient messages.

Created with the Personal Edition of HelpNDoc: Produce electronic books easily

Exchange Settings Dialog Box

Use this dialog box to enter Microsoft Exchange settings for Internet e-mail addressing.  (To open this dialog
box, choose Tools | Preferences | Group Scheduling. In the Electronic Mail page of the dialog box, choose
Microsoft Exchange, and click the Exchange button.)

In the upper panel, click each Exchange service you want to be able to use for group event messaging. 

In the lower panel, enter your Internet Address. If you use Exchange and send group scheduling messages to
non-Exchange users via the Internet, this address is used for their replies.

Created with the Personal Edition of HelpNDoc: Free CHM Help documentation generator

Web Publisher Preferences Command

Use the Web Publisher Preferences command (Tools | Preferences | Web Publisher) to set up Web
Publisher defaults. For more information, click the Help button from the Web Publishing Preferences dialog
box.

Created with the Personal Edition of HelpNDoc: Free iPhone documentation generator

Merge Cardfile Command

In the Contacts view, the Tools | Merge Cardfile command lets you merge the fields and data from one cardfile
into the open cardfile. In the Merge Cardfile dialog box, open the cardfile you want to add cards from.

For a description of the dialog box options, see File-Handling Options.

When you click OK, the Remove Duplicated Cards dialog box appears, where you choose how to handle
cards that have the same index line.

Note There is no Undo option for merges. When you merge cardfiles, the cardfile you add data to changes
to accommodate the new data and fields. To keep a copy of the original cardfile, save the merged
cardfile to a new name.

Created with the Personal Edition of HelpNDoc: Free Web Help generator
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Extract Cards on Text Command

The Extract Cards on Text command (Tools | Extract Cards | On Text) opens the Extract on Text dialog box,
where you can specify text to search for in the cardfile, as well as what part of the cardfile to search. It then
copies the matching cards to a new, untitled cardfile.

Dialog Box Options

Text to Find
Type the text you want to find in the cardfile.

Extract From
Select the areas of the cardfile you want to search. Choose from Index, Contact Log, Selected Cards, Cards,
or Marked Cards. If there are no marked or selected cards in the cardfile, the Marked Cards and Selected
Cards options are unavailable.

Created with the Personal Edition of HelpNDoc: Easy to use tool to create HTML Help files and Help web sites

Extract Cards on Index Range Command

The Extract Cards on Index Range command (Tools | Extract Cards | On Index Range) opens the Extract
Cards on Index Range dialog box, where you can enter the index lines of the first and last cards of a range
that you want to copy to a new cardfile.

Dialog Box Options

From
Type the index line information for the first card of the range of cards you want to add to a new cardfile.

To
Type the index line information for the last card of the range of cards you want to add to a new cardfile.

Created with the Personal Edition of HelpNDoc: Easy EPub and documentation editor

Extract Cards on Condition Command

The Tools | Extract Cards | On Condition command searches the active cardfile for data meeting a specific
condition. Once matching data has been found, a copy of the card is added to a new cardfile.

For a description of the dialog box options, see Extract Cards on Condition Dialog Box.
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Spelling Command

The Spelling command in Memos view (Tools | Spelling) begins the spelling check, and opens the Spelling
dialog box if a word is not found in the dictionary.  You can select text before using the Spelling command, to
check only the text you have selected.

Tip To check a single word, right-click with the pointer on the word. If the Spelling Checker does not
recognize the word, the shortcut menu will have suggested replacements.

Shortcut

Toolbar:

Dialog Box Options
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Not in Dictionary
Displays the word that may be misspelled.

Change To
Displays the correction that Sidekick suggests.

Change button
Inserts the suggested replacement.

Change All button
Replaces all instances of the found word with the replacement.

Ignore button
Ignores the found word, and continues.

Ignore All button
Ignores all instances of the found word.

Add to User Dictionary
Adds the found word to your user dictionary.

Undo Last Change
Reverses the last replacement.
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Auto Spell Check Command

The Tools | Auto Spell Check command in Memos view turns on and off the automatic spelling checker.  

After turning on Auto Spell Check, text you type is continuously checked for spelling errors. Words not in the
dictionary are marked with Strikeout as possible misspellings. Right-click a misspelling to see proposed
corrections.

When you print, you can uncheck Print Misspelled Words in Strikeout Font Style in the Print dialog box if you
want words in Strikeout to print in normal style.

Note To avoid conflicts with marked misspellings, you should avoid using strikeout in your text when you use
Auto Spell Check.

Created with the Personal Edition of HelpNDoc: Full-featured Kindle eBooks generator

Word Count Command

The Word Count command (Tools | Word Count) displays several useful statistics about the current memo:
Pages, Words, Characters, Paragraphs, and Lines.

Created with the Personal Edition of HelpNDoc: Easily create Qt Help files

View Menu

The View menu lets you switch to a different Sidekick view and control the display.

For more information, highlight one of the View menu options, and press F1.
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View Menu (Contacts View)

The View menu lets you switch to a different Sidekick view and control the display.

For more information, highlight one of the View menu options, and press F1.
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View Menu (Calendar View)

The View menu lets you switch to a different Sidekick view and control the display.

For more information, highlight one of the View menu options, and press F1.
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View Menu (Memos View)

The View menu lets you switch to a different Sidekick view and control the display.

For more information, highlight one of the View menu options, and press F1.
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View Menu (Expenses View)

The View menu lets you switch to a different Sidekick view and control the display.

For more information, highlight one of the View menu options, and press F1.
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View Menu (EarthTime View)

The View menu lets you switch to a different Sidekick view and control the display.

For more information, highlight one of the View menu options, and press F1.

Created with the Personal Edition of HelpNDoc: Easily create PDF Help documents

View Menu (Report View)

The View menu lets you switch to a different Sidekick view and control the display.

For more information, highlight one of the View menu options, and press F1.

Created with the Personal Edition of HelpNDoc: Easy EBook and documentation generator
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View Menu (Activities View)

The View menu lets you switch to a different Sidekick view and control the display.

For more information, highlight one of the View menu options, and press F1.

Created with the Personal Edition of HelpNDoc: News and information about help authoring tools and software

Calendar Command

The View | Calendar command switches to the Calendar.

Shortcuts
Keyboard: F6

Deskpad Icon:
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EarthTime Command

The View | EarthTime command switches to EarthTime.

Shortcuts
Deskpad Icon:
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Contacts Command

The View | Contacts command switches to the Contacts view.

Shortcuts
Keyboard: F5

Deskpad Icon:
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Memos Command

The View | Memos command switches to Memos view.

Shortcuts
Keyboard: F7

Deskpad Icon:
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Expenses Command

The View | Expenses command switches to the Expenses view.

Shortcuts
Keyboard: F8

Deskpad Icon:
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Activities Command

The View | Activities command switches to the Activities view.

Shortcuts
Deskpad Icon:
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Daily View Command

In Calendar view, the View | Daily View command switches to the Daily Calendar view.
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Weekly View Command

In Calendar view, the View | Weekly View command switches to the Weekly Calendar view.
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Monthly View Command

In Calendar view, the View | Monthly View command switches to the Monthly Calendar view.
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Yearly View Command

In Calendar view, the View | Yearly View command switches to the Yearly Calendar view.

Created with the Personal Edition of HelpNDoc: Generate EPub eBooks with ease

Toolbar Command
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The View | Toolbar command toggles the Toolbar on and off for the current view. 

Note In the Calendar, the Toolbarʼs on/off state is saved with the calendar file, so opening a different
calendar can cause the Toolbar to be displayed or hidden.

Created with the Personal Edition of HelpNDoc: Create HTML Help, DOC, PDF and print manuals from 1 single
source

Status Bar Command

The View | Status Bar command toggles the Status Bar on and off. 
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Index View Command

The View | Index View command in the Contacts view displays the current card in Index view, which includes
the Card list (index). 

Shortcuts
Keyboard: Ctrl+E
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Card View Command

The View | Card View command in the Contacts view displays the current card using the whole screen as
editing space. 

Shortcuts
Keyboard: Ctrl+E
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Memo View Command

The View | Memo View command in Memos view displays the current memo full-screen, with the index
hidden. 

Shortcuts
Keyboard: Ctrl+E

Created with the Personal Edition of HelpNDoc: Free help authoring environment

Folder View Command

The View | Index View command in Memos view displays the current memo in Index view, which includes the
memo list (index).

Shortcuts
Keyboard: Ctrl+E
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Created with the Personal Edition of HelpNDoc: Free Qt Help documentation generator

Ruler Command

In Memos view, the View | Ruler command toggles the ruler on and off. Use the ruler to change margins and
set tabs. 

Note Any changes you make to the ruler affect only the selected lines. 

To change a margin, drag the lower arrow at either end. The arrowʼs position marks the margin for the
selected line.

To change the indent of the first line of a paragraph, move the upper arrow on the left of the ruler. Note that
you can set the indent to the left of the left margin, thus creating an outdent. 

To add a tab stop, click on the ruler where you want it set. To move a tab stop, drag it along the ruler. To delete
a tab stop, drag the tab stop downward, away from the ruler.
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Line Numbers Command

In Memos view, the View | Line Numbers command displays line numbers in the current memo.
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Receipt View Command

In Expenses view, the View | Receipt View command switches to the Receipt view of your expenses.

Enter your receipts using the Receipt view. The Report view arranges the receipts you have entered by date
and category, and totals them, ready to be printed.
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Report View Command

In Expenses view, the View | Report view command switches to the Report view of your expenses.

Enter your receipts using the Receipt view. The Report view arranges the receipts you have entered by date
and category, and totals them, ready to be printed.
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All Events Command

In Activities view, the View | All Events command displays all events that appear in your Calendar view. This
includes Appointments, To Do items, Calls, Multi-Day and Special Day events, plus confirmed Internet
scheduling events. 

Note The All Events tab does not include items from the Internet Events tab that you have not accepted yet.
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Appointments Command

In Activities view, the View | Appointments command displays appointments only.
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To Do Items Command

In Activities view, the View | To Do items command displays To Do items only.
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Calls Command

In Activities view, the View | Calls command displays Calls only.
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Internet Events Command

In Activities view, the View | Internet Events command displays group events only.
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Creating a Cardfile (Using cardfile templates)

Using cardfile templates Topic 1 of 4

To create a cardfile

1. In Contacts view, click the New Cardfile button , or choose File | New Cardfile. The Select Cardfile
Template dialog box appears. 

2. Click each template, and view the fields they contain (you can add or modify fields later).

3. Select the template you want. If you donʼt want to use a template, and you want to create all the fields
yourself, choose None as the cardfile template.

4. Click OK.

If you selected a template, an empty cardfile appears, containing the fields from the selected template. If you
want to change any of these fields, see the next topic in this series. If you selected None, the Define Cardfile
Fields dialog box appears. 

Note Use the Browse buttons  >>  (next topic)  and  <<  (previous topic) to move through this series.
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Creating a Cardfile (Adding new contact cards)

Adding new contact cards Topic 2 of 4
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To add contact cards to the cardfile 

1. In Contacts view, choose Cards | Add, or click the Add button  on the Toolbar. The Add Card dialog
box appears. 

2. Type the data in each field. 

3. Click Add to add the information as a new card. Click Close when you have added all the new cards you
want.

Note Use the Browse buttons  >>  (next topic)  and  <<  (previous topic) to move through this series.
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Creating a Cardfile (Changing cardfile fields)

Changing cardfile fields Topic 3 of 4

In Contacts view, choose Cards | Define Fields to display the Define Cardfile Fields dialog box,. 

To add a field
 Type a name in the Field Name box, and click Add or Add Before. 

To change a field name
 Select the field from the list, and then type the new name and click Change. 

To delete a field
 Select the field from the list and click Delete. 

You can also change the order of fields in the cardfile.

To reorder the cardfile fields
 Choose Cards | Reorder Fields. The Reorder Cardfile Fields dialog box appears.

Note Use the Browse buttons  >>  (next topic)  and  <<  (previous topic) to move through this series.
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Creating a Cardfile (Sorting a cardfile)

Sorting a cardfile Topic 4 of 4

Every contact card has an index line (or title), defined for a cardfile by up to three fields. Sidekick sorts the
cards alphabetically (or reverse alphabetically, if you choose) according to its index. 

To define the index

1. Choose Cards | Sort, or click the Sort button  on the Toolbar. The Sort Cardfile dialog box appears. 

2. Choose up to three fields to use as the index.

Note Use the Browse buttons  >>  (next topic)  and  <<  (previous topic) to move through this series.
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Adding Contact Cards

To add contact cards to the cardfile 

1. Choose Cards | Add, or click the Add button  on the Toolbar. The Add Card dialog box appears. 

2. Type the data in each field. 

3. Click Add to add the information as a new card. Click Close when you have added all the new cards you
want.
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Selecting Contact Cards

Selecting contact cards lets you perform actions (deleting and printing, for example) on several cards at once.

To select multiple contact cards
Click a cardʼs index line in the card list, and then press Shift and click another cardʼs index. The two

cards and all cards between them are selected.

Alternatively, you can press Ctrl and click several cards  ̓index lines in the card list. Only those cards you Ctrl-
click are selected.
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Moving Contact Cards between Cardfiles

To move a group of contact cards from the current cardfile to another open cardfile 
 Drag and drop the cards onto another cardfileʼs tab. 

To copy contact cards instead of moving them
 Hold down the Ctrl key while dragging and dropping. 

You can also choose Cards | Move to move the current card, selected cards, marked cards, or all cards to a
different open cardfile.

When you move or copy cards between two cardfiles, the Match Cardfile Fields dialog box appears. This
dialog box automatically matches fields that share the same name in both cardfiles. You can match other fields
manually by selecting a field from each cardfile and clicking the Match button. 

Information from unmatched fields will be placed in the last field of the new card.
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Adding a To Do

 Related topics

You can enter tasks into the Sidekick To Do list in the Calendar view and check them off when completed.
Sidekick forwards any incomplete To Dos to the next day. You can also give a To Do attributes like priority,
category, due date, and person assigned to handle it.

To create a new To Do 
 Click any blank line in the To Do list and begin typing. Or you can choose Calendar | To Do Items | Single

Day, which opens the To Do dialog box.

You can also edit the text of existing To Do items by clicking the To Do line and typing. 
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Adding an Appointment

 Related topics

Put all your appointments and scheduled tasks into the Events list in Calendar view. You can have any number
of appointments scheduled throughout the day, and up to three appointments scheduled for the same time. 

To create an appointment 
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 Click the Events listʼs time line on the time you want to start your appointment, and type its description.
When youʼre done typing, press Enter.

To drag an appointment to change its start time
 Grab its icon and drag it up or down to a new time. 

To change its duration 
 Click on the appointment and drag its bottom edge up or down. 
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Making a Recurring Appointment, To Do, or Call

 Related topics

To schedule a recurring event (one that occurs at regular intervals) 
1. In the Daily Calendar view, choose the type of activity you want from the Calendar menu: Events, Calls, or

To Do Items; and then choose Recurring.

2. Enter information in the Subject and Notes text boxes. 

3. Specify the start and end times, if applicable.

4. Set the range of days, weeks, or months that the activity will recur using the From and To dates. There is a
dialog box for each kind of recurring activity:

Recurring To Do

Recurring Events

Recurring Call

1. Choose the interval of recurrence. When youʼre done, click Add.

Tip To make an existing event recurring, right-click the event and choose Recurring from the shortcut
menu. (This tip applies to personal events, not group events.)
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Adding Multi-Day Events

To schedule a multi-day event 

1. In Calendar view, Choose Calendar | Events | Multi-Day Event, or click the multi-day event button.  The
Multi-Day Event dialog box appears.

2. Type the name of the multi-day event in the Description text box.

3. Select the month, day, and year for the starting and ending dates of the event. 

4. Select Full Day, AM, or PM (visible in Yearly Planner), and a Color for the eventʼs bar.

5. Click Add to place the event in the Multi-Day Events List and add it to your calendar.
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Adding a Memo

To add a memo to the current folder 

1. In Memos view, click the Add Memo button  or choose Memos | Memo | Add. 

2. Type a subject for the memo.

3. Press Enter to move into the body of the memo, or click in the memo space. 

4. Type and format your memo.
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Faxing a Memo

You can fax a memo directly from Sidekick using the Windows 95 Fax capability. 

To fax a memo
1. In the Memos view, open the Viewport and display the Cards list.

2. Select one or more contact cards as the fax recipients. (These cards must have a field that includes the
word "fax" in the field name, and there must be a fax number in the field.) If you don't make a specific
selection, Sidekick uses the current card.

3. Right-click the current memo and choose Send To | Fax from the shortcut menu. The memo is faxed to the
people whose cards you selected. 
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E-mailing a Memo

You can e-mail a Contact card or a memo with the click of your mouse, using either Eudora Pro (32-bit) or
Microsoft Exchange.

To send a memo or contact card as e-mail
1. Right-click the text of a memo or the data area of a card.

2. Choose Send To, and choose your e-mail software: Eudora Pro or Exchange. 

3. Use your e-mail software to address and send the information.
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Backing Up Your Files

 Related topic

The Back Up command copies the Sidekick files you specify to a backup location, such as another disk drive
or diskettes. When you Restore, Sidekick puts the files back in their original locations, either on the same
computer or on another one.

You can copy multiple files across multiple diskettes, as long as no single file is larger than the capacity of the
backup disk, usually 1.44Mb for a diskette.

To back up files
1. Save your open files. The backup program copies only the last-saved versions of your files.

2. Choose File | Back Up and Restore. The Back Up and Restore dialog box appears.

3. Click the Back Up button and click Next. The Back Up dialog box appears.

4. Select all the files you want from the Source Files list. Click > to add the selected files to the Back Up List.
Click >> to add all files in the Source Files directory to the Backup List. Change the Source or Destination
directories if needed.

5. After youʼve selected all the files you want to back up and have specified the directory to copy them to,
click Begin. 
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Restoring Your Files
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 Related topic

To place backed-up files onto another computer, or to restore them to their original source
1. Choose File | Back Up and Restore. The Back Up and Restore dialog box appears.

2. Click the Restore button and click Next. The Restore dialog box appears. Notice that each file to be restored
already indicates its own destination directory. 

3. Select which files you want to restore from the Source Files list, and click >. Or restore all listed files by
clicking the >> button. Change the Source or Destination directories if needed.

4. Click Begin, and Sidekick copies the selected files to the correct directories.

Note You can restore only files backed up using Sidekick 98, Sidekick 97, or Internet Sidekick.  Files
created by earlier versions of the Back Up utility are not compatible.
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Designing Printed Label Contents (Overview)

 Label Contents 
Overview Topic 1 of 7

The design you create in the Set Up Contents dialog box will repeat on each printed label (or envelope or
address book page). To open this dialog box, click Set Up Contents in the Print Labels dialog box. 

The design is made up of four types of elements: 

  Card Fields

  Text

  Graphics

  Stamp

These are discussed later in this series.

When you are finished with your design, click the Save As button to save your contents.

Note Use the Browse buttons  >>  (next topic)  and  <<  (previous topic) to move through this series.
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Designing Printed Label Contents (Creating and editing elements)

Creating and editing elements Topic 2 of 7

Create the four types of elements by clicking their buttons: 

  Card Fields

  Text

  Graphics

  Stamp

These are discussed in the following topics.

To edit an element 
 Right-click it, or click the Modify Selection button while the element is selected. A shortcut menu appears,

with different options available depending on the type of element youʼve selected. 

To resize an element
 Click it to select it, and then drag one of its handles to make it larger or smaller.

To move or edit multiple elements
 Shift-click to select each one, then move or edit them as a group. 

Note Use the Browse buttons  >>  (next topic)  and  <<  (previous topic) to move through this series.
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Designing Printed Label Contents (Creating Card Fields elements)

Creating Card Fields elements Topic 3 of 7

Card Fields elements insert information from the cardfile into the label, address book page, or envelope.

To add a card field
1. Click the Card Fields button. The Edit Label Text dialog box appears. 

2. Click the field in the list on the left, and click the Fields >> button. The field name appears in the box on the
right. You can type a space, carriage return, or punctuation if you want it to appear between fields.

3. If you want any other text to appear on every label, type it in the box on the right.

When you print, the information from the cards will appear in place of the field names.

Note Use the Browse buttons  >>  (next topic)  and  <<  (previous topic) to move through this series.
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Designing Printed Label Contents (Creating Text and Stamp
elements)

Creating Text and Stamp elements Topic 4 of 7

To add a Text element
1. Click the Text button. 

2. Type in the Edit Text dialog box and click OK.

To add a Stamp element
 Click the Stamp button and choose the phrase you want.

After the element is created, you can change its type style, color, and alignment by right-clicking and
choosing from the menu. You can also drag its handles to resize it.

Tip You can rotate a Stamp by right-clicking it and choosing Rotate from the menu.

Note Use the Browse buttons  >>  (next topic)  and  <<  (previous topic) to move through this series.
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Designing Printed Label Contents (Creating Graphic elements)

Creating Graphic elements Topic 5 of 7

To create a Graphic element 
 Click the Graphics button, and choose what kind of graphic to place: Bitmap, Frame, Round Frame, or

Line. 

If you choose Bitmap, you can import a BMP file, which you can then resize, if needed.  If you create a
Frame, Round Frame, or Line, you can resize the element, and you can change its line thickness and its
color by right-clicking it and choosing from the menu.

Note Use the Browse buttons  >>  (next topic)  and  <<  (previous topic) to move through this series.
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Designing Printed Label Contents (Resizing elements)

Resizing elements Topic 6 of 7
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To change the size of a graphic element 
1. Select it. Black squares (called handles) appear at its edges. 

2. Drag a handle to resize the element. 

To change the size of a Text, Card Fields, or Stamp element
 Right-click it and use the Font menu choice to specify a larger font.

With Text, Card Fields, or Stamp elements, you can drag the handles to new positions, but the actual text
within the element remains the same size. Note that itʼs possible to size the element too small, so not all the text
fits within it.

Note Use the Browse buttons  >>  (next topic)  and  <<  (previous topic) to move through this series.
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Designing Printed Label Contents (More options)

More options Topic 7 of 7

To zoom in or out of your design 
 Click the Zoom button and choose the magnification or reduction you want.

To impose a regular grid of points that elements will snap to
 Check the Snap to Grid option. This is useful for aligning elements.

To display this grid
 Check Show Grid.

To display hints 
 Click the Hint button.

Note Use the Browse buttons  >>  (next topic)  and  <<  (previous topic) to move through this series.
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Expense Menu

The Expenses menu provides tools for creating, managing, and organizing your expense folders and
receipts. 

For more information, highlight one of the Expenses menu choices, and press F1.

Created with the Personal Edition of HelpNDoc: iPhone web sites made easy

Folder Command

 Related topics

In Expenses view, the Expenses | Folder command offers options to create, delete, and modify expense
folders.

Add

Delete Current Folder

Modify
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Add Folder Command (Expense View)

 Related topics

In Expenses view, the Add Folder command (Expenses | Folder | Add) opens the Add Expense Folder dialog
box so you can create a new Expense folder.

Dialog Box Options

Folder Name
Type the name you want for the folder tab at the bottom of the screen.

Folder List
Displays a list of folders in the current Expense file.

Personʼs Name
Enter your name or the name of the person whose expenses will be entered in this folder.

Department
Enter the personʼs department name.

Organization
Enter the company name.

Purpose of Expenses
Enter the purpose of the expenses in this folder.

Sort Folders Alphabetically
Check this option if you want the folder tabs to appear in alphabetical order. 
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Delete Current Folder Command

 Related topics

In Expenses view, the Delete Current Folder command (Expenses | Folder | Delete Current Folder) deletes the
current Expense folder. You will see a message asking you to confirm that you want to delete the curent folder
and all receipts it contains.
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Modify Folder Command

 Related topics

In Expenses view, the Modify Folder command (Expenses | Folder | Modify) opens the Modify Expense Folder
dialog box so you can modify the current Expense folder.

Dialog Box Options

Folder Name
Type the name you want for the current folder tab at the bottom of the screen.

Folder List
Displays a list of folders in the current Expense file.

Personʼs Name
Enter your name or the name of the person whose expenses will be entered in this folder.

Department
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Enter the personʼs department name.

Organization
Enter the company name.

Purpose of Expenses
Enter the purpose of the expenses in this folder.

Sort Folders Alphabetically
Check this option if you want the folder tabs to appear in alphabetical order. 
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Receipt Command

 Related topics

In Expenses view, the Expenses | Receipt command offers options to create and delete expense receipts.

New

Delete
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New Receipt Command

 Related topics

In Expenses view, the New Receipt command (Expenses | Receipt | New) adds a new, blank receipt to the
current expense file.

Shortcuts

Toolbar:

Keyboard: Ctrl+A
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Delete Receipt Command

 Related topics

In Expenses view, the Delete Receipt command (Expenses | Receipt | Delete) deletes the current receipt.
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File Properties Command

 Related topics

In Expenses view, the File Properties command (Expenses | File Properties) opens the Expense File
Properties dialog box, where you can set properties for new Expense files you create. 

Dialog Box Options

Name for First Folder (canʼt be modified in this dialog box)
When you create a new Expense file, this name will be used for the first folder. (You can change it using the
Expenses | Folder | Modify command.)
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Personʼs Name
The name of the person whose expenses will be entered here.

Department
The personʼs department, or the department incurring the expenses.

Organization
The name of the company or organization.

Purpose of Expenses
The purpose of the expenditures in this file.

File Currency Setting (canʼt be modified in this dialog box)
Indicates the currency that will be used in this file. You can change this setting for all Expense files using
Tools | Preferences | Expenses.

Expense Report Types 
Highlight the expense types you want displayed in the default pick list for expense types.

File Country Setting (canʼt be modified in this dialog box)
Indicates the country setting that applies to your location. The tax designations are VAT (Value Added Tax),
GST (Goods and Services Tax) and PST (Provincial Sales Tax). (You can change this setting for all Expense
files using Tools | Preferences | Expenses.)

U.S.A. and other countries (without VAT/GST/PST)

European Countries (with VAT)

Canada (with GST/PST)
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Format Menu

In Memos view, the Format menu gives you tools for controlling the appearance of your memos.

For more information, highlight one of the Format menu options, and press F1.
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Font Command

In Memos view, the Font command (Format | Font) opens the Font dialog box, where you can set the
character attributes for the selected text.

Shortcuts

Toolbar:

Dialog Box Options

Font
Sets the font of the selected text.

Font Style
Sets the font style (Regular, Italic, Bold, or Bold Italic) of the selected text.

Size
Sets the point size of the selected text.

Effects
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Strikeout sets the the selected text in Strikeout style.

Underline sets the the selected text in Underline style.

Color sets the the selected text in the specified color.

Sample
Displays a sample of the selected text with all the specified attributes.

Script
Sets the alphabet to use for the selected text.
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Paragraph Command

In Memos view, the Paragraph command (Format | Paragraph) opens the Paragraph Formatting dialog box,
where you can set the indentation and alignment of the selected paragraph.

Dialog Box Options

Indentation
Sets the indentation of the first line and the right and left sides of the selected paragraph.

Alignment
Sets the alignment of the selected paragraph. The choices are: Left, Right, and Center.
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Tabs Command

In Memos view, the Tab Stops command (Format | Tab Stops) opens the Set Tab Stops dialog box, where you
can set tab stops for the selected paragraph.

Dialog Box Options

New Tab Stop
Sets the placement of a tab stop, measured in inches.

Set button
Adds a tab stop at the location specified in the New Tab Stop field.

Clear button
Clears the tab stop selected from the Tab Stop list to the left.

Clear All button
Clears all the tab stops.
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Bullet Command

In Memos view, the Format | Bullet command sets the selected paragraphs as a bulleted list. A bullet is added
at the first line of each paragraph, and each paragraph is indented. Applying this command to a bulleted list
will set the text back to normal.

Created with the Personal Edition of HelpNDoc: Benefits of a Help Authoring Tool

https://www.helpndoc.com/feature-tour/create-ebooks-for-amazon-kindle
https://www.helpndoc.com
https://www.helpndoc.com/feature-tour/create-help-files-for-the-qt-help-framework
https://www.helpauthoringsoftware.com


Sidekick 98 Help

160 / 200

EarthTime Settings Dialog Box

 Related topics

The EarthTime Settings dialog box lets you specify the cities you want displayed in EarthTime. Youʼll see this
dialog box when you first run Sidekick 98 or when the Clocks.dat file (the file containing your clock settings)
is damaged or missing.

EarthTime displays clocks for eight different cities. Choose the cities you want in this dialog box. You can
easily change your selections later using various commands in EarthTime view. 

Dialog Box Options

Country
Normally set to All Countries, so all cities in the EarthTime database appear. To narrow down the city list,
choose a country from the drop-down list. Only cities from that country will appear in the City list.

City
Click in the City field and type the first few characters of a city to find it. Then click the city name and click
one of the right arrows to move it to the Local City, Home City, or Other Cities list. If necessary, you can
select a city in the Other Cities list and click the left arrow to remove it and make room for another city of your
choice.

Local City (my current location)
The Local City is normally the same as your Home City. When you travel, you change the Local City to your
current location. All your appointments are displayed in Local City time. The Windows Time Zone dialog box
opens so you can specify the Time Zone. 

A person icon { bmc person.bmp } appears next to the Local City

Home City (my home location)

The Home City is where you live. A home icon  appears next to the Home City.

Six/Seven other cities of interest to me
Select the remaining cities whose clocks you want displayed in EarthTime. If your Home City and Local City
are the same, you can choose seven others; if they are different, you can choose six additional cities.
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Select a Different City Command

 Related topics

In EarthTime view, the Select a Different City command changes the city in the selected City panel. To select
another city, right-click the panel you want to change or move your mouse to the menu arrow  and choose
Select a Different City. Or click the panel you want to change and choose Edit | Select a Different City.

Dialog Box Options

Country
Sets the country from which to show cities in the City list below.

City
Sets the city to display in the selected City panel.

Note To display Greenwich Mean Time, choose GMT/UTC/Zulu, Time Center from the City list. 

Facts about the City
Opens the Facts about the City dialog box.

Created with the Personal Edition of HelpNDoc: Create HTML Help, DOC, PDF and print manuals from 1 single
source
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Facts about the City Dialog Box

 Related topics

The Facts about the City dialog box displays information about the current Local Clock city, or about a city
you select in the Select a Different City dialog box. The Almanac displays time zone, sun and moon phases,
and other calendar related information for that location. To open this dialog box, in EarthTime view, choose
Edit | Facts about the City. You can also right-click a City panel or move your mouse to the menu arrow 
and choose Facts about the City for information on that city.

The Facts information includes:

Language

Currency

Population

City Phone Code

Country Phone Code

Latitude and Longitude

The Almanac information includes:

Time zone (difference from Greenwich Mean Time)

Sunrise and sunset times

Daylight hours

Moon phases

Daylight saving time start and end dates (dimmed if the city doesnʼt do daylight saving time)

Days of the year

You can change the Date setting to see the sunrise, moon, and other information for the current city for any
date you specify. For example, if you want to know when daylight saving time starts in Sydney, Australia, in
1999, choose Sydney, open the Facts about the City dialog box, and change the year in the Date field to 99. 
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Modify City Information Dialog Box

 Related topics

The Modify City Information dialog box lets you change some of the information about each city in the
EarthTime database. This feature lets you update certain parameters that might change from time to time.

To open this dialog box, right-click a city and choose Modify City Information, or move your mouse to the
menu arrow  and select that menu item. You can also click the city and choose Edit | Modify City
Information.

Note You cannot modify the city information for the Local Clock city. If you need to do so, change the Local
Clock to another city temporarily while you make the changes.

Dialog Box Options

City and Country Facts
You can change the Phone Area Code and the Phone Country Code for any city, as well as the Language,
Currency, and Population.

Standard Time
Set the standard time difference from Greenwich Mean Time. For example, the East Coast of the U.S.
(Eastern Standard Time) is five hours earlier than GMT when Standard Time is in effect. (The difference is
four hours when Daylight Saving Time is in effect.)

Daylight Saving Time
You can change how daylight saving time is determined for a city. Specify the dates when it starts and ends,
or the means of determining it (such as: “Begins at 2 a.m. on the 1st Sunday of April”). When daylight saving

time is in effect for a city, a sunburst  appears on its clock.
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Browse Cities button
Opens the Select a Different City dialog box.
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Make Cityname the Map Center Command

Cityname the Map Center Command
 Related topics

The Make Cityname the Map Center command lets you shift the map to the left or right to center the city that
is in the selected City panel. Right-click a city panel and choose Make Cityname the Map Center, or move the
mouse to the menu arrow  and select that menu item.

Note You can also center any location you point to on the map. Move the mouse pointer to the location you
want to center, and right-click. Click the Center Map Here choice, or double-click the location you want
to center. The pointer location is centered in the window.
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EarthTime Menu

The EarthTime menu has the following commands:

Set as Local Time

Choose as Home Clock

Clock Setup

Time Difference
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Set as Local Time Command

 Related topics

The Set as Local Time command lets you choose one of the eight displayed cities as your Local Clock city,
so that when you travel, your appointments will be shown in the time of the city youʼre in.

To set a city to local time
Right-click the city panel where you are currently located, and click Choose as Local Clock from the menu, or
move the mouse to the menu arrow  and select that menu item. Or, you can click the city and choose
EarthTime | Set as Local Time.

You can keep a different city set as your Home Clock city, so you know what time it is at home.

A person icon  appears in the City panel of the Local Clock. When daylight saving time is in effect for a

city, a sun  appears on its clock.

Note Sidekick 98 does not change your computer system clock to the Local Time.

Created with the Personal Edition of HelpNDoc: Create help files for the Qt Help Framework

Choose as Home Clock Command

 Related topics

The Choose as Home Clock command lets you choose one of the eight displayed cities as your Home Clock
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city. This city is set when you install. Changing this city changes the Home Clock city displayed in the Time
Difference dialog box.

To change the Home Clock, right-click the city panel you want to make the Home Clock, and click Choose as
Home Clock from the menu, or move the mouse to the menu arrow  and select that menu item. Or, you can
click the city and choose EarthTime | Choose as Home Clock.

A home icon  appears in the City panel of the Home Clock. When daylight saving time is in effect for a city,

a sunburst  appears on its clock.
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Clock Setup Command

 Related topics

The Clock Setup command displays a dialog box where you can set a preferred name, clock display, and
time options for the selected city. To open this dialog box, right-click a city panel and choose Clock Setup
from the menu, or move the mouse to the menu arrow  and select that menu option. Or, choose EarthTime |
Clock Setup. 

Dialog Box Options

Clock Name
You can display the city/country name supplied by EarthTime, or type a different name that you want
displayed. This lets you display any city name, even if it is not in the database. 

Note The Facts about the City will still refer to the city in the database, not the city whose name you type in
the Use Preferred Name box.

Clock Faces
Select Analog or Digital for the EarthTime clocks.

Time Formats 
Display Seconds shows or hides the seconds counter for all cities. 

Military Time displays time in 24-hour time format when checked. 

Apply button
Click to see the clock face you have chosen on the sample clock panel in the dialog box.
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Time Difference Command

 Related topics

The Time Difference command shows the time difference between two cities. Right-click a city and choose
Time Difference to see the time difference between it and the Local Clock, or move the mouse to the menu
arrow  and select that menu option. Or you can click a city and choose Time Difference from the EarthTime
menu.

Note To see the Time Difference for any two of your eight displayed cities, drag from the time display area
of one city clock panel to another panel.

Dialog Box Options

City 1
By default, shows the selected city. You can change this city by clicking the Browse Cities button in that
panel. (Changing the city in this dialog box does not change the city displayed in EarthTime.)

City 2
By default, shows your Local Clock city. You can change this city by clicking the Browse Cities button in that
panel. (Changing the city in this dialog box does not change the city designated as your Local Clock city in
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EarthTime.)

Time Difference
Displays the time difference between City 1 and City 2.

Time Comparison
Shows a graphical hour-by-hour comparison between the two cities for every hour of the day. 

Switch Cities button
Switches City 1 and City 2 in the Time Comparison.
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Rearranging Cities

 Related topics

You can change the order of cities in EarthTime using drag and drop.

To switch the position of two cities, drag the city name from one of the displayed cities to another.

Note Be sure to drag the city name. Dragging the clockʼs time display area (rather than the city name) to
another panel opens the Time Difference dialog box, where you can view the time difference between
the two cities.
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Daylight Saving Time Change

During the transition from daylight saving time to standard time, there can be ambiguity about the time. When
you set the clock back in the fall, the hour between 1 a.m. and 2 a.m. is, in effect, repeated.  So there are two
moments when the clock reads 1:15 a.m., for example.  

Also, when USA Eastern Time “springs” forward in the spring, USA Pacific Time will be 4 hours behind during
a 3-hour period. Similarly, in the fall, there will be a period when the difference is 2 hours during the
transition.

The dialog box asks you to specify whether the current time is standard time or daylight saving time.  

Created with the Personal Edition of HelpNDoc: Easily create Help documents

Center Map Here Command

When you right-click a map location and click Center Map Here, the map shifts horizontally so that the place
you clicked is centered in the window. Or, you can double-click the location to cause the map to shift to that
location.
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Internet Menu (Activities View)

The Internet menu in the Activities view has options for scheduling meetings and resources, as well as mailing
list management.

Scheduling Wizard

Resource Wizard

Mailing List
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Resources

Eudora Pro Mail

Netscape Mail

Send/Receive Now
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Internet Menu (Contacts View)

The Internet menu in the Contacts view has options for scheduling meetings, managing mailing lists, opening
your e-mail address books, publishing cardfile data to the Web, and launching your browser and jumping to a
Web site.

Scheduling Wizard

Send/Receive Now

Mailing List

Eudora Pro Address Book

Netscape Address Book

Exchange Address Book

Windows Address Book

Publish to the Web

Publishing Wizard

Launch URL
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Internet Menu (Calendar View)

The Internet menu in the Calendar view has options for scheduling meetings and publishing Calendar
information to the Web.

Scheduling Wizard

Send/Receive Now

Publish to the Web

Publishing Wizard
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Mailing List Command

In Activities and Contacts views, the Internet | Mailing List menu has options for editing and managing mailing
lists. 

The menu choices are 

Edit

Manage

Created with the Personal Edition of HelpNDoc: Create HTML Help, DOC, PDF and print manuals from 1 single
source
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Resources Command

In Activities view, the Internet | Resources menu has options for reserving and managing resources. 

The Resources menu includes:

Add

Modify

Remove

Transfer

Distribute

View

Print

Created with the Personal Edition of HelpNDoc: iPhone web sites made easy

Publish to the Web Command (Calendar View)

In Calendar view, The Internet | Publish to the Web command allows publishing of Sidekick 98 Calendar (and
Contacts) data to the World Wide Web as HTML documents. For more information, see Introducing Web
Publisher. 
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Publishing Wizard Command (Calendar View)

In Calendar view, The Internet | Publishing Wizard command opens a Wizard for publishing Sidekick 98
Calendar (and Contacts) data to the World Wide Web as HTML documents. For more information, see
Introducing Web Publisher. 
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Publish to the Web Command (Contacts View)

In Contacts view, the Internet | Publish to the Web command allows publishing of Sidekick 98 Contacts (and
Calendar) data to the World Wide Web as HTML documents. For more information, see Introducing Web
Publisher. 
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Publishing Wizard Command (Contacts View)

In Contacts view, the Internet | Publishing Wizard command opens a Wizard for publishing Sidekick 98
Contacts (and Calendar) data to the World Wide Web as HTML documents. For more information, see
Introducing Web Publisher. 

Created with the Personal Edition of HelpNDoc: Generate Kindle eBooks with ease
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Netscape Mail Command

In Activities view, the Netscape Mail command (Internet | Netscape Mail) lets you create e-mail in Netscape
Navigator.

This command opens Netscape Navigator and takes you to the Message Composition window where you can
create a new message. (If you have not configured Navigator for e-mail, this option just opens the Navigator
browser.)
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Eudora Pro Mail Command

In Activities view, the Eudora Pro Mail command (Internet | Eudora Pro Mail) opens the Eudora Pro (32-bit) e-
mail program so you can send and receive e-mail. 
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Send/Receive Now Command

In the Calendar, Contacts, and Activities views, the Send/Receive Now command (Internet | Send/Receive
Now) starts an immediate e-mail session to check for incoming messages and send any that are waiting to
go. 

Shortcuts

Toolbar:

The Activities view shows you all incoming and outgoing group event invitations. Any that you have not read
yet are marked with an icon  in the New column. 

If there are unread messages in the Activities view, the Activities icon on the Deskpad changes to red and is
animated every 15 minutes.

Note All invitations or replies are sent only when a Flash Session occurs, or when you use the Send/Receive
Now command. 
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Schedule Group Event Dialog Box

In Calendar view, choose Calendar | Events | Group to open the Schedule Group Event dialog box. Click each
tab in the dialog box, and fill in information about the group event. 

Note If you do not specify participants or resources, the event is entered locally, on your calendar only, as
an individual event. 

For more information, click the page in the list:

Date and Time page

Participants page

Message page

Resources page

Options page
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Date and Time Page

 Related topics

In the Date and Time page of the Schedule Group Event dialog box (Calendar | Events | Group), enter the
“when and where” details for your event.

Note: Be sure that cardfiles you want to use for selecting participants are open before you begin scheduling
the event.

Dialog Box Options

Subject 
Type the subject of your meeting or event. (You canʼt select other page tabs without entering a subject.)

Date and Time
Click the day or month, day, year, and use the arrows to increase or decrease the value. Or click the large
arrow to see a calendar you can use to find and select the date. You can also type a date.

Click the hour or minute in the From and To fields, and use the arrows to increase or decrease the time. Or
you can type the time.

Location
City and Country:  Click the arrow and choose one from the list, such as San Francisco, CA, USA.

Time Zone: The time zone is filled in when you select a city. For an event that is time-zone specific, such
as a conference call at 10 a.m. USA Central time, you can select the time zone instead of choosing a city
and country.

Place:  Type a location, such as Smith Hotel, or click the arrow and choose one from the list of your
previous entries. 
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Participants Page

 Related topics

In the Participants page of the Schedule Group Event dialog box (Calendar | Events | Group), identify the
people you want to invite to your event or meeting. Participants will be notified and their responses collected
automatically by Sidekick 98ʼs messaging software.

Note If you do not enter any participants, the event is considered a personal event, entered in your calendar
only.

Dialog Box Options

Select Address Book or Mailing List
Select one of the currently open Sidekick cardfiles containing people you want to notify of the event. 

Add Card button — Click to add one or more new cards to the currently selected Address Book. The Add
Card dialog box opens. 

More button — Click to open another cardfile. You can select particpants from more than one address book
or mailing list.

People
Lists the people in the currently selected address book or mailing list.  Click the + sign next to the name that
you want to add, to see the personʼs addresses. If several delivery options are available, such as Internet and
CompuServe, click the one you want to use for delivering the invitation, and then click the > (Add) button for
the Participants or CC lists. 

If you select a telephone address, the person will be added to your Calls list in the Calendar to remind you to
call them. If you select a fax number, a fax is automatically created and sent (assuming you have installed
Microsoft Fax, and have a fax modem installed). 

Click the >> button to add all entries in the People list to the Participants list.  Click << to remove all names
from the Participants list.
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Participants
Click > to add the selected name to the Participants list. Or select a name in the Participants list and click < to
remove it. 

cc:
Click > to add the selected name to the cc: list. People on the cc: list receive the same e-mail notification as
participants. They have the option of accepting or declining the invitation. 
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Message Page

 Related topics

In the Message page of the Schedule Group Event dialog box (Calendar | Events | Group), enter the meeting
agenda, announcement, notes, or other information about the event.

Dialog Box Options

Message
Type the message in the text field (up to 2,000 characters). You also can click the Message button and
choose a text file (.TXT) to copy into the Message text field.

Attach URL button
Opens the Attach a Uniform Resource Locator dialog box, where you can enter a URL and description. 

Message button
Opens the Browse dialog box, where you can look for a text file to load into the Message text field.

File Attachment
Click the Browse button and locate a file to include as an attachment to the message.
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Resources Page

 Related topics

In the Resources page of the Schedule Group Event dialog box (Calendar | Events | Group), identify the
facilities and equipment you want to reserve for your event. 

Dialog Box Options

Available Resources
Choose one or more resources from the list. These are resources that have been distributed to you, plus any
that you manage. To create new resources, use Internet | Resources | Add (in Activities view).

Event Resources
Click > to add the selected name to the Event Resources list.

You can select a resource in the Event Resources list and click < to remove it. 

You will receive an automatic reply from the manager of the resource, which you can view in the Activities
view. The reply will confirm your reservation, or decline it if the resource is already booked or no longer
available.  
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 Related topics

The Options page of the Schedule Group Event dialog box (Calendar | Events | Group) lets you add reminders
and set a number of options for the event.

Dialog Box Options

Reminders
Remind Participants sends a reminder automatically to all participants in the event (including those on the
cc: list), except for those who have Declined.  In the time boxes, specify how far ahead of the meeting you
want the reminder sent. 

Page Me At pages you to remind you of the event. Click in the time box and use the arrows to specify how
far ahead you want to be paged. The value to enter is, for example, 999-9999@pagenet.net. Note: You
must have an alphanumeric pager with an electronic mail account from your pager provider. Contact your
pager provider for the addressing information. 

Alert me lets you set an alarm to remind you of the event. Click in the time box and use the arrows to
specify how far in advance you want the alarm.

Click the arrow at the Tone box and choose a sound. (The Tone pick list includes sound files found in the
Windows\Media directory.) Click the Test Play button to hear the sound. Note: A sound card is required to
play sounds.

Event Options
RSVP requests replies from your participants. Sidekick automatically collects Accept, Decline, or other
reply messages from your recipients, and displays them in the Activities view. Click FYI if you want to
broadcast a message announcing an event, like a company meeting, without collecting reply information. 

Tentative indicates that the event has not been confirmed. A tentative icon  appears on your calendar
and on participants  ̓calendars. (Select the item in the Activities view and click the Confirm button, or right-
click the event and choose Confirm,  when you are ready to to send a message confirming a tentative
event.)

Completed lets you check off the event in your calendar when it has been completed. 

Type lets you select the event type: Public, Confidential, and Personal.
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Internet Scheduling Wizard Step 1

 Related topics

In Calendar, Contacts, and Activities views, the Scheduling Wizard command (Internet | Scheduling Wizard)
opens the Wizard for scheduling events.

Shortcuts

Toolbar:

In the opening Wizard panel, click one of the categories on the left:

Meeting

Conference Call

Online Event

Other Event

Then click an event description from the list on the right.

When you have selected the event type, click Next to continue to the next Wizard panel, or Cancel to exit.

Note If the choices are not exactly what you need, you can edit the subject in Step 2.
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Internet Scheduling Wizard Step 2

 Related topics
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In Step 2 of the Internet Scheduling Wizard, review the subject and enter the details of time and location for
your event.

Subject
Review the subject, which is the meeting or event you selected on the previous page of the Wizard. You can
revise the subject here, if necessary.

Date and Time
Click the day or month, day, year, and use the arrows to increase or decrease the value. Or click the large
arrow to see a calendar you can use to select a date. You can also type a date.

Click the hour or minute in the From and To fields, and click the arrows, or use the up-arrow and down-arrow
keys, to increase or decrease the time. Or you can type the time.

Location
City and Country:  Click the arrow and choose the city and country from the list, such as San Francisco,
CA, USA.

Time Zone:  The time zone is filled in when you select a city. For an event that is time-zone specific, such
as a conference call at 10 a.m. US Central time, you can select the time zone instead of choosing a city
and country. 

Place: Type a location, such as Smith Hotel, or click the arrow and choose one from the list of your
previous entries. 
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Internet Scheduling Wizard Step 3

 Related topics

In Step 3 of the Internet Scheduling Wizard, identify the people you want to invite to your event or meeting.

Select Address Book or Mailing List
Select a Sidekick Cardfile containing names you want to notify of the event. 

Add Card button — Click to add one or more new cards to the currently selected Address Book. The Add
Card dialog box opens.

More button — Click if you want to open another Address Book or mailing list.

People
Lists the people in the currently selected address book or mailing list.  Click the folder icon next to the name
that you want to add, to see the personʼs addresses. If several delivery options are available, such as Internet
and CompuServe, click the one you want to use for delivering the invitation, and then click the > (Add) button
for the Participants or CC lists. 

If you select a telephone address, the person will be added to your Calls list in the Calendar to remind you to
call them. If you select a fax number, a fax is automatically created and sent (assuming you have Microsoft
Fax installed, and have a fax modem). 

Click the >> button to add all entries in the People list to the Participants list.  Click << to remove all names
from the Participants list.

Participants
Click > to add the selected name to the Participants list.

CC
Click > to add the selected name to the CC list. People on the CC list receive the same e-mail notification as
participants. They have the option of accepting or declining the invitation.

You can select a name in the Participants or CC list and click < to remove the name.
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Internet Scheduling Wizard Step 4

 Related topics

In Step 4 of the Internet Scheduling Wizard, enter the meeting agenda, list of required items, notes, or other
information about the event.

Message
Type the message in the text field (up to 2,000 characters). You also can click the Message button and
choose a text file (.TXT) to copy into the Message text field.

Attach URL button
Opens the Attach a Uniform Resource Locator dialog box, where you can enter a URL and description. 

Message button
Opens the Browse dialog box, where you can look for a text file to load into the Message text field.

File Attachment
Click the Browse button to locate a file to include as an attachment to the message. 
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Internet Scheduling Wizard Step 5

 Related topics

In Step 5 of the Internet Scheduling Wizard, identify the facilities and equipment you need for your event.

Available Resources
Choose one or more resources from the list.

Event Resources
Click > to add the selected name to the Event Resources list.

You can select a resource in the Event Resources list and click < to remove it. 

You will receive an automatic reply from the manager of the resource, which you can view in the Activities
view. The reply will confirm your reservation, or decline it if the resource is already booked or no longer
available.  
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Internet Scheduling Wizard Step 6

 Related topics

Step 6 of the Internet Scheduling Wizard lets you add reminders and set a number of options for the event.

Reminders
Remind Participants sends a reminder automatically to all participants in the event (except those who have
declined). In the time boxes, specify how far ahead of the meeting you want the reminder sent.

Page Me At pages you to remind you of the event. Click in the time box and use the arrows to specify how
far ahead you want to be paged. The value to enter is, for example, 999-9999@pagenet.net. Note: You
must have an alphanumeric pager with an electronic mail account from your pager provider. Contact your
pager provider for the addressing information. 

Alert Me lets you set an alarm to remind you of the event. Click in the time box and use the arrows to
specify how far in advance you want the alarm. 

Click the arrow at the Tone box to choose a sound. Click Test Play to hear the sound. Note: A sound card
is required to play sounds.

Event Options
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RSVP requests replies from your participants. Sidekick automatically collects Accept, Decline, or other
reply messages from your recipients, and displays them in the Activities view. 

FYI broadcasts a message announcing the event, like a company meeting, without collecting reply
information. 

Tentative marks the event as unconfirmed on your calendar and participants  ̓calendars.  (Select the event
in the Activities view and click the Confirm button, or right-click the event and choose Confirm,  when you
are ready to send a message confirming the tentative event.)

Type lets you select the event type: Public, Confidential, and Personal.
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Internet Scheduling Wizard Step 7

 Related topics

Review the details you have specified for your event. Click Back if you need to go back to previous steps to
change anything.

Event Summary
Review the date, time, location, and subject. Check the Participants and Resources lists. If you need to
change any information, click the Back button until you come to the page where it appears, and make the
changes.

Finish button
Click to schedule the event.
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Set Up Preferred E-Mail Search Order Dialog Box

Use the Set Up Preferred E-mail Search Order dialog box to specify the order for e-mail fields to be searched
when adding to the Participants list.  

Dialog Box Options

Available E-mail Types
This list displays the avaiilable fields that may contain e-mail address information.

Preferred Search Order
The list you create that specifies the order the fields should be searched.  For example, if your first choice is
to use a field called Electronic Mail, be sure that field appears at the top of the list.

Select an entry in the Available E-Mail Types list, and click > to add it to the end of the existing list.  To change
the order, use the < button to remove any entries that are in the wrong order, and then use the > button to
add them back in the order you want. 
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Edit Mailing List Command

In Contacts and Activities views, the Edit Mailing List command (Internet | Mailing List | Edit) lets you add or
delete mailing lists, or modify their names.

Dialog Box Options

Specify the Mailing List Name
Type the name of a new or existing mailing list.
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Existing Mailing Lists
Click a mailing list to select it from the list.

Add button
Enter a new name, and click Add to add the new mailing list.

Modify button
Select an existing mailing list. Revise the name as desired, and click Modify to change the name. 

Delete button
Select an existing mailing list and click Delete to remove it permanently.

Warning: Deleting a Mailing List removes all the addresses it contains.
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Manage Mailing List Command

In Contacts and Activities views, the Manage Mailing List command (Internet | Mailing List | Manage) lets you
modify the membership of your mailing lists.

Dialog Box Options

Select a Mailing List
Start by specifying the mailing list. Click the arrow and select one of your defined mailing lists.

Select Address Book
Click the arrow and choose an address book from the currently open cardfiles. After adding names from one
address book, you can select another and add names from it.

People in the Address Book
Click the + sign next to each name, and click a notification method if more than one appears. Then click the >
button to add the person to the list.

The > and < buttons
Once you have clicked a person and notification method, click > to add the person to the list.

Click a person in the Contacts in the Mailing List box and click < to remove him/her from the list.

People in the Mailing List
Contains the list you have created.

Save
Click to save the list, including any changes you have made.

Reset
Restores the list to its last saved state. 
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Compose the Minutes of the Meeting Dialog Box

The Compose the Minutes of the Meeting dialog box lets you (or any meeting participant) write meeting
minutes and send them to the attendees. 

Dialog Box Options

Minutes of Meeting
Type the minutes in the space provided. 

File Attachment
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Specify a file to send as an attachment, or click Browse to locate the file.

Once you have entered the minutes, click OK to send them automatically to the meeting attendees. 
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Delegate To Dialog Box

Use the Delegate To dialog box to delegate a meeting invitation to someone else. The person you delegate to
becomes the recipient, and has the same options for responding as other recipients.  The event initiator
receives notification that you have delegated the event, and to whom you delegated it.

Dialog Box Options

Select Address Book  
Click the arrow to select an address book from among your open Sidekick Cardfiles. 

Select the Person to Delegate This Event To 
Click the person you want to delegate the invitation to. If a + appears next to the name, click it and choose the
notification method you want to use in delegating the message.

Short Message
Type a message of up to 2,000 characters. 
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Reschedule Request Dialog Box

The Reschedule Request dialog box lets you reply to a meeting invitation with a request to reschedule it. Your
reply includes up to three proposed alternate times, and can include your Free Time Report.

Dialog Box Options

1, 2, 3 Proposed Schedule
Enter one or more alternate dates and times, if desired. Check the box for First Proposed Date/Time (then
Second Proposed Date/Time, if desired, then Third). Click in the date or time field, and click the arrows to
increase or decrease the value. The large arrow in the Date field opens a calendar you can use to select the
date. 

4 Type a Short Message
Type a short message (up to 2,000 characters) you want to send with your reschedule request.

Attach My Calendarʼs Free Time Report for Next 30 Days
Check to attach a report showing your free time for the next 30 days. Note: This report is based on your
currently open calendar.
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Accept Invitation Dialog Box

Type a short message (up to 2,000 characters) to send with your reply accepting the meeting invitation. 
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https://www.helpauthoringsoftware.com
https://www.helpndoc.com/create-epub-ebooks
https://www.helpndoc.com/feature-tour/create-help-files-for-the-qt-help-framework
https://www.helpndoc.com/create-epub-ebooks


Sidekick 98 Help

176 / 200

Decline Invitation Dialog Box

Type a short message (up to 2,000 characters) to send with your reply declining the meeting invitation. 

Check Attach My Calendarʼs Free Time Report for Next 30 Days to include a report showing available time on
your calendar. This report is based on the currently open calendar.
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Cancel Event

Cancels the selected event (you can cancel only an event that you initiated). Participants are notified
automatically by Internet messaging. 

When participants click the cancelation message and click the Clear This Event button, the event is removed
from their calendars. The notification icon remains in the New column to remind participants to clear the
event.
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Send Reminder

Automatically sends a reminder to participants in the selected event (it must be an event you initiated). People
who have declined the invitation do not receive the reminder. 

The reminder appears with an icon  in the New column in the Activities view.
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Reschedule

The Reschedule command opens the Schedule Group Event dialog box. You can enter new event information
and re-send the invitations. 

Once you reschedule an event, all previous replies you received are cleared, since new replies are needed
for the rescheduled event.

The recipients see an icon  in the New column, and the word Rescheduled appears as the Status in the
Information pane.

Recipients must click the Accept, Decline, or other reply buttons to reply to the rescheduled event notification.
The notification icon remains in the New column to remind participants to reply to the rescheduled event.
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Reschedule Resource Reservation

The Reschedule command for a resource lets you change the date and/or time of a resource reservation. 

Click the resource message and click the Reschedule button. Or you can right-click the resource message
and choose Reschedule from the shortcut menu.  Enter the new date/time information in the Resource
Wizard.
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Cancel Resource Reservation

Use the Cancel Resource Reservation command to cancel a resource reservation. 

Note A resourceʼs manager can cancel reservation for that resource manually. View the resourceʼs
reservations (Internet | Resources | View). Right-click on the reservation and select Cancel
Reservation. No notification is sent to the person who made the reservation.
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Confirm Event

The Confirm command sends confirmation notices to participants of an event previously marked tentative. 

Select the event and click the Confirm button, or right-click the event and select Confirm. Notification is
automatically sent to all participants, removing the tentative status of the event.
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Delete Event

Use Delete to remove the selected event from the Activities list. 

Deleting the activity is used to clean up the Activities view. No messages are sent to participants, and the
event is not removed from your calendar.  Use the Cancel Event button if you want to cancel an event and
notify participants, or delete the event from the Calendar view. 

Note: Here are some issues to consider when you delete an event:

1. If the item is for a group event that you initiated and that has not been completed, you will not be able to
track and modify the deleted event.

2. If the item is a group event that is still in your calendar, deleting the item will delete all participant and
resource information for the event. You can safely do so after the event has taken place. 

3. If you delete an item in Activities view and then delete it from the Calendar, you will not be prompted to send
cancelation notices to participants, because the participant and resource information has been deleted. 

4. If you delete an event, incoming replies to that event are discarded.
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Event

The New option in the shortcut menu and the New button in Activities view open the Schedule New Activity
dialog box, so you can create a new event. 
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Resource Reservation Wizard Step 1

 Related topics

In Activities view, the Resource Reservation Wizard command (Internet | Resource Wizard) opens the Wizard
for scheduling resources. 
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Shortcuts

Toolbar:

Wizard Options

Facilities
Click one or more resources in the Facilities list. Click a selected resource to de-select it.

Equipment
Click one or more resources in the Equipment list. Click a selected resource to de-select it.

Details
Select a resource and click Details to see information about that resource, such as the maximum occupancy
of a facility and the managerʼs name.
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Resource Reservation Wizard Step 2

 Related topics

Enter the purpose and time of the reservation.

Wizard Options

Purpose
Type the purpose of the reservation.

From
Click in the date or time box and use the arrows to increase or decrease the value. Or type a date or time in
the box. The large arrow next to the Date box opens a calendar you can use to select the date.

To
Click in the date or time box and use the arrows to increase or decrease the value. Or type a date or time in
the box. The large arrow next to the Date box opens a calendar you can use to select the date.

Location
Select the city and country from the list.  The Time Zone is filled in automatically. Or select the time zone from
the Time Zone drop-down list. This is the date and time that will be used for reserving the resource.
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Add Resources Command

In Activities view, use the Add Resources command (Internet | Resources | Add) to add a new resource. You
become the manager who “owns” the new resource (unless you transfer it to someone else). The managerʼs
computer is where the resourceʼs calendar is maintained, but all scheduling occurs in the background, without
requiring any involvement by the manager.
Note A resource manager should keep the Flash Sessions setting enabled, and set to a fairly frequent

interval, to allow Sidekick 98 to respond to resource requests promptly. Flash sessions are turned on or
off in the Group Scheduling Preferences dialog box.

Dialog Box Options

Existing resources
A list of resources currently available on your system.

Resource Type
Facility: A conference room or other location. A maximum occupancy field is provided.
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Equipment: A computer, vehicle or other resource that has no maximum occupancy.

Other: An undefined resource category you can use as you need. For example, this might be a phone
company conference call operator or a catering company. No reservations are recorded for Other
resources.

Name
Type the name of the new resource.

Maximum Occupancy
For a Facility, the maximum number of people that it accommodates (up to 32,000).

Resource Manager Information
Contact Name: Your name, as the manager of the resource.

E-mail Type: Your e-mail account type.

E-mail Account: Your e-mail account name.

Phone Number: Your telephone number.

Fax Number: Your fax number.

Comments
Comments or notes about the resource.
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Modify Resources Command

In Activities view, the Modify Resources command (Internet | Resources | Modify) lets you modify a
resourceʼs information, as it appears on your system.

In the Modify Resources dialog box, click the resource you want to modify in the list on the left.  Make
changes you want in the fields on the right (fields that are gray cannot be modified).

Note If you try to schedule a resource and receive notification that the resource has been transferred to a
different manager, use the Modify Resources command to enter the new managerʼs information.

Dialog Box Options

Select the resource to be modified 
A list of resources currently available on your system.

Resource Type
Facility: A conference room or other location. A maximum occupancy field is provided.

Equipment: A computer, vehicle or other resource that has no maximum occupancy.

Other: An undefined resource category you can use as you need.

Name
The name of the resource, which cannot be modified.

Maximum Occupancy
For a Facility, the maximum number of people that it accommodates.

Resource Manager Information
Contact Name: The name of the person who “owns” the resource.

E-mail Type: The contactʼs e-mail account type. 

E-mail Account: The contactʼs e-mail account name.

Phone Number: The contactʼs telephone number.

Fax Number: The contactʼs fax number.

Comments
Comments or notes about the resource.

Note The changes you make will appear on your computer only. 
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Remove Resources Command

In Activities view, use the Remove Resources command (Internet | Resources | Remove) to delete a resource
from your system. 

In the Remove Resources dialog box, click the resource in the list at the left, and then click Remove to delete
the resource. 
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Transfer Resources Command

In Activities view, the Transfer Resources command (Internet | Resources | Transfer) lets you transfer
management of a resource to another person. You can transfer a resource to anyone using the same kind of
e-mail as you.

In the Transfer Resources dialog box, click the resource in the list at the left. You can view the current
information about the selected resource.  

Click the Transfer button, and enter the new managerʼs information in the spaces provided. The manager must
be using Sidekick 98 or 97 (or Internet Sidekick), and you must provide the managerʼs e-mail account
information. 

When you have entered the information, click the Transfer button. The new manager has the option of
accepting or declining the transfer. 

Note A resource manager should keep the Flash Sessions setting enabled, and set to a fairly frequent
interval, to allow Sidekick 98 to respond to resource requests promptly. Flash sessions are turned on or
off in the Group Scheduling Preferences dialog box.

Dialog Box Options
Contact Name: The name of the person who “owns” the resource.

E-mail Type: The contactʼs e-mail account type. Click the arrow and choose the account type from the
list. 

E-mail Account: The contactʼs e-mail account name.

Phone Number: The contactʼs telephone number.

Fax Number: The contactʼs fax number.
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Accept Resource Transfer

When a resource is transferred to a new manager, the new manager must Accept the transfer before it goes
into effect. 

The new manager clicks the transfer message and clicks the Accept button to accept the transfer.

The scheduling of the resource happens in the background on the managerʼs computer, without requiring any
direct involvement of the manager. A resource manager should schedule flash sessions at frequent intervals
so Sidekick 98 can handle incoming resource requests promptly.
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Decline Resource Transfer

When a resource is transferred to a new manager, the new manager has the option to decline the transfer. 

Click the transfer message and click the Decline button to decline the transfer.
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Retransfer Resource

The retransfer command repeats a resource transfer message. Use this command if you find the message
transferring a resource has failed to arrive at the destination. 

Select the resource transfer message and click the Restransfer button to send the transfer message again to
the same person as before.
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Undo Transfer

Use the Undo Transfer command if a problem with a transfer requires you to undo it.

For example, if you transfer a resource and then find out that the e-mail transfer message cannot be
delivered, use the Undo command to resume managing the resource. You can then transfer to another
recipient or a new e-mail address if desired.
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New Resource Manager Dialog Box

Use the New Resource Manager dialog box to specify a new manager for a resource you have managed.  

Dialog Box Options

Contact Name
Type the new managerʼs name

E-mail Type
The new managerʼs e-mail type (Internet or Exchange).

E-mail Account
Enter the new managerʼs account name.

Phone Number
Enter the new managerʼs telephone number.

Fax Number
Enter the new managerʼs fax number.

Transfer button
When the information is correct, click the Transfer button.
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Distribute Resources Command

In Activities view, the Distribute Resources command (Internet | Resources | Distribute) lets you make a
resource available to other users for booking reservations. Only users to whom the resource has been
distributed will be able to reserve it. You can distribute a resource to anyone using the same kind of e-mail as
you.  You can distribute resources you manage and resources that were distributed to you by others.

Dialog Box Options

Select Resources for Distribution
Available Resources lists resources on your system. Click each resource you want to distribute, and click
> to add to the Selected Resources list. You can distribute resources that are managed by others. 

Selected Resources lists the resources you are distributing.

Select Users for Distribution
Address Book or Mailing List:  Choose the address book or mailing list to use. You can select users from
more than one address book or mailing list.

User List shows everyone in the selected Address Book or Mailing List. Click names and click > to add
them to the Selected Users list.

Selected Users lists users you want to receive the distribution.

Distribute button
When the lists of resources to distribute, and users to distribute to, are correct, click Distribute to make the
distribution.
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View Resources Command

In Activities view, use the View Resources command (Internet | Resources | View) to see the schedule of a
resource you manage.  You can view the schedule for up to six months ahead.

In the Viewing Resources dialog box, booked time shows as blocks. Use the scroll bars to see more dates and
times. 

If you need to cancel a resource reservation, right-click the reservation block and choose Cancel Reservation
(no notice is sent to the person who made the reservation).

You can print the schedule in weekly or monthly format. Click the Print button. The Print Resource
Reservation Report dialog box opens.
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Print Resources Command

In Activities view, the Print Resources command (Internet | Resources | Print) opens the Print Reservations
dialog box. You can print the schedule for up to six months ahead. 
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Print Reservations Dialog Box

The Print Reservations dialog box lets you print a report showing booked time and free time for resources you
manage. To open this dialog box, in Activities view, choose Internet | Resources | Print or click the Print button
in the Viewing Resources dialog box.
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Dialog Box Options:  Weekly View

Resource to Print
Click the arrow and choose the resource schedule you want to print.

Date Range
Click in the From or To box, and use the arrows to increase or decrease each value. The large arrow opens a
calendar you can use to select a date. 

Time Range
Click in the From or To box, and use the arrows to increase or decrease each value. Or you can type a value.

Dialog Box Options:  Monthly View

Resource to Print
Click the arrow and choose the resource schedule you want to print.

Month to Print
Click the arrow, and choose the month you want to print.
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Netscape Address Book Command

In the Contacts view, the command Internet | Netscape Address Book opens the Netscape address book and
converts the multi-level mailing list into a Sidekick 98 mailing list.

Note Sidekick looks for the file Address.htm, stored in the same folder as your Netscape bookmarks file. If
the file is not found, the File Open dialog box appears so you can select the address book. Once
imported, the copy of the address book is saved as Netscape.SKCard in the Sidekick 98 data
directory. 
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Eudora Pro Address Book Command

In the Contacts view, the command Internet | Eudora Pro Address Book opens the Eudora Pro (32-bit)
address book, and converts its contents into a Sidekick cardfile. The cardfile is called Eudora.SKCard, and is
stored in the Sidekick 98 data directory.

Note If the Eudora Pro address book file is not found, the File Open dialog box appears so you can select
the address book. Once imported, the copy of the address book is saved as Eudora.SKCard in the
Sidekick 98 data directory.

If you are using Eudora Pro 3.0, you can have multiple e-mail addresses per person. These entries are
automatically converted into a mailing list. 

Created with the Personal Edition of HelpNDoc: Produce online help for Qt applications

Exchange Address Book Command

The Internet | Exchange Address Book command opens your Microsoft Exchange address book in the
Sidekick Contacts view as a virtual cardfile. If you have several Exchange address books, such as a
Postoffice Address List and a Personal Address Book, a dialog box appears asking you to specify which one
to use.

Once you open the file in Sidekick, you can use Save As to give it a Sidekick file name.  (You need to log on
to Exchange to reopen the saved Exchange cardfiles.) The cardfile is “linked” to the Exchange Address book.
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For more information, see Virtual Cardfiles.
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Windows Address Book Command

In Contacts view, the Internet | Windows Address Book command opens your Windows address book in the
Sidekick Contacts view as a virtual cardfile. (This command also opens Outlook Express, Outlook 97, and
Internet Mail address books.) If you have several of these address books, a dialog box appears asking you to
specify which one to use.

Once you open the Windows address book file in Sidekick, you can use Save As to give it a name. The
cardfile is “linked” to the Microsoft address book.

For more information, see Virtual Cardfiles.
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Virtual Cardfiles

When you open cardfiles using Internet | Windows Address Book or Internet | Exchange Address Book, the
files are opened as virtual cardfiles. Virtual cardfiles look similar to native Sidekick cardfiles, but they are
stored differently. Rather than being actual Sidekick cardfiles, Sidekick treats them as links to the source files.

When you work with virtual cardfiles, you can add and edit cards, but you canʼt delete cards.

To edit a virtual cardfile card

1. With the card open, click the pencil icon. 

2. The Properties dialog box for that card opens. Make the changes you want in the dialog box, then click OK.

When you edit a card in a virtual cardfile, the changes are reflected in both Sidekick and the originating
application.

To save a virtual cardfile with a name
 Choose File | Save Cardfile As.

The file is still only a virtual Sidekick cardfile, taking up only a small amount of disk space; but now you can
open the file using the File | Open Cardfile command.

If you make changes to the cardfile outside of Sidekick while the virtual cardfile is open in Sidekick, the
changes are not reflected in Sidekick until you close and re-open the virtual carfile.

Note If you transfer a virtual cardfile to a different computer, it will point to the data on that machine, not the
data on the original computer.

To create a native Sidekick cardfile from a virtual cardfile
If you want to create a real Sidekick 98 cardfile from the cards in a virtual cardfile, create a new cardfile
template and cardfile, then use the Cards | Move command  to copy cards from the virtual cardfile into the
new cardfile.

Note Because you canʼt delete cards from a virtual cardfile, when you use the Move command with virtual
cardfiles, Sidekick copies, rather than moves, the cards you specify.

You can also use the Tools | Extract Cards command to create a Sidekick cardfile from a virtual cardfile.
Extract Cards lets you specify criteria to determine which cards to extract. For more information, highlight one
of the Extract Cards commands and press F1.
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Launch URL Command
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In Contacts view, the Internet | Launch URL command launches your default World Wide Web browser and
jumps to the Web site specified by a URL in the current card. 

If there is more than one URL in the current card, Sidekick jumps to the first URL in the card. If that is not
what you want, you can click in a field containing a URL before giving the Launch URL command to specify
which URL to use.

Sidekick recognizes a variety of URL types such as http:// (the World Wide Web), ftp://, gopher://, wais://,
and file://.

A 32-bit browser is required. 
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Shortcut Menu (Activities View)

The shortcut menu opens when you right-click an Internet Event in the Activities view.

Menu Options (Incoming Events)
Accept sends an accept message to the meeting originator. You can type a message to go with the reply.

Decline sends a decline message to the meeting originator.  You can type a message to go with the reply.

Reschedule Request sends a message requesting that the event be rescheduled to another time. You can
propose up to three alternate times, and you can attach a Free Time Report showing your available times for
the next 30 days.

Delegate forwards the invitation to someone else you specify, and notifies the meeting originator that you
have delegated the event. 

New opens the Schedule Group Event dialog box so you can enter a new event.

Delete deletes the selected event.

Menu Options (Outgoing Events)
Reschedule opens the Schedule Group Event dialog box, where you can change the eventʼs date, time, or
other options, and re-send the invitation.

Cancel sends a message canceling the event, and removes it from your calendar.

Send Reminder sends a message to all participants reminding them of the event.  The event is marked with a

reminder icon: 

New opens the Schedule Group Event dialog box so you can enter a new event.

Delete deletes the selected event.
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Checking Your Schedule

 Related topics

To view your Internet scheduling and Calendar events, To Do items, and Calls
1. Switch to the Activities view by clicking its icon on the Deskpad.

2. Click the tab for the events you want to see: Internet Events or the Calendar event tabs (All, Appointments,
To Do, or Calls). 

3. Click the Show drop-down list button and select the time period or event type you want to see. 

4. For Internet events, click the item, and view the information in the Details and Information panes. If you
click an entry in the Details pane, you see more specifics in the Information pane.  

You can also:
Double-click a Calendar activity (appointment, To Do item, or Call) to jump directly to that event. 

Click a heading, such as Date and Time or Subject, to sort on that field.

If there is a URL attachment to a group event, click the URL to launch your default browser and jump
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directly to the World Wide Web site.  

Created with the Personal Edition of HelpNDoc: Easily create CHM Help documents

Viewing Internet Group Scheduling Event Details

 Related topics

To view details of your Internet scheduling events
1. From the Internet Events page of Activities view, click the event in the list (you may need to set the Show list

to include the event type you want to see, such as Incoming Events or All Events).

2. In the Details pane, click an item and check the Information pane for more specifics. 

The buttons at the bottom of the window change depending on the kind of event you have selected: incoming,
outgoing, resource message, and so on. Use the buttons, or right click an event and use the shortcut menu, to
respond to event invitations or take other actions.
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Creating a Group Event

 Related topics

To schedule an event and send invitation messages automatically to the attendee list using the
Internet Scheduling Wizard
1. In the Calendar, Contacts, or Activities view, choose Internet | Scheduling Wizard.

2. Fill in the information in each Wizard page, and click Next to continue. Click the Help button on each page
if you need information about the options.

To schedule a group event using the Schedule an Event dialog box
1. In Calendar view, click Calendar | Events | Group. If you are in Activities view, click the New button (while a

group event is selected). The Schedule an Event dialog box opens.

2. Fill in the information in each page of the dialog box. Click the Help button on each page if you need
information about the options.

If you select participants or resources, the event is treated as a group event: invitations are sent to
participants, and the resources are scheduled. If you do not select participants or resources, the event is a
local event, added only to your calendar.

Note If you create an event or accept an invitation, the activity is added to your current calendar. If you use
more than one calendar file, be sure the right one is open when you create or respond to Internet
scheduling messages.
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Replying to an Event Invitation

 Related topics

When you are invited to a group event, the invitation appears in the Activities view. An icon appears in the
New column until you click the event to read it.

To accept or decline an invitation
1. Click the incoming invitation in the Internet Events page of the Activities view.  Read about the event in the

Information pane.

2. Right-click the event, or click one of the buttons, to respond:

Accept – Sends a reply accepting the invitation, and adds the event to your calendar. You can include a
reply message of up to about 2,000 characters.

Decline – Sends a reply declining the event. You can include a reply message of up to about 2,000
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characters.

Reschedule Request – Opens the Reschedule Request dialog box. You can enter up to three proposed
alternative times and include your Free Time Report.

Delegate – Forwards the invitation to another person you select, with an optional message. The event
originator receives notification that you have delegated the event to someone else.

Note If your invitations go to non-Sidekick users, they can reply using their e-mail software. They will see
the instructions when they open your invitation message in their e-mail program.
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Checking Event Replies

 Related topics

To check replies to an event you have initiated
1. Switch to the Activities view by clicking its icon on the desktop. Be sure the Internet Events tab is selected.

2. Click the event in the list. (If necessary, set the Show list to include the event type you want to see.)

3. In the Details pane, check the Participants list.  The icon by each name tells you the reply status:

No Reply Yet

Accepted

Declined

Reschedule Requested

Delegated

Click each participant and check the Information pane for any message that participant may have have sent
with the reply.

Click the Expand button    to read the meeting details more easily.
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Entering Reply Status Manually

 Related topics

This option is useful when you receive a reply verbally for an event you have initiated.

To enter the status of event partipants 
1. Switch to the Activities view by clicking its icon on the desktop. Be sure the Internet Events tab is selected.

2. Click the event in the list.

3. In the Details pane, the icons next to the participants indicates their status. You can click a participant in
the Details pane and read that personʼs status and response details in the Information pane.

4. Right-click a participant and choose the status you want: Accept, Decline, Reschedule Request, or
Delegate.
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Rescheduling a Group Event

 Related topics

To reschedule a group event you have initiated
1. Switch to the Activities view by clicking its icon on the desktop. Be sure the Internet Events tab is selected.

2. Click the event in the events list.
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3. Click the Reschedule button to change the event, and enter the new time. 

The participants are notified of the schedule change. When they click the notification message, they can
Accept, Decline, or choose another reply to the rescheduled event. (The reschedule event icon remains in the
New column as a reminder until the participant replies.) 
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Canceling a Group Event

 Related topics

To cancel a group event you have initiated
1. Switch to the Activities view by clicking its icon on the desktop. Be sure the Internet Events tab is selected.

2. Click the event in the events list.

3. Click the Cancel button. 

The participants are notified that the event is canceled. The event is automatically removed from their
calendars when they click on the cancellation message and then click the Clear This Event button. (The
Cancel icon remains in the New column as a reminder until the event is cleared.)
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Adding More Participants to an Event

To add more participants to an event you have scheduled
1. Switch to the Activities view by clicking its icon on the desktop. Be sure the Internet Events tab is selected.

2. Click the event and click the Reschedule button, or right-click the event and choose Reschedule from the
shortcut menu. The Schedule an Event dialog box opens.

3. Select the participants you want to add. Click OK.

Note The notification is sent to all participants, so that everyone receives the full attendee list.
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Adding a New Resource

 Related topics

To add a new resource (Facility, Equipment, or Other)
1. In the Activities view, choose Internet | Resources | Add.

2. Enter information about the new resource in the Add Resources dialog box.
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Making a Resource Available to Others

 Related topics

Once you have created a new resource (Facility, Equipment, or Other) using the Add command, you must
distribute the resource to others so they can reserve it. 

To distribute a resource
1. In the Activities view, choose Internet | Resources | Distribute. The Distribute Resources dialog box opens.

2. Click the resource to be distributed in the Available Resources list.  Click the > button to add it to the
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Selected Resources list.

3. Select all users who should be able to reserve the resources in the User List. Click the > button to add them
to the Selected Users list.

You can distribute a resource to anyone using the same kind of e-mail as you.
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Reserving a Resource for an Event

 Related topics

To reserve a resource before or after sending invitations, use the Resource Reservation Wizard
 In the Activities view, choose Internet | Resource Wizard. 

The first Resource Reservation Wizard panel opens. You can request the resource and wait for confirmation
before notifying attendees.

To reserve a resource while scheduling an event
1. In the Calendar, choose Internet | Scheduling Wizard. 

2. In the Select Resources panel of the Internet Scheduling Wizard, make your choice from the Available
Resources list. The resource request is sent at the same time as your invitations.

Note If you use the Resource Reservation Wizard to book the resource, do not also include the resource
when you create invitations to the same event. If you have already reserved the resource, sending a
second request will result in a message saying the resource is already reserved for that time. 
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Transferring Management of a Resource

 Related topics

If you are the manager of a resource, you can transfer it to someone else. 

To transfer management of a resource
1. In the Activities view, choose Internet | Resources | Transfer. The Transfer Resources dialog box opens.

2. Select the resource you want to transfer.

3. Enter the new managerʼs name and information. 

Note The new manager, who must be using Sidekick 98 or 97 (or Internet Sidekick), can decline or accept
the transfer. Until the new manager accepts the transfer, you are still the resource manager.

You can transfer a resource to anyone using the same kind of e-mail as you.
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Changing a City Clock

 Related topics

To change a city clock
1. In EarthTime view, right-click an existing city clock that you want to replace, or move the mouse to the

menu arrow .

2. Choose Select a Different City from the menu.

3. Type the first few letters of the city. 

4. When you see the name you want in the list, click it to select it, and then click OK.
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Centering a City

 Related topics

To move a city to the horizontal center of the EarthTime map
1. Right-click the clock for the city you want to center, or move the mouse to the menu arrow .

2. Choose Make Cityname the Map Center from the menu.
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Centering a Map Location

 Related topics

To center any location horizontally in the EarthTime map
1. Right-click on the map at the location you want centered.

2. Click Center Map Here.

You can also double-click the part of the map that you want to be in the center.
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Comparing Time in Two Cities

 Related topics

To see a comparison of time in two cities
1. Click on the clock of the first city (you must click the time display area itself).

2. Drag the time display area to the clock for the second city. 

Or, right-click the clock for any city, or move the mouse to the menu arrow , and choose Time Difference
from the menu. Then select the cities you want using the Browse Cities buttons in the Time Difference dialog
box.
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Converting Measurements

To convert from one unit of measure to another
1. Choose Tools | Conversions. The Conversions dialog box opens.

2. Choose a category of measurement.

3. In the From section, fill in the quantity (Value) and choose the unit to convert from.

4. In the To section, choose the unit to convert to.

5. Read the result in the Value box in the To section.
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Entering an Expense Receipt

 Related topics
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To enter information for a new receipt

1. In Expenses view, click the Add Receipt button.  

2. Choose the Expense Type from the drop-down list at the upper-right of the view. 

3. Type the receipt information in the blank receipt form below the list. 

Most fields include a drop-down list you can select from to speed up your data entry. These lists are updated
when you type new information, such as a new city name. For a mileage expense receipt, you enter the
number of miles, and Sidekick automatically calculates the mileage amount by multiplying it times your
mileage rate (in the Defaults page of Expense Preferences).

To edit an existing receipt
1. Click the receipt in the Receipts list at the left of the view. The receipt appears at the right. 

2. Make any changes you want in the receipt fields.

Once you have entered one or more receipts, you can create an expense report.
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Creating an Expense Report

 Related topics

To create an expense report, you must first enter information in expense receipts. 

To create the expense report from one or more receipts

1. Select View | Report View, or click the Go To Report button.  

2. Type the Name, Department, and Purpose of the expense report at the top of the screen.

3. In the By drop-down list, choose the contents: by Range, by Week, or by Folder.

The numbers in the expense report are not directly editable. To change this information, return to the Receipt
view (View | Receipt View) and make changes in the receipts.
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Changing Expense Report Options

 Related topics

To enter default values and currencies to apply to the Expenses view
 Choose Tools | Preferences | Expenses 

To set properties for the specific folder
 Choose Expenses | Folder | Modify 

To set properties for the current Expense file
 Choose Expenses | File Properties 

Note Changes in the Expense Preferences dialog box are not retroactive. They apply to new data you enter.
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Dialing a Voice Call Automatically

To dial a call using cardfile information (provided you have entered a default dialing field in the
Cardfile SpeedDial field)
1. Select the card you want in the Contacts view. Or, if you are in another view, open the Viewport and select

the card you want.
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2. Drag the card to the telephone icon on the Deskpad.

3. Lift the receiver of your phone, and click the Talk button in the Call Status dialog box. Or you can click
Hang Up to cancel the call.

Once the Phone Dialer is open, you can select a different card to dial just by clicking the card you want in the
Contacts view or the Viewport—without closing the Phone Dialer.

Tip You can also dial a call using a phone number you have typed in an appointment or To Do item in the
Calendar. Just drag the appontment or To Do item to the phone icon to dial the number.  Or you can
highlight a phone number and press F9.
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Entering a Call Note

 Related topics

To enter a text note about a call

1. Open the Phone Dialer by clicking the Call icon  or pressing F9.

2. Click the Call Note button at the bottom of the Phone Dialer.

3. Type the text you want in the Call Note pad.

4. Select the card to which the note applies by clicking it in the Contacts view or Viewport.

5. Click Save to Current Contact Log in the Phone Dialer.
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Checking While-You-Were-Out Messages

 Related topics

To see who called while you were out

1. Open the Phone Dialer by clicking the Call icon  or pressing F9.

2. Open the History window by clicking the History button

3. Review the Call History panel, which displays Caller ID information on incoming calls that were not
answered.

Note: This feature requires you to have the Windows 95 Unimodem V driver installed, a modem with
Unimodem V capability, and Caller ID service. See the Readme.txt file for information on obtaining the
Unimodem V driver.
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Importing and Exporting

Sidekick 98 includes advanced technology for importing and exporting files in various formats. With just a few
clicks, you can import files in formats ranging from ASCII tab-delimited to Outlook 97 to dBASE.

Importing
You can import files in the Contacts, Calendar, and Memos views. For details, see Importing files in different
formats.

Exporting
You can export files in the Contacts and Memos views.  For details, see Exporting files.

File Formats
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For a list of the file formats supported by Sidekickʼs Import and Export Wizards, see Importing and Exporting:
Supported File Formats.

Maximum Values
To see a list of maximum values for importing and exporting cardfile data, see Importing and Exporting:
Maximum Values.
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Importing and Exporting: Supported File Formats

The following table describes the file formats supported by Sidekick 98 Import and Export Wizards for
cardfiles. To see the most up-to-date list of supported files, when you open the Import or Export Wizard, click
the link to the Starfish Software Web site.

File Format Description

dBASE III (.DBF) File format editable by most applications that can read dBASE.

dBASE IV (.DBF) File format editable by most applications that can read dBASE.

Spreadsheet Data Interchange Format (.DIF) File format editable by many spreadsheet and word processor
applications. This format should not be confused with Navy Data
Interchange (DIF), which is not currently supported.

Tab-delimited Text (.TXT) ASCII text file format in which each tab represents the end of a field.
Tabs within quotation marks are treated as normal characters and not
delimiters. There should be an even number of quotation marks in each
line. A hard return represents the end of a record. The first line of the
text file is used for cardfile field names.

Comma-delimited Text (.CSV) Text file format in which each comma represents the end of a field.
Commas within quotation marks are treated as normal characters and
not field delimiters. There should be an even number of quotation marks
in each line. A hard return represents the end of a record. The first line
of text is used for cardfile field names.

Microsoft Outlook 97 (import only) Format used by Microsoft Outlook 97. 

Schedule+ 7.0 (import only) File format used by Microsoftʼs Schedule+ 7.0.

Lotus Organizer 97 (import only) File format used by Lotus Organizer 97.
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Importing and Exporting: Maximum Values

These are the maximum values for importing and exporting cardfile data:

Maximum number of characters in a field: 98

Maximum number of characters per record of a card: 5,000

Maximum number of records: 30,000

Maximum  number of fields to a record of a card: 100
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Importing files in different formats

In Contacts view, use the Import Wizard to import files in various formats, including Microsoft Outlook 97,
Schedule+ 7.0, Lotus Organizer 97, ASCII tab-delimited, comma-separated, dBASE, and Spreadsheet DIF
files.

In Calendar view, use File | Import Calendar to import calendar files from Microsoft Outlook 97, Schedule+
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7.0, and Lotus Organizer 97.

In Memos view, you can import files in .rtf (rich text) or .txt (plain txt) format using the Memos | Memo | Import
menu item.

Note For information on maximum values supported when importing and exporting cardfiles (for example,
maximum number of characters per field), see Importing and Exporting: Maximum Values.

To import files in the Contacts view, follow these steps:
1. Choose File | Import Cardfile.

2. The first Wizard screen contains a link to the Starfish Software Web site. As new import formats become
available, you can download them from the Starfish Web site. If you want to see whether new formats are
available, click the Go to Starfish Website button. To continue, click Next.

3. If you have Microsoft Outlook 97 and want to import from it, click Import from Outlook 97. Otherwise, click
Import from Other File and enter the name of the file that you want to import, or click Browse to select a file.
You can select the format from the Files of Type drop-down list. Click Next to continue.

4. You can enter a new file name for the Sidekick 98 file that will be created from the import operation, and a
new target location, or accept the file name and target location shown. Click Next to continue.

5. In the Available Fields list, choose which fields you want to import from your file to the new Sidekick 98 file
that will be created. Select a field and click Add, or choose Add All to select every field. If you change your
mind, select the field that you do not want in the Fields to Import list, and click Remove. Click Remove All to
start over. When you have chosen the fields that you want in your new file, click Finish.

You can now open the file in Sidekick by using the File | Open menu item.

(You can export files in the Contacts view.  For details, see Exporting Files.)

To import files in Calendar view
1. Choose File |Import Calendar.

2. Choose the type of file to import: Outlook 97, Schedule+ 7.0, or Lotus Organizer 97.

3. If you chose Outlook 97, your Outlook file is imported. If you chose Schedule+ 7.0 or Lotus Organizer 97,
the Open dialog box appears, where you can specify the file to import.
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Exporting files

Exporting Files

To export files in the Contacts view
Use the Export Wizard to export files in the Contacts view.

Note For information on maximum values supported when importing and exporting cardfiles (for example,
maximum number of characters per field), see Importing and Exporting: Maximum Values.

1. Choose File | Export Cardfile in the Contacts view.

2. The Contacts Export Wizard opens. Click Next.

3. Type in the source file name, or click Browse to select the file name from a directory. Click Next.

4. Enter the target file name and target file type. To choose a different file type, click the drop-down list. If you
select a different file type, the extension of the target file name will change automatically. You can also
enter a different target file name by typing it in. Click Next when you have completed this screen.

5. Choose which available files you want to export, and click Finish.

Exporting memos in Memos view
Memos view includes two commands for exporting memos:

Use Memos | Memo | Export to export the current memo to a rich text (RTF) file. The new RTF fileʼs name is
the name of the memo, with an RTF extension.

Use Memos | File | Export if you want to export multiple memos. You can export the current memo, all
memos in the folder, all memos in all folders of the Memo file, marked memos, or found memos. You can
export the memos to a text file, an RTF (Rich Text Format) file, or the Clipboard.

Importing
You can import files in the Contacts, Calendar, and Memos views. For details, see Importing files in different
formats.
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Import Wizard: Welcome

The first Wizard screen contains a link to the Starfish Software Web site. As new import formats become
available, you can download them from the Starfish Web site. 

If you want to see whether new formats are available, click the Go to Starfish Website button. To continue,
click Next.

Created with the Personal Edition of HelpNDoc: Easy EPub and documentation editor

Import Wizard: Select File

Use the second Wizard screen to select the file that you want to import.

If you have Microsoft Outlook 97, the option Import from Outlook 97 is available. Click that option if you want
to import from Outlook 97.

If youʼre importing from a format other than Outlook 97, click Import from Other File and enter the name of the
file that you want to import, or click Browse to select a file.

If you click the Browse button, select the file format from the Files of Type drop-down list. 

Click Next to continue.
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Import Wizard: Target File

Use the third Wizard screen to choose the name of the new Sidekick 98 file that will be created, and to select
the target location.

You can enter a new file name and target location, or accept the file name and target location shown. 

Click Next to continue.
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Import Wizard: Select Fields

Use the fourth screen to choose which fields you want to import from your file to the new Sidekick 98 file that
will be created.

In the Available Fields list, select a field and click Add, or choose Add All to select every field. If you change
your mind, select the field that you do not want in the Fields to Import list, and click Remove. Click Remove All
to start over. 

When you have chosen the fields that you want in your new file, click Finish.

You can now open the file in Sidekick 98 using the File | Open Cardfile menu item.
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Export Wizard: Welcome
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The first Wizard screen contains a link to the Starfish Software Web site. As new export formats become
available, you can download them from the Starfish Web site. 

If you want to see whether new formats are available, click the Go to Starfish Website button. To continue,
click Next.
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Export Wizard: Select File

Use the second Wizard screen to select the Sidekick 98 file that you want to export.

Enter the name of the file that you want to export, or click Browse to select a file.

Click Next to continue.
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Export Wizard: Target File

Use the third Wizard screen to choose the name of the new file that will be created, and its location and file
type.

You can enter a new file name and target location, or accept the file name and target location shown.

Click Next to continue.
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Export Wizard: Select Fields

Use the fourth screen to choose which fields you want to export from your Sidekick 98 file to the new file that
will be created.

In the Available Fields list, select a field and click Add, or choose Add All to choose every field. If you change
your mind, select the field that you do not want in the Fields to Export list, and click Remove. Click Remove All
to start over. 

When you have chosen the fields that you want in your new file, click Finish.
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Customizing the Toolbar

You can choose which buttons appear on the Toolbar for the active view.

To change the buttons on the Toolbar
1. Choose Tools | Setup | Toolbar. The Customize Toolbar dialog box appears.

2. To add buttons to the toolbar, add them to the Toolbar Buttons list. To remove buttons, remove them from this
list.

3. To change the position of buttons in the Toolbar, change their position in the Toolbar Buttons list.

4. Click OK.

To reset the Toolbar so that it contains the default buttons, click the Reset button in the Customize Toolbar
dialog box. 

Tip You can use drag and drop to change button positions on the toolbar itself. Just hold down the Alt key
as you drag with the mouse. To remove a button from the Toolbar this way, hold down the Alt key and
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drag the button off of the Toolbar.
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Dragging Sidekick URLs into Your Web Browser

You can quickly view a Web page by dragging its URL (Web address) from Sidekick into your Web browser.
Your Web browser must be open in order to do this.

1. In Contacts view, find the URL you want to go to.

2. Drag and drop the URL into your browser.

Sidekick 98 supports a variety of URL file protocols, such as http://, file://, ftp://, and gopher://.
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Introducing Starfish Web Publisher

{button ,AL(`Internet')} See also

Web Publisher lets you publish your Sidekick 98 calendars and cardfiles as attractive, professional-looking
HTML documents for sharing on the Internet or a corporate intranet. Web Publisher uses Starfish Software's
innovative Reflex® engine technology to create HTML documents.

Because the Web Publisher documents are fully formatted and hyperlinked, you can jump easily from one
date to another in a published calendar, or to a different view of the calendar: daily, weekly, monthly, yearly,
or activities (list) views. In the Contacts view, you can click an index letter to jump to the entries beginning with
that letter. URLs (Web addresses) in cardfile fields and calendars are hyperlinked.

Web Publisher calendars and cardfiles are stored as a series of HTML documents that can be posted on your
Web site.  To get started, see Using Web Publisher.
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Using Starfish Web Publisher

{button ,AL(`Internet')} See also

You can use Web Publisher to produce calendar and cardfile HTML documents. This Help topic gets you
started; for additional information, click the Help button from within the appropriate dialog box or Wizard.

Starting Web Publisher
In Calendar view: Choose Internet | Publishing Wizard, or click the Publishing Wizard button in the Toolbar, to
open a Wizard that will help you through the process. 

To have more publishing options, choose Internet | Publish to the Web. This menu item lets you enter detailed
information in the multi-tab dialog box. The Wizard is intended to be a quick publishing tool, so it has fewer
options than the dialog box.

In Contacts view: Choose Internet | Publishing Wizard, or click the Publishing Wizard button in the Toolbar, to
open a Wizard that will help you through the process.

To have more publishing options, choose Internet | Publish to the Web. This menu item lets you enter detailed
information in the multi-tab dialog box. The Wizard is intended to be a quick publishing tool, so it has fewer
options than the dialog box.

Specifying what to publish
Enter the information requested by the Wizard, and press Next at each panel to proceed. At the last Wizard
panel, you will see a summary of your publishing specifications. Click Finish to publish.  

If you use the dialog box instead of the Wizard, be sure to click each tab and fill in the required information.
When you click OK, your information is published.  

Click the Help button at any Wizard panel or dialog box page for more information. 

https://www.helpndoc.com/create-epub-ebooks
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Viewing your published information
At the end of the publishing process, you can check the “Launch Web browser to check output pages” box to
view the results immediately. 

Later, when you want to see the published cardfile or calendar, navigate to the folder where the published files
are stored.  Double-click a file to open it in your browser. For calendars, double-click the file named
xxCAL.HTM, where xx represents the file prefix you are using, such as your initials (for John Smith, the file
might be JSCAL.HTM). For cardfiles, double-click the file xxCARDS.HTM.

Publishing URLs
You can publish URLs (Internet addresses) that are hyperlinked – that is, you can click on them to jump
directly to the URL.  In the Contacts view, the word URL must appear in the field name for the field contents to
be recognized and published as a URL.  In the Calendar, click the Attach URL button in the Schedule an
Event dialog box to add a URL. The URL should be complete, including the prefix http:// or other prefix, so it
will be recognized by most browsers. You are not limited to Web URLs; you can use mailto, ftp, file, and other
URLs.

Created with the Personal Edition of HelpNDoc: Free PDF documentation generator

Introducing Starfish TrueSync

{button ,AL(`Internet')} See also

TrueSync™ means that you can always have up-to-date calendars and contacts with you, wherever you go,
by updating your handheld device with your data in Sidekick 98.

Just use Sidekick 98 to enter your calendar events, to do items, contact information, and memos.  Then,
when you have updated information, use TrueSync to synchronize this data with your handheld device. The
Preferences Wizard gets you up and running quickly, and you can customize TrueSync to suit your own
working style.

For more information, see:

Using TrueSync for REX

Using TrueSync for PalmPilot

For details on synchronizing and customizing, and on other handheld devices, see Starfish TrueSync
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Using TrueSync for REX

{button ,AL(`Internet')} See also

TrueSync™ updates your REX card with the latest information about your calendar, contacts, and To Do
items in Sidekick 98, so this information is always with you, wherever you go.  

Whenever you have updated information that you want to appear in your REX card, use TrueSync. It just
takes one click to synchronize Sidekick 98 with your REX card. 

For details on synchronizing and customizing, see Starfish TrueSync.

For details on the REX card, see About the REX card.

Created with the Personal Edition of HelpNDoc: Free help authoring tool

Using TrueSync for PalmPilot

{button ,AL(`Internet')} See also

TrueSync for PalmPilot is an add-on module that synchronizes information between Sidekick 98 and the U.S.

https://www.helpndoc.com
https://www.helpndoc.com/help-authoring-tool
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Robotics PalmPilot personal organizer. 

When you click the HotSync button on the PalmPilot cradle, TrueSync automatically synchronizes the
information in both systems. Since synchronization causes the contents to match, you can enter information
in either system, and use TrueSync to keep your PalmPilot and Sidekick 98 in sync. (Some limitations exist
because of differences between the Sidekick and PalmPilot designs.) 

When you use TrueSync:

Your appointments in the Sidekick Calendar are synchronized with those in the PalmPilot Date Book.

Your Sidekick Contacts cardfile is synchronized with the PalmPilot Address Book.

Your Sidekick Memos file is synchronized with the PalmPilot Memo Pad.

Your Sidekick To Do items are synchronized with the PalmPilot To Do list. 

By using TrueSync, you can enter information wherever itʼs most convenient, at your keyboard, on-site
through your handheld PalmPilot, or both. Then let TrueSync transfer the new information from each system
to the other.

For details on synchronizing and customizing, see Starfish TrueSync

Created with the Personal Edition of HelpNDoc: Create help files for the Qt Help Framework

Synchronizing Sidekick 98 and PalmPilot Data

{button ,AL(`Internet')} See also

To start a TrueSync session
1. Complete the TrueSync Wizard, if you have not yet done so. To see the Wizard, click the TrueSync button

in Sidekick, and then click the picture of PalmPilot labeled PalmPilot Preferences. 

2. Be sure the HotSync manager is running. When it is running, you can see its icon in your Windows
Taskbar. You can control whether it runs automatically or manually in the HotSync Manager Startup
Preferences dialog box. 

3. Place your PalmPilot in the cradle, which must be attached to your computer via a serial port.

4. Click the HotSync button on the cradle. 

If you have already completed the TrueSync Wizard and do not want to make any changes, Sidekick does
not need to be running when you run TrueSync. The HotSync Manager, which should start automatically when
you start Windows, does need to be running. If you need to start the HotSync Manager manually, click the
Windows Start button. Go to Programs|TrueSync, and click HotSync Manager.

Created with the Personal Edition of HelpNDoc: Full-featured EBook editor

About the REX card

{button ,AL(`Internet')} See also

Rolodex® Electronics REX™ allows you to take your Sidekick 98 data anywhere you go. REX is an ultra-thin
1.4 ounce Type II PCMCIA card with a large LCD screen for viewing your Sidekick data, anytime, anywhere. 

Laptop users can slide REX directly into their PCMCIA card slot, or desktop users can use the REX Docking
Station. Synchronize REX to Sidekick 98  with just a few simple clicks. When synchronization is complete,
just remove REX and you're ready to go.

To purchase REX or for more information, visit Franklin Electronic Publishers' web site at www.franklin.com or
call 1-800-266-5626.

For details on synchronizing and customizing, see Starfish TrueSync.
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Introducing vCard and vCalendar

{button ,AL(`Internet')} See also

Sidekick 98 supports vCard and vCalendar, which are univeral business card and calendar formats that work
across different computers, operating systems, and communication technologies. This cross-platform, cross-
application support lets you share contact and scheduling information more easily over the Internet. 

You can use the vCard and vCalendar support in Sidekick 98 to drag and drop vCard and vCalendar objects
into the Contacts and Daily Calendar views.

The Sidekick 98 vCard and vCalendar features offer support for two URL protocols: http:// and file://

For information on how to use this feature, see Using vCard and vCalendar.
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Using vCard and vCalendar

{button ,AL(`Internet')} See also

To import a vCard object into Contacts view,
1. Make sure Contacts view is active.

2. Drag and drop the object into Contacts view.

3. The Match Cardfile Fields dialog box opens. Match the fields from the vCard object with the fields in the
cardfile, and click OK. Any unmatched fields will appear last in the card.

To import a vCalendar object into Calendar view,
1. Make sure Calendar view (Daily view) is active.

2. Drag and drop the object into the Daily view

Created with the Personal Edition of HelpNDoc: Free iPhone documentation generator
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